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What is Ad Hoc?
Ad Hoc is a relational database management system for Microsoft Windows.    With Ad Hoc, 
you can create simple single-table databases or complex databases with many tables.    Ad 
Hoc enables you to define relations between tables that make multi-table forms and reports
easy to design.    

With Ad Hoc, you can create forms that allow you to display and edit the data on the 
screen, and create reports that allow you to print the data in many types of formats.    Ad 
Hoc also allows you to import data from or export data to other programs.
Ad Hoc is designed to be quick and easy to use.    You do not have to learn a programming 
language to build and access databases in Ad Hoc.    Ad Hoc is designed for anyone who 
wants to store large or small amounts of data and access it easily without having to learn a 
complex database management system. 



How to Use Ad Hoc
The Ad Hoc Main Window
Creating Databases
Designing Forms
Using Forms to Enter Data
Designing List Forms
Using List Forms to Display and Enter Data
Designing Reports
Printing Reports
Importing Data
Exporting Data
Database Maintenance



The Ad Hoc Main Window
When you start Ad Hoc, the first window that you see is the Ad Hoc Main Window.

The main area of this window (called the client area in Windows terminology) is referred to 
in Ad Hoc as the desktop.    Ad Hoc displays various desktop objects on the desktop, 
including data entry forms, list forms, report design templates, and the table status 
window.
Click the mouse on the areas of the Ad Hoc window above to see a definition of each 
component of the main window.



Window Title Bar
This area displays the application name, Ad Hoc, and if a database is open, the name of the
database.



Main Menu
The main menu of Ad Hoc, contains the commands you use to open and work with 
databases, forms, and reports.



Desktop
The Ad Hoc Desktop, on which appear the desktop objects: forms, reports, the table status 
window, etc.



Status Bar
The status bar displays the state of various system wide options on the right, and status 
messages of the active desktop object on the left side.    When you are dragging the mouse 
across a menu, the status bar displays a description of the menu selection that is 
highlighted.



Design Mode Indicator
If the currently active form is in design mode, this area will display the word "DESIGN".



Record Locking Indicator
If record locking is in effect, this area will display "RL".



Auto Update Mode Indicator
If the automatic record update mode is in effect, this area will display "AUTO".



System Menu
The Ad Hoc system menu is standard for a windows program.



Minimize Box
Click here to minimize Ad Hoc to an icon on the Windows desktop.



Maximize Box
Click here to maximize Ad Hoc to the size of the full screen.



First Record
Click here to load the form with the first record in the current index.



Previous Record
Click here to load the form with the previous record in the current index.    Hold the mouse 
button down for automatic sequencing through records.



Next Record
Click here to load the form with the next record in the current index.    Hold the mouse 
button down for automatic sequencing through records.



Last Record
Click here to load the form with the last record in the current index.



New Record
Click here to start a new record.    Ad Hoc will blank the form, and you can enter data for a 
new record.



Delete Record
Click here to delete the current record displayed in the form.    Ad Hoc will ask you to 
confirm the deletion.



Update Changes
Click here to update the changes you have made to the current record, or insert the new 
record you have filled out into the database.    This icon will only appear on the control pad 
if you have made changes to a record, or started a new record.



Cancel Changes
Click here to cancel changes you have made (but not yet updated) on the form, or to 
cancel a new record.    Ad Hoc will reload the form with the previous record data.



Edit Control
An edit control is used for entering and editing a field on a form.



ComboBox
A combo box is used for entering or editing data in a field.    Combo boxes can be used for 
fields for which a list of valid code entries have been defined in the data dictionary.



Glossary

A
active form

B
break level
break, report
Btrieve
Btrieve file

C
combo box
computed field (report)
control
control pad

D
database
data dictionary
data exchange
data exchange template
data view
design mode
desktop
desktop object

E
edit control
element, report
embedded list
event, report
export
extended field ID

F
field
file
filter
filter rule
font
foreign key
form
form control

G



H

I
import
index
index segment

J

K

L
landscape orientation
link
list

M
margins, report
maximize icon
minimize icon

N
null

O

P
page break
point
portrait orientation
primary key

Q

R
record
region, report
render
report break
required field
root table
ruler

S
scroll bar
scroll region
sort specification
startup dialog, report



status bar
system files
system menu

T
table
text box
title bar
total field

U

V
view
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The active form is the form or list on the desktop that is currently accepting keyboard 
input.    It is also on top of any other forms displayed on the desktop.    The active form has a
highlighted title area as an indicator.    To make a form the active form, you can click on it 
with the mouse, or select it from the Window Menu.



A report break, or break level is a division in a report that occurs when a designated field 
in the report changes value.    Breaks are defined by fields that are used to sort a report.



Btrieve is a record manager from Novell.    Ad Hoc uses Btrieve as the default physical file 
format for its database tables.



A Btrieve file is a DOS file that can be read or written by Btrieve.    The database system 
tables and the default file type for Ad Hoc database tables are Btrieve files.



A combo box is a control, or data entry area, on a form or dialog box that gives you the 
option of entering a value, or selecting a value from a list.    Some combo boxes allow you 
only to select a value from a list.    If the list is not displayed, an arrow icon is shown on the 
right of the data area, click on this icon to display the list, then select an entry.



A computed field in a report is a field whose value is computed from other fields, from a 
constant expression defined when the report was defined, or is input by the user on the 
startup dialog before the report is printed.



A form control is a object on a form that displays and enables you to edit the contents of 
a data field.    Control types include edit controls, combo boxes, and text boxes.



A control pad is a set of icons in a window or form that represent actions you can initiate.   
To initiate an action, click on the icon.



A database is a collection of related data that is organized so that data can be easily 
retrieved in a desired format.    The data in a database can be restricted to the data needed 
by a single application, or can be all the data associated with a company.    Each database 
has a single data dictionary that describes the organization of the data.



A data dictionary is a description of how the data in a database is organized.    It 
describes the tables, fields, and indexes of the database.    It also describes how information
in different tables can be linked together.    The Ad Hoc data dictionary also describes the 
location and type of physical data files that implement the data tables.



Data Exchange is the process of importing data into a database or exporting data out of a
database.



A data exchange template defines a data import or export process.    It describes the 
fields that will be imported or exported as well as the type of file the data will be read from 
or export to.    A data exchange template can be associated with a form, so that you can 
import or export data through the form.



A data view, or view,    is a collection of fields from one or more tables in a database.    It 
acts like a table in that it can be sorted and filtered, and you can retrieve records from it 
(and update records in it).



You can set design mode for a form or list object on the desktop by selecting the Design 
Mode command on the form or list popup menu (press the right mouse button when the 
mouse cursor is over the form or list).    When an object is in design mode, you can change 
its design and layout, then save it with the File Save command.



The desktop is the main area of the Ad Hoc window.    Forms, lists, report edit windows, 
and other objects appear on the desktop.



A desktop object is a window that appears on the Ad Hoc desktop.    Desktop objects that 
you can display on the desktop include forms, lists, and report edit windows.    The Tables 
Window is also a desktop object.    When you initiate a process, such as rebuilding a table or
importing data, the process window that appears is also a desktop object.



An edit control is a object on a form that displays the value of a data field.    If the edit 
control is not set to display only, you can edit the field contents in the edit control.    An edit
control on a form is just like the edit controls on dialogs in all Windows programs.



An embedded list is a list object similar to a list on the desktop, except that it appears on 
a form as part of the form design.    A embedded list is usually linked to the form so that it 
displays records related to the record currently displayed on the form.



A report event is an action that takes place during the printing of a report.    Examples are 
the start of the report, the start of a new page, reading of a new record from the report 
view, etc.    Events can trigger the printing of parts of a report, such as a page header.



Export is the action of sending data from a Ad Hoc database to an external file or database
.



An Extended Field ID is used to identify fields in a data view.    A view is made up of fields 
from the root table of the view, and fields from other tables related to the root table 
through links that are defined for the root table.    The extended ID is composed of the Field 
ID of the field (as it is defined in its table) and the link IDs that link the field's table to the 
root table.    The extended ID contains one or more link IDs and a field ID, separated by 
periods.    The extended ID of a field from the root table has no link prefix.
Example:

Assume a view used in an employee report, including fields from the Employee table 
(EMPID, EMPNAME and WORKSIN) and    fields from the Department table (DEPTNO, 
DEPTNAME, MGR).    The primary key of the Employee table is EMPID and the primary key
of the Department table is DEPTNO.    The Employee table is linked to the department 
table by a link with ID WKSINLNK and the Department table is linked to the Employee 
table by a link with ID MGRLNK.
The root table of the view is the Employee table.    The following Extended Field IDs 
describe the fields in the view.    Fields from the root table have no link prefix.

Extended Field ID Description of the field

EMPID The id of the EMPID field in the root
table of the view

WORKSIN The department in which the 
employee works

WKSINLNK.DEPTNAME The name of the department in 
which the employee works

WKSINLNK.MGR The employee ID of the manager of
the department in which the 
employee works

WKSINLNK.MGRLNK.EMPNAME The name of the manager of the 
department in which the employee
works

A report element is a object that appears on a report.    An element can be a picture, a 
detail line, a report title, a paragraph or several paragraphs, etc.    An element is printed in 
a specified region (area) of the report when a specified event occurs (such as a new page is
started, or a new record is read from the view).



A field is a single data item in a table record.    A field can be a character string, number, 
date, or other information.    Examples of fields include employee id, name, birthdate, etc.    
A field can also be an object such as a picture.



The term file in Ad Hoc means a DOS file on your hard disk or a diskette.    A database table
is stored as a file.    Therefore, a table not only has an ID, by which it is identified in the data
dictionary, but it also has a DOS file name.



A filter is an object that determines the selection of records from a table when the records 
are displayed in a form or printed in a report.    A filter is a set of filter rules or selection 
criteria, such as "ORDERNO equals 334 and DATE greater than 3/4/93".    Only records in 
the table whose ORDERNO field equas 334 and DATE field is later than 3/4/93 are selected.



A filter rule is a record selection rule.    A set of filter rules make up a filter.    A rule is 
usually composed of the ID of a field in a record, an comparison operator such as "equals" 
or "greater than", and a value to which the contents of the field is compared.



A font is a collection of type faces and styles that you can apply to text in forms, lists, and 
reports.    When you specify a font, you specify the type face, size, and style (e.g. bold or 
italic) of the text.    Your font selection is limited to the fonts you have installed in Windows 
and (for reports) the fonts available for your printer.



A foreign key is a field, or group of fields, in a database table record, that together are 
equivalent to the primary key of another table.    The value of a foreign key usually must 
equal the value of the primary key of a record in the other table.



A form is a window on the Ad Hoc desktop that is used for entering and editing data in the 
database.    It is laid out much like a paper form that you would fill out.    You can design 
forms and store them in the Forms Table for later use.



Import is the action of reading data from an external file or database into a Ad Hoc 
database.



An index is a permanent sort on a data table.    The data dictionary can contain a number 
of indexes for a particular table.    As records are added or deleted to a table, the index is 
updated to remain current.



An index segment is one of the fields that define an index in a table.



Landscape orientation for a printer is when the long dimension of the paper is at the top



A link is an association between tables.    It defines a relationship between the primary key 
of one one table and matching foreign keys in another table.



A list is a desktop object that can display a number of records at once in a scrolling view.    
It is similar to a form in that it is associated with a data view, and displays fields from the 
view.



Report margins are the margins set in the report layout for a printed page.    You set left, 
right, top and bottom margins for the page layout of a report.



    The maximize icon on a window enables you to resize the window to its maximum size.



    The minimize icon on a window enables you to resize the window to an icon.    If you 
minimize Ad Hoc, it will appear as an icon on the Windows Desktop.    If you minimize a form,
list, or other Ad Hoc desktop object, it will appear as an icon on the Ad Hoc desktop.    
Double-click an icon to restore the window to its previous size.



A null value for a field is a value that has not been defined.    If you do not enter a value for 
a field when you fill out a form, the value of the field is null, and the field will be blank.    
Note that for a numerical field, a null value is not the same as a value of zero.



A page break is the action of starting a new page when a report is printing.



A point is a typographical unit of measure.    There are 72 points in an inch.    A point is 
used to measure the height of characters in a font or the leading (spacing between lines).



Portrait orientation of a printer is when the short dimension of the paper is at the top of 
the page.



The primary key of a database table is a field, or group of fields, whose value uniquely 
identify a record in the table.    Therefore no two records can have the same value for the 
primary key.    The primary key is always the first index defined for the table.



A record is unit of storage in a database table.    A record is made up of the database 
fields.    Think of a table as an arrangement of rows and columns of information.    The 
columns correspond to the fields of the table, and the rows correspond to the records of the
table.    As an example, in an employee table, the fields may be "employee ID" and "name". 
The rows correspond to individual employees.



A report region is a specified area on the page layout of a report.



A required field is a field that has the required attribute.    Each record in a table must 
contain a value for each required field.    When you are entering a new record through a 
form, you cannot leave a required field blank.    The fields that comprise a primary key are 
by definition required.    You can designate other fields as required.



Rendering is the act of printing an object in a report, or displaying an object on the 
screen.



The root table of a view is the primary table upon which the view is based.    The indexes 
of the root table are also the indexes of the view.    When you read records from the view 
using an index (instead of sorting the view), the records are in the order of the 
corresponding records of the root table.    A view must have a root table defined, and it will 
consist of fields from the root table as well as fields from other tables related to the root 
table by links defined for the root.



A ruler is displayed at the top of a report edit window.    It enables you to measure the 
placement of margin, tabs, and text in the report layout.    Tabs are displayed and set on the
lower part of the ruler



A scroll bar is a window control that enables you to use the mouse to make the list scroll.



A scroll region is an area on a form that contains an imbedded list object.    You can 
manipulate a scroll region when the form is in design mode just as you would other form 
controls.



A sort specification is a description of how the records in a data view will be sorted.    It is 
a list of the fields from the view whose values will be used to sort records.    Each field can 
be sorted in ascending or descending order.



A report startup dialog is displayed before a report is printed, to enable the user to 
specify certain values or report controls to be used during the printing of the report.



The status bar is displayed at the bottom of the Ad Hoc main window.    It shows the status
of operations and also quick help when selecting commands from menus.



The system files of a database include the data dictionary file, and the following files
Data Dictionary Data file, containing validation rules and other supplementary 

information
Forms Table file, containing form, list, and desktop definitions
Reports Table file, containing report definitions



The system menu of a window is a standard menu that controls the sizing and display of 
the window.    The system menu is displayed when you click on the system menu icon (or 
click on the window icon if the window is minimized).

    The system menu icon is located in the upper left corner of a window.



A table is a unit of data storage in a database, usually associated with a single file.    A 
table contains information related to a type of object in the application such as an 
employee, an order, etc.    A table contains any number of records, each dealing with a 
single person or thing.    Records are divided into data items, or fields, which are single 
pieces of data, or data objects, that relate to the record.



A text box is a form control that is used to display and edit a field of type Text.    The text 
box contains multiple lines of text that can scroll vertically.



The title bar is the area at the top of a window, including the Ad Hoc main window and the
desktop objects, that contains the title of the window.    If the window is active, the title bar 
will be displayed with the highlighted color.    You can move a window by dragging its title 
bar.



A total field in a report is a report field that accumulates a running total of the value in a 
designated field in the report view as records are printed in the report.    A total field can 
compute a total, count, average, minimum, or maximum of the field values.



Menu Commands Reference
File Menu
Edit Menu
Options Menu
Report Menu
Database Menu
Tables Menu
Window Menu
Help Menu
Form Menu
Form Design Menu
List Menu Commands
List Design Menu



File Menu
Command Summary
New Print Report
Open Display Report
Close Printer Setup
Delete Design Report
Form Links Delete Report
Save Database
Save Desktop New Database
Read From File Exit

Edit Menu
Command Summary



Options Menu
Command Summary
Desktop Configuration
Database Options
Confirmation Options
FastMenu Options
Diagnostics Options



Database Menu
Command Summary
Open Database
Close
Create New Database



Tables Menu
Command Summary Edit Database 

Information
Show Tables Window Rebuild Table File
Update Tables Window Empty Table File
New Table Run Database 

Diagnostics
Edit Table Definition Run Table Diagnostics
Delete Table

Report Menu
Command Summary Total Fields
Elements Computed Fields
Regions Insert Field
Layout Print
Edit Startup Dialog Display
Data View Run Diagnostics
Report Breaks

Window Menu
Command Summary



Help Menu
Command Summary



File Menu Command Summary

New
Creates a new desktop object.    Desktop objects include forms, lists, and reports.    An 
empty window for the object is opened on the desktop.    You use the design menu for the 
object to design its layout, data view, etc.

Open
Opens an existing form, list, desktop layout, or report design stored in the forms table.

Close
Closes the active object on the desktop.    

Delete
Deletes a form, list, or desktop layout from the database.

Form Links
Links the active Form or List to other Forms or Lists on the desktop.    The active form 
becomes a master to the linked forms, controlling the data that is displayed in the linked 
form.

Save
Saves the design of the currently active desktop object in the database.    This command 
saves forms, lists, or report designs.

Save Desktop
Saves the current layout of the desktop.    The desktop layout is saved under a unique ID 
that you can use later to recall the layout.    The layout saved includes all form and list 
objects currently on the desktop, their current size and position on the desktop, and all 
links defined between them.

Read From File
Reads a desktop object (form, list, or report) from a DOS file and loads it onto the desktop.

Save To File
Saves a desktop object (form, list, or report) to a DOS file.

Print Report
Prints a report selected from the reports table.

Display Report
Display a report on the screen in a Report Display Window.

Printer Setup
Selects and configures a printer connected to your system that will be used by Ad Hoc to 
print reports.

Design Report
Opens a report design that has been stored in the reports table.

Delete Report
Deletes a report design stored in the reports table.



Exit
Closes all open desktop objects and exits Ad Hoc.
When no database is currently open, most of the above commands do not appear on the 
file menu, and the following commands are added.    A list of the most recently opened 
databases (up to four) appears at the bottom of the menu.    To open one of these 
databases, select its entry. 

Open Database
Opens a database.    This command appears on the File Menu only when there is no 
database currently open

New Database
Enables you to create a new database.    This command appears on the File Menu only when
there is no database currently open.



Edit Menu Command Summary
The Edit Menu is a standard Windows program Edit menu that allows you to cut and paste 
information on the screen.    The edit menu commands operate in Ad Hoc to cut and paste 
text in the form edit and textbox controls.

Undo
Reverses the last cut, copy, paste, or delete action.

Cut
Copies the selected text or object to the Windows clipboard, and then deletes it from Ad 
Hoc

Copy
Copies the selected text or object to the Windows clipboard

Paste
Pastes the contents of the Windows clipboard into the location specified by the user.    If 
pasting text, the text on the clipboard is inserted at the blinking cursor in an edit or textbox
control on a form.    If text is selected in the control, it is replaced by the contents of the 
clipboard.

Delete
Deletes selected text in a form edit or textbox control.



Options Menu Command Summary

Desktop Configuration
The Desktop Configuration command displays the Desktop Configuration dialog, which 
enables you to set options concerning how the desktop is saved until the next Ad Hoc 
session, and how keystrokes can be used to move to desired entries on lists.

Database Options
The Database Options command displays the Database Options dialog, which enables you 
to select options for the operation of the database manager.

Confirmation Options
The Confirmation Options command displays the Confirmation Options dialog, which 
enables you to select which database operations Ad Hoc will confirm with you before it 
proceeds.

FastMenu Options
The FastMenu Options command displays the FastMenu Options dialog, which enables you 
to tailor a popup menu that appears when you click the right mouse button on the Ad Hoc 
Desktop.    This menu allows you to quickly select a form to display or report to print.



Desktop Configuration Dialog
The Desktop Configuration dialog is displayed by selecting the Desktop Configuration 
command on the Options menu.    Use the Desktop Configuration dialog to set the way the 
Ad Hoc Desktop is displayed when you start the program, and to select the method by 
which keystrokes help you to find a desired entry on a list.

Dialog Options

Open with last database
If this option is checked, Ad Hoc will remember which database is open when you exit the 
program, and will reopen this database the next time you start Ad Hoc.    If this option is not
checked, Ad Hoc will not open a database automatically the next time you start it.
If you start Ad Hoc from a command line (such as with the Program Manager Run 
command) with a database specified on the command line, this option is not enabled, and 
the database is not remembered the next time you start Ad Hoc.

Save window size and position
If this option is checked, Ad Hoc will remember its main window size and position on the 
screen, and will appear with the same size and in the same position on the screen the next 
time you start Ad Hoc.    If this option is not checked, Ad Hoc will start with a default size 
and position for its main window.    The default is:    the top of the Ad Hoc window will be at 
the top of the screen, the width will be the full width of the screen, and the bottom of the 
window will extend down almost to the bottom of the screen.    You can resize and move the
Ad Hoc window after Ad Hoc starts. 

Save Desktop
If this option is checked, Ad Hoc will save the desktop that is current when you close a 
database, and will redisplay this desktop layout the next time you open that database.

Keystroke Navigation for Lists
To select an entry on a list, you can use the arrow keys to move the selection up and down, 
or use the other scrolling keys to go to the top or bottom of the list.    For long lists, that 
may be displaying thousands of records, a better method is required.    Some lists contain a 
search control that helps you find an entry by typing in a search keyword.    If the list does 
not display a search control, you can use keystroke navigation to get the same effect.
The keystroke navigation option you select is operable whenever a list has the input focus 
(whenever an arrow key would move the highlight on the list).    It works for lists with or 
without search controls.

No Keystroke Navigation
When you select this option, all forms of keystroke navigation are turned off.    You can still 
move the highlight on the list with the up and down arrow keys, and the Home, End, PgUp, 
and PgDn keys.    But typing letters or numbers has no effect on moving the selection bar 
on the list.

Progressive Key Navigation
Select this option if you want to use progressive keystroke navigation in lists.    Progressive 
keystroke navigation works much like a list search control.    When the list has the input 
focus, and you type a letter or digit, this letter is added to a search string.    If the list has a 
search control, the search string is displayed in the search control, otherwise you can't see 
it.    The search string is then used to find the entry with the closest match, as explained in 
the search control topic.    The highlight will be moved to this entry.    As you continue typing



letters or digits, they are appended to the search string and the highlight moves each time 
to the closest matching entry in the list.    If you press the backspace key, the last character
in the search string is removed and the highlight moves back to the previous record.
To cancel a search string (for example to start another search), press the SPACE BAR.    The 
highlight will not move from the current record, but the next letter you type will start a new
search.
Progressive keystroke navigation is the easiest way to find a record when the list holds 
hundreds or thousands of entries.

Single-key (Windows standard)
Select this option if you want Ad Hoc lists to work like standard listboxes that you find in 
dialogs in most Windows programs.    This type of keystroke navigation uses only a single 
letter or digit to search for an entry.    When you type a letter key, for example, the first 
entry in the list that starts with that letter is highlighted.    When you type that key again, 
the next entry in the list starting with that letter is highlighted.    When you reach the last 
matching entry, typing the letter key again takes you back to the first match.

Reset Search with SPACE BAR
This option applies to progressive keystroke navigation.    As explained above, when you 
press the SPACE BAR when navigating a list, this will reset the search string.    If you want to
include spaces in your search string, you can turn this option off, and then when you type 
the SPACE BAR, a space is added to your search string.
If this option is turned off, you can reset the search string by holding down the SHIFT key 
and typing the SPACE BAR.



Database Options Dialog
The Database Options dialog is displayed by selecting the Database Options command on 
the Options menu.    It enables you to set various operating options for the Ad Hoc database
engine.

Dialog Options

Record Locking
This option determines whether record locking will be in effect when Ad Hoc retrieves 
records from the database in order to update them.    When record locking is in effect, when
you make changes to a record on a form, Ad Hoc locks the record so another user cannot 
update the same record until you are finished with it.    If you are editing a record on one 
form, record locking also keeps you from making changes to the same record on another 
form until you have accepted the changes on the first form.
Note: Record locking will not be in effect on a standalone computer, even though this 
option is checked, unless you have run the DOS SHARE.EXE program before you start 
Windows.    
For proper operation of Ad Hoc, whether or not you want record locking,    you must run 
SHARE.    It is recommended that you include a line in your autoexec.bat file to run 
share.exe, so that share is loaded each time your computer is booted.    If you start 
Windows in your autoexec.bat file, make sure the command to run share is before the 
command to run Windows.

Send Data Change Notices
Set this option if you want changes that you make in one form or list to be immediately 
displayed in all other open forms or lists.
With this option on, whenever a change is made to a record in a database table, either by 
editing a record on a form, or deleting or adding a record, or some other change to the 
database caused by a process running in the background, the change will be immediately 
reflected in all forms and lists open on the desktop, as well as in the Tables Window.
If this option is off, changes to data made on one form will not be displayed in other forms 
until you reload the changed record(s) into the form with a Next Record, Previous Record, 
etc. command.    It is recommended that you leave this option ON.



Confirmation Options Dialog
The Confirmation Options dialog is displayed by selecting the Confirmation Options 
command on the Options menu.    It enables you to select the operations that Ad Hoc will 
confirm with you before it carries them out.

Dialog Options

Updating a database record
Select this option if you want Ad Hoc to ask you to confirm changes that you have made to 
a record before those changes are put into the database.    Changes you have made to a 
record on a form are updated when you move to another record on the form, start a new 
record, or close the form.    If you don't select this option, the changes are updated 
automatically.    Not selecting this option is equivalent to selecting the Automatic Record 
Update option in previous versions of Ad Hoc.

Deleting a database record
Select this option if you want Ad Hoc to confirm your request to delete a record on a form 
or list.

Rebuilding a table
When you request that a database table be rebuilt with the Rebuild Table command, Ad Hoc
will ask you to confirm the operation if this option is set, otherwise it will immediately start 
the rebuild.

Redefining a table that has records
When you select the Edit Table Definition command for a table that has records in it, Ad 
Hoc notifies you that the table has records and it may have to be rebuilt if you make certain
changes.    This notification will take place if this option is set.

Closing a database
Set this option if you want Ad Hoc to ask you to confirm the closing of a database whenever
you use the Close Database command, or before closing the current database when you 
ask Ad Hoc to open a different database.



FastMenu Options Dialog
Select the FastMenu command on the Options menu to display this dialog.    The FastMenu 
Options dialog enables you to tailor a pop-up menu that appears whenever you click the 
right mouse button when the cursor is over the Ad Hoc Desktop.    This menu    contains 
selections that make it easier to quickly open a form or print a report.    You can select any 
or all of the following to appear on this menu

Dialog Options

None
Check this option to un-checked all the others.    With no options selected, the pop-up menu
will not appear.

Open Dialog (Forms)
Check this option to place an Open Form command on the pop-up menu.    This command 
has the same action as the Open command on the File menu.

List of Recent Forms
Check this option if you want the pop-up menu to include the most recently opened forms 
or lists in the current database.    When you open a form or list, it is added to the top of the 
recent forms list.    When you select one of these entries when the pop-up is displayed, the 
corresponding form or list will be opened.    When you open a form this way, Ad Hoc will 
place the form on the desktop so that its upper left edge is a close as possible to the point 
where you pressed the right mouse button.    It will adjust this position to try to display all of
the form or list.    
Ad Hoc keeps track of the most recent forms opened for each database you have created.

Design Report Dialog
Check this option if you want the pop-up menu to include a Design Report command, which
will have the same action as the Design Report  command on the File Menu.

Print Report Dialog
Check this option if you want the pop-up menu to include both a Print Report command, 
which will have the same action as the Print Report command on the File Menu, and a 
Display Report command, which will have the same action as the Display Report command 
on the File Menu.

List of Recent Reports
Check this option if you want the pop-up menu to include the most recently printed reports 
in the current database.    When you print, design, or display a report, it is added to the top 
of the list.    Selecting one of these entries when the pop-up is displayed will cause the 
corresponding report to be printed, displayed, or loaded into a Report Design Window.
Ad Hoc keeps track of the most recent reports for each database you have created.

Recent Report Options
If you select the "List of Recent Reports" option, you can further select what will be done to 
a report selected from the recent list.    The options you can select are

Print to print the report
Display to display the report output in a report display window
Design to open a report design window for the report

If you select only one of these options, the corresponding action will appear before the 
report name on the FastMenu.    (for example "Print Employee Report").    If you select one or



more of these options to appear on the FastMenu, a further level of menu will be appended 
to each recent report entry on the FastMenu, containing the options you select.

Maximum number of recent forms
If you have checked the recent forms options, this entry will determine the maximum 
number of recent forms that will appear on the pop-up menu.    You can select any number 
from 1 to 6 recent form menu entries.

Maximum number of recent reports
If you have checked the recent reports options, this entry will determine the maximum 
number of recent reports that will appear on the pop-up menu.    You can select any number
from 1 to 6 recent report menu entries.



Diagnostics Options Dialog
The Diagnostics Options Dialog enables you to set when the results of a diagnostics test are
displayed.    Whenever you open a form, list, report window, or database, Ad Hoc runs a 
diagnostics check on the integrity of the design.    If errors are found, Ad Hoc displays a 
window with the results of the diagnostics if the severity of problems exceeds a threshold 
that you set.    This lets you quickly tell if you have a conflict between a form design, for 
example, and the design of the database fields used on the form.    (See Diagnostics for 
details on the diagnostics procedures).
The Diagnostics Options Dialog lets you set the error threshold independently for Forms 
(and Lists), Reports, and Databases.    

Level Diagnostics are displayed when

Fatal Errors Only when fatal errors are detected
Errors When fatal or other errors are detected
Warnings Whenever any anomaly is found that may cause a problem
Always Always, even if there are no errors

The popup menus on forms, lists, report design windows, and report output windows also 
contain a Run Diagnostics command, to allow you to check the design of an object at any 
time.



Database Menu Command Summary

The Database Menu appears only when a database is open.    The most recently opened 
databases (up to four) appear at the bottom of this menu.    To open one of these 
databases, select its entry.

Open Database
Displays the File Open Dialog to enable you to open a database.

Close
Closes the currently open database.

Create New Database
Enables you to create a new database.



Tables Menu Command Summary
The Tables Menu is associated with the Tables Window.    When the Tables Window is not 
displayed on the desktop, the only command available is Show Tables Window.    When 
the Tables Window is open on the desktop, the first command on the menu becomes Hide 
Tables Window, and the other commands are enabled as appropriate.

Show (Hide) Tables Window
Displays (opens) or closes the Tables Window.

Update Tables Window
Updates the status information displayed in the tables window.

New Table
Enables you to define a new table for the database.

Edit Table Definition
Enables you to change the definition of a table in the database.

Delete Table
Enables you to delete a table definition from the database.    This command optionally 
enables you to delete the file associated with the table definition.

Rebuild Table File
Enables you to rebuild a damaged database table file.    This command creates a new table 
file and copies records into it from the old table file.    If the copy is successful, the old file is
deleted.    Otherwise, the new file is deleted and the old file remains unchanged.

Empty Table File
Removes all of the information stored in a table.    This command deletes the old table file 
and creates a new empty file for the table.

Edit Database Information
Enables you to change the general design attributes of the database, such as its 
description.

Create New Database
Enables you to create a new database.

Run Database Diagnostics
Runs a diagnostics test on the design of the database.

Run Table Diagnostics
Runs a diagnostics test on the design of the table selected in the Tables Window.



Report Menu Command Summary
The Report Menu appears on the Ad Hoc menu bar only when a report design window is the
currently active desktop object.    This menu contains commands that allow you to design a 
report and test it.

Elements
Displays a list of elements defined for the report, from which you can add new elements, 
edit the attributes of an element, or delete elements.

Regions
Displays a list of regions defined for the report, from which you can add new regions, edit 
the attributes of a region, or delete a region.

Layout
Displays the Report Layout dialog, with which you can define the design attributes of the 
report.

Edit Startup Dialog
Displays the Startup Dialog associated with the report, and allows you to design it by 
placing controls on it that are associated with report fields.    This command is available 
only if you have designated that the report will have a startup dialog on the Report Layout 
dialog.

Data View
Displays the Edit View dialog, enabling you to design the database view that will be 
associated with the report.

Report Breaks
Displays the Report Breaks dialog, with which you can define break levels for the report.    A
break level happens whenever a new record is read and the value of the field associated 
with the break level is different from the value in the previous record.

Total Fields
Displays a list of total fields that have been specified for the report, and enables you to add
new total fields, change the definition of total fields, or delete total fields from the report.

Computed Fields
Displays a list of computed report fields, and enables you to add new computed fields, 
change the definition of computed fields, or delete computed fields from the report.

Insert Field
Displays a list of all the report fields that have been defined for the report, and enables you
to select a field to be inserted at the current position (the position of the blinking cursor) in 
the report edit window.

Run Diagnostics
Runs a diagnostics test on the report.

Print
Prints the report being designed in the currently active Report Edit window.

Display
Opens a report display window to display the output of the report being designed.





Window Menu Command Summary

Tile
Arranges all open desktop objects in a tiled layout.    If you select this command, Windows 
will move all the desktop objects and change the size of some objects.    Form objects will 
not change size, but lists, report designs, and the Tables Window will change size to fit the 
tiling pattern.

Cascade
Arranges all open desktop objects in a cascading layout.    If you select this command, 
Windows will move all the desktop objects and change the size of lists, report designs, and 
the Tables Window.    Forms will not change in size.

Arrange Icons
Arranges the icons of all desktop objects that have been minimized.

Close All
Closes all open desktop objects.    If the object design has been edited, Ad Hoc will prompt 
you to save the design.



Help Menu Command Summary

Contents
Displays the help system table of contents.

Search
Search for help on a topic in the help system index

Context
Display context sensitive help.    The help topic that appears depends upon the desktop 
object that is currently active.    This menu command gives the same results as pressing the
F1 key.

Commands
Displays the menu commands reference in the help system.

Using Help
Displays help on using the help system.

About
Displays a dialog box with information about Ad Hoc.



Form Menu Command Summary
The Form Menu contains commands that allow you to retrieve records from the database, 
control the updating of the record displayed in the form, and perform other run-time 
operations on the data associated with the form.
The Form Menu is not displayed on the Ad Hoc menu bar.    Instead, you display the Form 
Menu by clicking the right mouse button when the cursor is positioned over the free area of
a form object on the desktop, or by pressing Alt-M when a form is the active desktop object.
The "free area" of the form is any part of the form that is not a form control or a scrolling 
region.    When the form is in design mode, this action will display the Form Design Menu.    
When the form is not in design mode, this action will display the Form Menu.
The Form Menu contains the following commands:

Find
Displays the search list for the form, which allows you to browse through the records in the 
view attached to the form and select a record to be loaded into the form.    This command is
available only if the form has been designed with a search list.    

Next
Loads the next record from the view into the form.    The order of records in the view is 
determined by (in this order) the sort index you select in the search list (if there is one), by 
the sort order you specified in the design of the view (if one was specified), or by the 
primary key.

Previous
Loads the previous record from the view into the form.    The order of records in the view is 
determined by (in this order) the sort index you select in the search list (if there is one), by 
the sort order you specified in the design of the view (if one was specified), or by the 
primary key.

First
Loads the first record from the view into the form.    The order of records in the view is 
determined by (in this order) the sort index you select in the search list (if there is one), by 
the sort order you specified in the design of the view (if one was specified), or by the 
primary key.

Last
Loads the last record from the view into the form.    The order of records in the view is 
determined by (in this order) the sort index you select in the search list (if there is one), by 
the sort order you specified in the design of the view (if one was specified), or by the 
primary key.

New
Blanks out the data displayed on the form, allowing you to enter a new record into the 
database.    This command is only available if the form has been designed to add new 
records to the view.

Update
Updates the displayed record in the database if changes have been made.    This command 
is available only if the form has been designed to allow changes to data, and you have 
changed one or more of the fields on the form.

Cancel



Cancels changes to the data on the form, restoring all fields to their original value.

Delete
Deletes the current record displayed on the form.    If you select this command, Ad Hoc will 
ask you if you want to delete the record.    Respond Yes to delete it, No to avoid deleting the
record.    This command is available only if the form has been designed to allow deletion of 
records.

Import
Initiates a data import using the data exchange template attached to the form.    This 
command is only available if the form has been designed with a data exchange template.

Export
Initiates a data export using the data exchange template attached to the form.    This 
command is only available if the form has been designed with a data exchange template.

Form Links
Links the form to another form or list on the desktop.    The active form becomes a master 
to the linked form or list, controlling the data that is displayed in it.

Run Diagnostics
Runs a diagnostics test on the form design.

Design Mode
Places the form in design mode, allowing you to make changes to the design of the form.    
In design mode, you can display records from the database on the form, but you cannot 
add, edit, or delete records.



Form Design Menu Command Summary
The Form Design Menu contains commands that you will use to design the form layout and 
operation.    With these commands you can change the design attributes and database 
permissions of the form and add form controls and scrolling regions.
The Form Design Menu is not accessible from the Ad Hoc menu bar.    Instead, you display it
by clicking the right mouse button when the cursor is positioned over the free area of the 
form, or by pressing Alt-M when a form is the active desktop object.    The "free area" of the 
form is any part of the form that is not an item such as an edit control or scrolling region.    
When the form is in design mode, this action will display the Form Design Menu.    When the
form is not in design mode, this action will display the Form Menu.
The following commands are on the Form Design Menu:

Form Attributes
Use this command to display the Form Attributes Dialog.    You use this dialog to define the 
Form ID, the form description, and set custom attributes of the form.

Data View
Use this command to display the Edit View Dialog.    You use this dialog to define the fields 
that are in the view associated with the form, as well as the sort order and selection filter of
the view.

Data Exchange Template
Use this command to display the DX Template Dialog.    You use this dialog to define the 
characteristics of the data exchange template attached to the form.    This command is 
accessible only if you have checked the Data Exchange Template check box on the Form 
Attributes Dialog.

Fonts
Displays the form Fonts dialog, where you can specify the fonts to be used to display 
control titles and data on the form.

Colors
Displays the form Colors dialog, where you can specify the colors to be used to display the 
form.

Control Attributes
Displays the attributes dialog for the selected control or controls.    You use this dialog to 
define the characteristics of a form control, such as the field it is associated with, its title, 
the position of the title, and its display style.    If more than one control is selected, the 
attributes dialog for each control will be displayed in sequence.    If no controls are selected,
this command is grayed.

New Edit
Enables you to insert a new edit control on the form.    Ad Hoc will display the Edit Control 
Attributes dialog.    When you accept the entries on the dialog, the mouse cursor will appear
as a cross.    Position the cursor at the spot on the form where you wish the upper left 
corner of the edit control to be located, and press the left mouse button.    The new control 
will be displayed on the form.

New Combo Box
Enables you to insert a new combo box control on the form.    Ad Hoc will display the combo
box Attributes dialog.    When you accept the entries on the dialog, the mouse cursor will 



appear as a cross.    Position the cursor at the spot on the form where you wish the upper 
left corner of the control to be located, and press the left mouse button.    The new control 
will be displayed on the form.

Next Text Box
Enables you to insert a new text box control on the form.    Ad Hoc will display the Text Box 
Attributes dialog.    When you accept the entries on the dialog, the mouse cursor will appear
as a cross.    Position the cursor at the spot on the form where you wish the upper left 
corner of the control to be located, and press the left mouse button.    The new control will 
be displayed on the form.

New Scroll Region
Enables you to insert a scroll region on the form.    The cursor will change to a cross-hairs.    
Position the cursor to the location you desire for the upper left corner of the scroll region, 
then press the left mouse button and drag the bottom right corner of the region to the 
desired location.    When you release the mouse button, Ad Hoc will display two dialogs in 
succession to allow you to define the scrolling region before it is displayed:    the List 
Attributes Dialog allows you to define the design attributes of the scroll region, and the Edit
View Dialog allows you to define the database view associated with the list region.
When you have entered the design information in these two dialogs, Ad Hoc displays an 
imbedded list form in the scroll region.

Quick Layout
Enables you to quickly lay out the controls of a new form.    When you select this command, 
Ad Hoc displays the Quick Form Layout dialog, where you can define the layout of controls 
on the form.    When you accept the entries on the dialog, Ad Hoc adds the controls you 
specified to the form.    You can perform a quick layout only on a form that contains no 
controls.

Delete Control
Deletes the selected control (or controls) from the form.

Align Left
Moves all selected controls so that the left edges of the data areas of the controls are 
aligned.    The leftmost of the selected controls is not moved, but all other controls are 
moved left to align with it.

Align Top
Moves all selected controls so that the top edges of the edit areas of the controls are 
aligned.    The topmost control is not moved, but all others are moved upwards to align with
it.

Set Tab Order
Enables you to set the tabbing order of the controls on the form.    This is the order in which 
the controls will receive the input focus when you press the Tab key.    When you select this 
command, the cursor changes to the Tab Order shape.    Move the cursor to the first control 
in the tabbing order, and press the left mouse button.    The control will be highlighted.    
Continue clicking on the controls in the order that you want.    When the last control is 
highlighted, the cursor will change back to its regular appearance, indicating that all the 
controls have been ordered.    You can exit the tab order mode at any time by selecting the 
Set Tab Order command again.    The controls that you order before exiting stay in the new 
tab order.

Run Diagnostics



Runs a diagnostics test on the form design.

Leave Design Mode
Takes the form out of design mode.    The form then can be used to add, edit, and delete 
records in the database.



List Menu Command Summary
The List Menu contains commands that allow you to perform operations on the data 
associated with the list.
The List Menu is not displayed on the Ad Hoc menu bar.    Instead, you display the List Menu
by clicking the right mouse button when the cursor is positioned over the list, or by 
pressing Alt-M when a list is the active desktop object.    When the list is in design mode, 
this action will display the List Design Menu.    When the list is not in design mode, this 
action will display the List Menu.
When you click the right mouse button over the scrolling area of the list, the list entry 
under the mouse cursor is selected so that the commands on the List Menu can be applied 
to the selected entry.
The List Menu may contains the following commands:

Add Record
Enables you to add a record to the database through the pop-up edit form associated with 
the list.    This command is not available if the list has not been designed to add records to 
the database.

Edit Record
Enables you to edit the record associated with the highlighted entry in the list.    The editing
is done on the pop-up edit form associated with the list.    This command is not available if 
the list has not been designed to edit records.

Delete Record
Enables you to delete the record associated with the highlighted entry in the list.    When 
you select this command Ad Hoc will ask you to confirm the deletion.    This command is not
available if the list has not been designed to add records to the database.

Form Links
Links the form to another form or list on the desktop.    The active form becomes a master 
to the linked form or list, controlling the data that is displayed in it.

Run Diagnostics
Runs a diagnostics test on the list design.

Design Mode
Places the list in design mode, so that you can change the design attributes and database 
permissions of the list.



List Design Menu Command Summary
The List Design Menu contains commands that you will use to design a list object on the 
desktop.    With these commands you can design the database view associated with the list,
define the columns that will be displayed on the list, and design other characteristics of the
list.
The List Design Menu is not accessible from the Ad Hoc menu bar.    Instead, you display it 
by clicking the right mouse button when the cursor is positioned over the list object on the 
desktop, or by pressing Alt-M when a list is the active desktop object.    When the list is in 
design mode, this action will display the List Design Menu.    When the list is not in design 
mode, this action will display the List Menu.
The following commands are on the List Design Menu:

Data View
Displays the Edit View Dialog.    You use this dialog to define the database view associated 
with the list, the fields of the database view, its sort order and selection filter criteria.

List Attributes
Displays the List Attributes Dialog, which enables you to:

Design the columns displayed in the list
Design the control buttons on the list
Determine if the list will have an associated popup edit form
Determine if the list will have a search control
Determine if the list will have an index control

Fonts
Enables you to specify the fonts to be used for the column headings and entries in the list.

Colors
Enables you to specify the colors of the various areas of the list.

Control Style
This command appears only for lists that are embedded in forms as scrolling regions.    It 
enables you to specify the control attributes associated with the list, such as a the title.

Link to Parent
This command appears only for lists that are embedded in forms as scrolling regions.    It 
enables you to define the data link between the list and the form it is embedded in.    
Use this command to display the Edit Link Dialog, which you use to define the link between 
the list and the form you have placed it on.

Run Diagnostics
Runs a diagnostics test on the form design.

Leave Design Mode
Takes the list out of design mode.    The list then can be used to add, edit, and delete 
records in the database.



Report Display Window Menu Command Summary
You display the report display window menu by clicking the right mouse button when the 
cursor is over the display area of a report display window.    The following commands are on
the menu:

Select Report
Select this command to open the Print Report dialog, from which you can select a report to 
be displayed in the window.

Restart Report
Select this command to generate the current report again after you have changed display 
options or changed the design of the report.    While a report is being generated, this 
command becomes "Stop Report" and selecting it will stop the report generation.

Options
Select this command to display the Report Display Window Options dialog, which enables 
you to view and change the report display window options.

Go To Page
Select this command to type in the number of the report page that you want to display.

Next Page
Select this command to display the next page of the report.

Previous Page
Select this command to display the previous page of the report.

First Page
Select this command to display the first page of the report.

Last Page
Select this command to display the last page of the report, or, if the report is still being 
generated, the last generated page.

Run Diagnostics
Runs a diagnostics test on the design of the currently loaded report.



New Command    (File menu)
Use the New Command on the File Menu to create a new desktop object.    This command 
displays a dialog containing a list of the types of objects you can create:

Object Type Description

Form A data entry form with edit 
controls for editing records.   
Each control on the form 
displays a field from the 
view associated with the 
form.    A form displays one 
record at a time.

List A scrolling list that displays 
several records at a time.    
Each column of the list 
corresponds to a field in the 
view associated with the list.

Report (Quick Setup) A report design window, with
a Quick Report Setup Dialog 
that helps you quickly set 
the basic design for a 
standard report style.

Report (Label Style) A report design window, with
a label-style layout dialog.    
(See Label Report Layout 
Dialog)

Report (detailed 
design)

A report design window that 
enables you to design a 
report from scratch.

To select a new object type from the dialog, double click on the desired type, or use the 
cursor keys to highlight the desired type, then either click on the OK button or press the 
ENTER key.
To put away the dialog without selecting an object, click on the CANCEL button, or press the
ESCAPE key.
When you select an object type, a new object of that type will be displayed on the screen.    
You can then design the layout, database view, and other attributes of the object and then 
save it in the database.



Open Command    (File Menu)
Use the Open Command on the File Menu to select a form, list, or desktop layout from the 
Forms Table and open it on the desktop.    The types of desktop objects that can be opened 
with this command are:

Object Type Description

Form A data entry form with edit controls 
for editing records.    Each control on 
the form displays a field from the 
view associated with the form.    A 
form displays one record at a time.

List A scrolling list that displays several 
records at a time.    Each column of 
the list corresponds to a field in the 
view associated with the list.

Desktop A desktop layout that you have 
previously saved with the Save 
Desktop command.

When you select this command, Ad Hoc displays the Open Dialog.    This contains a list of 
the desktop objects stored in the database sorted by the long description given the object 
when it was designed.    The type of each object is also displayed.    Check boxes below the 
list allow you to select the types of objects that will appear in the list.
To select and open an object, double click on the list entry, or highlight the entry in the list 
and either press the ENTER key or click the OK button.    To close the Open dialog without 
selecting an object, press the ESCAPE key, or click on the CANCEL button.
Forms and lists will be displayed on the desktop at the position and with the size they were 
given when designed.    If you open a desktop, the objects will be displayed with the size 
and position they had when the desktop was saved.



Close Command    (File Menu)
Use the Close Command on the File Menu to close the currently active desktop object.    The
active desktop object is the one with the highlighted border and title bar that is responding 
to keyboard input.    If you have changed the design of the object since it was last saved, Ad
Hoc will ask you if you want to save the object (Form, List, Report, etc.).    Your response to 
this can be:

Response Action

Yes The object design changes will be saved
in the database and the object will be 
removed from the desktop.

No The design changes to the object will 
not be saved.    The object will be 
removed from the desktop and the 
design changes will be lost.

Cancel The object will not be removed from the 
desktop, changes will not be saved.

Delete Command    (File Menu)
Use the Delete Command on the File Menu to delete a form, list, or desktop layout from the
database.    When you select this command, Ad Hoc displays the Delete dialog, containing a
list of the forms, lists, and desktops stored in the Forms Table.    Below the list are check 
boxes that you can use to select the type of objects that appear in the list.
Double click on the entry in the list that you want to delete from the database, or highlight 
the entry and either press the ENTER key or click the OK button.    Press the ESCAPE key or 
click the Cancel button to close the dialog box without deleting an object.
When you select an object, Ad Hoc will ask you if you want to delete it.    Respond Yes to 
delete the object, No to leave it in the database.
Warning:    When you delete an object from the database, it cannot be retrieved, unless 
you have made a backup of your database



Form Links Command    (File Menu and Form Menu)
Use the Form Links Command to display the forms or lists that are linked to the currently 
active form (or list), and to edit the links.    This command will link two forms together so 
that the contents of the record displayed in one form (the master form) controls the records
that are displayed in the other form (the linked, or dependent, form).    The Form Links 
command can also be used to edit an existing link between two forms or to remove a link.
In Ad Hoc, two form objects on the desktop can be linked together to display related 
information.    The values of data fields defined in the view of the master form are used to 
filter the view of the linked form.    Usually the linked form would be a list; a linked list would
display records linked to the record displayed on the master form.    Any two forms on the 
desktop can be linked together if their data views share common fields.    For example, 
suppose in an order entry system that the Customer Master form is displayed on the 
desktop, and as you work with the customer records you wish to see a list of recent orders 
for the customer.    You could open a list form on the desktop that displays records from the 
Order file, and link list to the Customer Master form so that only orders for the customer 
record displayed on the Customer Master Form appear in the Orders list form.    If this were 
a configuration that you used often, you could save it as a desktop layout in the database.

To link two forms

1. Make sure that both forms are open on the desktop.    
2. Make sure that the form or list that is to be the master is active.    (One way to do this is 

to click on it. )
3. Select the File Form Links command.
4. Describe the link on the Form Links Dialog.
5. Close the dialog with the OK button or by pressing ENTER.
The forms will be linked until you remove the link with the Form Links command, or until 
one or both of the forms are closed.



Save Command    (File Menu)
Use the Save command when you have designed a new desktop object (Form, List, Report, 
etc.) or have changed its design and want to save it permanently in the database for later 
use.    When the design of a desktop object has changed, or the object is in design mode, 
the Save Command will be enabled.    When it is selected, the currently active object's 
design is saved in the database under the ID that you gave it.
The Save Command applies to the following desktop objects:

Object Type Saved in Table ID specified on

Form Forms Table Form Attributes Dialog
List Forms Table List Attributes Dialog
Report Reports Table Report Layout Dialog

Before you can save the design of an object, you must have given it a unique ID on the 
design dialog specified above.    Objects without IDs cannot be saved.    If another object 
already in the table already has the ID you specified, Ad Hoc will warn you that the current 
object cannot be saved because it has a duplicate ID.    In this case, return to the design 
dialog and change the ID.

Hint
If you want to save a copy of a form, list, or report, and perhaps make some slight changes 
later to the copy, change the ID and save it as a different object.    It would be wise to also 
change the long description of the object so that you can distinguish them on selection 
lists.



Save Desktop Command    (File menu)
Use the Save Desktop Command to save the current desktop layout.    The desktop 
information saved includes the position and size of all form and list desktop objects as well 
as all links existing links between them.
When you select this command, Ad Hoc displays the Save Desktop dialog, which allows you
to enter a unique ID under which the desktop layout will be saved, and a long description 
for the layout.    Enter both the ID and description then respond OK to save the layout, or 
respond Cancel if you decide not to save the desktop layout.    
If you have given the desktop an ID that is already in use by a desktop, Ad Hoc will ask if 
you want to replace the old desktop with that ID with the current desktop layout.    If you 
answer Yes, Ad Hoc will save the current desktop, replacing the old one.    If you answer No, 
the current desktop will not be saved.
If you supply a desktop ID that is already used for another kind of object, Ad Hoc will not let
you save the desktop with that ID.



Read From File Command      (File Menu)
Use the Read From File Command on the File Menu to read a desktop object into Ad Hoc 
from an external file and display the object on the desktop.    The object can subsequently 
be saved in the database with the Save command.
When you select this command, Ad Hoc displays the Open File dialog.    Two types of files 
(distinguished by their filename suffix) can be read using this command:

File Type Object Type

.FRM Forms and lists

.RPT Reports

To read a file

1. Enter the full pathname of the file, including the correct extension, in the File Name 
edit, or

2. Select either Form Template or Report Template in the List Files of Type control.    This 
will display the all the files of the selected type in the current directory.    

3. Select a file by double-clicking it, or highlighting it and clicking OK (or pressing ENTER).    
4. You can use the Directories list or the Drives list to change the current directory.
When you select a file, Ad Hoc will determine that it is a valid file type, and that is 
consistent with the currently open database.    If these checks are successful, the file is read
in and the object is displayed on the desktop.
Use this command with the Save To File Command to export an object from the database 
and import the object into the same database at a later time, or into the same database on 
another computer or network.



Save To File Command    (File menu)
Use the Save To File Command on the File Menu to save an object on the desktop to an 
external file.    Make sure the object you want to save is active, then select the Save To File 
command.    Ad Hoc will display the File Save As dialog.    Navigate the directory in which 
you want to save the file and enter the file name.    Ad Hoc will supply the proper extension. 
If you enter a filename that is already in use, Ad Hoc will ask you if you want to replace the 
old contents of the file.    If you respond Yes, the old contents will be discarded and replaced
by the object you are saving.    If you don't want to lose the old contents, respond No, and 
enter a different file name.
When you select this command, Ad Hoc displays the Open File dialog.    Two types of files 
(distinguished by their filename suffix) can be read using this command:

File Type Object Type

.FRM Forms and lists

.RPT Reports
Along with the object description, Ad Hoc saves the database ID and version number, to 
insure that the object will be compatible with any database that tries to load it.
Use this command with the Read From File Command to export an object from the database
and import the object into the same database at a later time, or into the same database on 
another computer or network.
Note: objects saved with this command are saved to a DOS file, and not saved in the 
database (unless you also use the Save Command).    An object is not considered saved by 
Ad Hoc unless you save it with the Save Command.



Print Report Command    (File Menu)
Use the Print Report Command on the File Menu to select a report from the database 
Reports Table, and print it.    When you select this command, Ad Hoc displays the Print 
Report dialog, which contains a list of all reports in the Reports Table alphabetically by their
long description.
To print a report, double click on its description, or use the cursor keys to highlight the 
report and click on the OK button or press ENTER.    If you decide not to print a report, click 
on the Cancel button, or press ESC.
Before you print a report, you may want to select and configure a printer using the Printer 
Setup Command.    
To print a report that is not stored in the database but is in an .RPT file, first load the report 
with the Read From File Command and then print the report using the Print Command on 
the Report Menu.



Display Report Command (File Menu)
Use the Display Report Command on the File Menu to open a Report Display Window and 
display a report in this window.    When the report display window first opens, you can select
the report you want to display from the Print Report dialog, which contains a list of all 
reports in the Reports Table alphabetically by their long description.    When you select a 
report from this dialog, it is "printed" in the report display window.    
This command also appears on the Report Menu, and on the pop-up menu of the Report 
Design Window.    When you select this command from a Report Design window, the Report 
Display Window is attached to the report you are designing, and can't display other reports.
To display a report that is not stored in the database but is in an .RPT file, first load the 
report with the Read From File Command and then display the report using the Display 
command on the Report Menu.
See Report Display Window and Report Display Window Options Dialog for details on using 
a report display window.



Printer Setup Command    (File Menu)
Use the Printer Setup Command to select and configure a printer that will be used to print 
reports from Ad Hoc.    You may never need to use this command if you have only one 
printer connected to your computer and don't want to change its configuration.
When you select this command, Ad Hoc displays the Printer Setup dialog, which contains a 
list of printers attached to your computer.    To select a printer, double click on its entry, or 
highlight the entry and click the OK button    (or press ENTER). 
To change the configuration of the selected printer, click on the Setup button, or press Alt-
S.    This will display a printer configuration dialog that is specific to the printer you 
selected.    This dialog enables you to change printer settings such as paper size, paper 
source, number of copies, etc.
The printer configuration changes you make are local to Ad Hoc, and will not be seen by 
other programs.    When you exit Ad Hoc, the configuration changes will be discarded.    
Reports can be designed to override some of the printer settings (such as portrait vs 
landscape orientation).    These settings are changed only while the report is being printed.



Design Report Command    (File Menu)
Use the Design Report Command to load a report design that is saved in the database 
Reports Table.    This command displays the Design Report dialog, which lists all the reports 
saved in the Reports Table alphabetically by their long description.    When you select a 
report from this list, Ad Hoc opens a Report Design window on the desktop, enabling you to 
change the design of the report.
To display the report design on the desktop, double click on the report in the list, or 
highlight the report with the cursor keys and click the OK button or press ENTER.    If you 
decide not to open a report design, click the Cancel button or press ESC.



Delete Report Command    (File Menu)
Use the Delete Report Command to delete a report design from the database Reports Table.
This command displays the Delete Report dialog, which lists the reports in the table 
alphabetically by their long description.    To delete a report, double click on its entry, or 
highlight it and click the OK button or press ENTER.    If you do not want to delete a report, 
click on the Cancel button, or press ESC.    Ad Hoc will ask you to confirm the deletion.
Warning:    When you delete a report from the database, it cannot be retrieved, unless you
have made a backup of your database



Exit Command    (File menu)
Use the Exit Command to exit the Ad Hoc program.    If there are desktop objects with 
design changes, Ad Hoc will ask if you want to save the changes for each desktop object 
separately:

Respond To

Yes Save the changes and exit
No Discard the changes and exit
Cancel Cancel the exit and return to Ad Hoc 

(changes will not be saved at this time)

Open Database Command    (Database Menu)
Use the Open Database Command on the Database Menu to change the database that you 
are working with.    When no database is currently open, the command appears on the File 
Menu.
If there is a database already opened, Ad Hoc will ask if you want to close it.

Respond To

Yes Close the currently open database and 
select a new one to open

No To cancel the command
When you close the current database, all open desktop objects will be closed.    If the design
of any of these objects has been changed, Ad Hoc will ask you if you want to save the 
design.    You have the same choice of response as for the Close Command on the File 
Menu.
If you proceed to open a database, Ad Hoc will display the Open File dialog, allowing you to 
select a data dictionary file that contains the description of the database you want to open. 
A data dictionary file has the same name as the database ID, followed by a .DDF suffix.    
You can use the Open File dialog to navigate to the directory in which the desired database 
is located, then select its data dictionary file.    Ad Hoc will open the selected database and 
display its description in the title area of the Ad Hoc window.



Close Command (Database Menu)
Use the Close Command on the Database Menu to close the currently open database.    Ad 
Hoc will ask you to confirm that you want to close the database.

Respond To

Yes Close the currently open database
No To cancel the command

When you close the current database, all open desktop objects will be closed.    If the design
of any of these objects has been changed, Ad Hoc will ask you if you want to save the 
design.    You have the same choice of response as for the Close Command on the File 
Menu.



Create New Database Command    (Database Menu and File Menu)
Use the Create New Database Command to create a new database.    If a database is 
currently open, this command appears on the Database Menu.    If no database is open, this
command appears on the File Menu.
If a database is open when you select this command, Ad Hoc will ask you if you want to 
close the current database.    If you answer NO, no action is taken.    If you answer YES, the 
current database is closed.
The New Database Dialog is displayed, if you fill out this dialog and accept it by pressing 
ENTER or clicking OK, the new database is created.    If you cancel this dialog by pressing 
ESC or clicking Cancel, no database is created.
To create a new database, you must supply a unique ID for the database, a long 
description, and the pathname of a directory in which the database resides.    (See Creating 
a Database).
When the database is created, the system tables are created and the Tables Window is 
displayed.    The status of the system tables will be displayed in the Tables Window.    At this 
point you can begin defining tables for the new database.



Show Tables Window Command    (Tables Menu)
Use the Show Tables Window Command to display the Tables Window on the desktop.    The 
Tables Window lists the tables in the database along with status information on each.    
When the Tables Window is displayed, the other commands on the Tables Menu are 
activated, allowing you to add, edit, or delete table definitions from the database, and 
perform maintenance on table files.
When the Tables Window is displayed, this command becomes Hide Tables Window, in 
which case it closes the Tables Window.    You cannot close the Tables Window if it is 
performing a process, such as translating a table, or rebuilding a table.



Update Tables Window Command    (Tables Menu)
Use this command to cause Ad Hoc to update the table status information displayed in the 
Tables Window.    If you suspect that the status of a table has changed since you opened the
Tables Window, you can use this command to update the status display.
Ad Hoc will automatically update record counts for the tables as records are added or 
deleted from the database.



New Table Command    (Tables Window)
Use the New Table Command to add a new table definition to the database.    The Tables 
Window must be open before you can select this command.    The New Table Command 
displays the Database Table dialog, with which you design the attributes of a new table.    In
order to add a new table, you must fill out this dialog, defining the fields of the table, and at
least one index (the primary key).

To add a new table to the database

1. Select the New Table Command
2. Describe the table and its fields, indexes, and links on the Database Table dialog.
3. Click the OK button on the Database Table dialog, or press ENTER to accept the entries 

you have made
4. Ad Hoc will create a new empty file for the table, and insert the table in the Tables 

Window list
Once you have added a new table definition to the database, you can design forms, lists, 
and reports using the table, and enter information into the table.



Edit Table Definition Command    (Tables Menu)
Use the Edit Table Definition Command to change the definition of a table in the database.   
This command is available when the Tables Window is displayed, and when there are no 
other objects on the desktop, including forms, lists, and reports.    This commands enables 
you to examine or change the definition of the currently selected table in the Tables 
Window.
You can change the definition of a database table at any time, including adding, changing, 
and removing fields, indexes, and links to other tables.    But you must be careful of the 
following:

Ad Hoc does not check forms, lists, reports, or link definitions for other tables to see if
they would be affected by changes you make in a table.    Make sure your changes do not 
affect these objects, or they will not operate properly.

Do not delete a field if you have forms with controls associated with the field, or if the
field is used on a report.    If you do, make sure you change the design of the forms and 
reports that reference the deleted field.

Do not change the primary key (the first index) if you have defined links in other 
tables that link them to this table.    If you must change the primary key, make sure you 
change the link definitions in the other tables.

If you change the file name or path name in the table definition, Ad Hoc may not be 
able to find the table file, unless you also rename the table file (using Windows File 
Manager).
Some changes that you make to a table definition require the table to be rebuilt.    
Examples of these are adding, changing, or deleting fields from the tables, and changing 
the index definitions.    If you make these changes and accept them by clicking OK on the 
Database Table dialog, Ad Hoc will warn you that the table will have to be rebuilt and ask 
you if you want to proceed.    If you respond YES, Ad Hoc will proceed with rebuilding the 
table.    If you answer NO, you will return to the Database Table dialog.    At this point you 
can Cancel the changes, and no changes will be made to the table definition.
Some changes do not require the table to be rebuilt, and if you accept these changes by 
clicking OK or pressing ENTER, Ad Hoc will incorporate the changes into the data dictionary 
and update the status display in the Tables Window.
If Ad Hoc determines that a table must be rebuilt, and you allow it to proceed, a process 
window will open on the desktop, displaying the progress of the rebuild.    You can cancel 
the rebuild and discard the changes by clicking on Cancel in this window, or you can wait 
until the process is complete and click on OK (or press ENTER).    While a table is being 
rebuilt, you cannot open any other desktop objects (forms, lists, reports) or exit Ad Hoc.    
You can edit or rebuild another table, however.



Delete Table Command    (Tables Menu)
Use the Delete Table Command to delete a table from the database.    This command is 
available if the Tables Window is displayed and no forms, lists, or reports are open on the 
desktop.    This command deletes the table that is currently selected in the Tables Window.
If you select this command, Ad Hoc will ask you to confirm that you want to delete the 
table.    If you respond YES, the table definition will be deleted.    If a file is associated with 
the table, Ad Hoc will ask you if you also want to delete the file.    
Warning: Once a table definition and the table file have been deleted, all data stored in 
the table will be lost.    You can only recover if you have backed up your database.    Use this
command carefully.
Do not delete a table if it or any of its fields are referenced in a form, list, or report, or if it is
referenced in a link defined in another table.    If you do delete the table, all references to it 
must be removed from these objects.    Ad Hoc does not check this for you.



Rebuild Table File Command    (Tables Menu)
Use the Rebuild Table File Command to rebuild the currently selected table in the Tables 
Window.    The command is available only when the Tables Window is displayed and no 
other desktop objects are open.
It is only necessary to rebuild a table file when the Table Window indicates that there is 
something wrong with the table, either there is no file, or the file is damaged and cannot be
read normally.    To rebuild a table, select it in the Tables Window list and select the Rebuild 
Table File Command.    Ad Hoc will ask you to confirm that you want to rebuild the table.
When the rebuilding begins, a process window is displayed on the desktop, showing the 
progress of the rebuild.    You can cancel the rebuild by clicking Cancel on this window.    
When the rebuild is completed, click OK to close the progress window and complete the 
process.
While a table is being rebuilt, you cannot open other desktop objects or exit Ad Hoc.    You 
can rebuild several tables at once.
The rebuilding process creates a new temporary file and copies records from the old file 
into the new file, building the file indexes as the records are added.    If the process 
completes successfully, the old file is deleted, otherwise the new file is deleted and the old 
file remains the same.    
Note:    If some of the records in the old file could not be written to the new, Ad Hoc will tell
you and ask if you want to accept the rebuild anyway.    If you do, the unwritten records will 
be lost.    Accept a partial rebuild only after trying to rebuild the file at least twice and only if
you have no backup of the table.    Use this as a last resort.



Empty Table File Command    (Tables Menu)
Use the Empty Table File Command to delete all the records from a table, or to create a new
table file if one currently does not exist.    This command is available when the Tables 
Window is displayed.    It erases the table that is currently selected in the Tables Window 
list.    Ad Hoc will ask you to confirm the command before it erases the table.
Warning:    This command will erase all the data that was stored in the selected table.    
The only way to recover the data is to restore it from a backup.



Edit Database Information Command    (Tables Menu)
Use the Edit Database Information Command to edit attributes of the database.    Currently 
this is only the long description of the database.    You cannot change the ID of the database
that was assigned when the database was created.    This command displays the Edit 
Database Information dialog.



Run Database Diagnostics Command (Tables Menu)
Select the Run Database Diagnostics Command when the Tables Window is displayed to run
a diagnostics test on the design integrity of the database.    See Diagnostics for details.



Run Table Diagnostics Command (Tables Menu)
Select the Run Table Diagnostics Command when the Tables Window is displayed to run a 
diagnostics test on the design integrity of the table that is selected in the Tables Window.    
See Diagnostics for details.



Elements Command    (Report Menu)
Use the Elements Command to work with the elements that have been defined for a report. 
The Elements Command displays the Report Elements Dialog.    From this dialog you can 
edit an element design, add new elements, or delete elements.    



Regions Command    (Report Menu)
Use the Regions Command to work with the regions that have been defined for a report.    
The Regions Command displays the    Report Regions Dialog.    From this dialog you can edit 
a region design, add new regions, or delete regions.



Layout Command    (Report Menu)
Use the Layout Command to change the attributes of a report, including its description, 
page layout, font,    and other general report characteristics.    The Layout Command 
displays the Report Layout Dialog.    The Layout Command is not only found on the Report 
Menu, but also on the popup menu that is displayed when you click the right mouse button 
on the report ruler.



Edit Startup Dialog Command    (Report Menu)
Use the Edit Startup Dialog Command to design the dialog that is displayed when you print 
a report.    The startup dialog of a report enables the user to set values that will determine 
how a report is printed.    This command is available if you have checked the "Startup 
Dialog" option on the Report Layout Dialog.    This command displays the startup dialog in 
an edit mode, enabling you to design controls on the dialog.    See Designing a Report 
Startup Dialog.
To hide the startup dialog when you are finished with it, select Close on its system menu, or
just double-click its system menu icon.
When the report is printed, the startup dialog will be displayed as you designed it, with the 
addition of an "OK" and a "Cancel" button at the bottom.



Data View Command    (Report Menu)
Use the Data View Command on the Report Menu to define the database view associated 
with the report.    This command displays the Edit View Dialog.    The report view determines
the information that is extracted from the database to appear on the report.    The order of 
the records in the view determines the order of the report.
The fields of the view become available as database fields on the report.    The fields that 
the view (and therefore the report) is sorted on are available to use as report breaks.    
When you use the Data View Command to change the view fields or sort order, you may 
change any previous definitions of the report breaks.    If you remove a field from the view 
that has been used in the report, Ad Hoc will not display an error, but when the report is 
printed, "???" will appear on the report in the positions of any fields that are no longer 
defined in the view.



Report Breaks Command    (Report Menu)
Use the Report Breaks Command to define the break levels of a report.    This command 
displays the Report Breaks Dialog, which enables you to define the break levels of the 
report.    
You can define break levels only after you have defined the report view using the Data View
Command.    If you change the fields in the view, or the sort specification of the view, you 
should select the Report Breaks Command to see if the breaks you have defined are still 
valid.



Total Fields Command    (Report Menu)
Use the Total Fields Command to work with the total fields of a report.    This command 
displays the Total Fields Dialog, which enables you to define or delete total fields for the 
report.    Total fields can be placed on the report layout using the Insert Field Command.



Computed Fields Command    (Report Menu)
Use the Computed Fields Command to work with the computed fields of a report.    This 
command displays the Computed Fields Dialog, which enables you to define or delete 
computed fields for the report.    Computed fields can be placed on the report layout using 
the Insert Field Command.



Insert Field Command    (Report Menu)
Use the Insert Field Command to insert a defined report field into the report layout at a 
designated location.    This command displays the Report Fields Dialog.    This dialog lists the
fields that have been defined for the report.    When you select a field from this dialog, it is 
inserted into the report layout at the cursor position.
The Insert Field Command also appears on the popup menu that is displayed when you 
click the right mouse button when the mouse cursor is over the edit region of the report 
edit window.    You can also insert a field by pressing the INS key.

To insert a field in a report layout

1. Move the edit cursor on the report layout to the spot you want to insert the field
2. Select the Insert Field Command (or press Ins) to display the Report Fields Dialog
3. Select the desired field from the Report Fields Dialog by double-clicking it, or highlighting

it and clicking OK or pressing ENTER.

To delete a field in a report layout
If the cursor is to the immediate left of the field, press the DEL key, or
If the cursor is to the immediate right of the key, press the backspace key, or
Select the field and press the DEL key

The types of report fields that can be inserted using the Insert Field Command are:
Field Type Description

Standard Fields Built-in report fields that include Page, 
Date, and Time.

Database Fields Database fields are defined in the report
view (See Data View Command).    The 
report field name is an "@" sign 
followed by the field ID of the field.    (if 
the field is from a linked table, the link 
prefix is not used).    If two fields in the 
view have the same base ID, a "1" is 
appended to the name of the second 
field.

Total Fields Total fields are defined with the Total 
Fields Command.    Total fields appear 
with the name (ID) you entered when 
you defined the field.

Computed Fields Computed fields are defined with the 
Computed Fields Command.    Computed
fields appear with the name (ID) you 
entered when you defined the field.

Print Command    (Report Menu)
Use the Print Command on the Report Menu to test the report you are designing.    This 
command prints the report as it is currently appears in the report edit window.    However, if
you have designed a startup dialog for the report, it is not available to the report until you 
save the report in the Reports Table with the Save Command on the File Menu.    It is a good
practice to save changes you made to the report design before you test it with the Print 



Command.



Run Diagnostics Command
This command appears on several menus associated with forms, lists, and reports.    Select 
this command to runs a diagnostics test on the form, list, or report.    See Diagnostics for 
details.



Import Command (Form Menu)
Use the Import Command to import data from an external file into a Ad Hoc database.    
Data is imported through a form for which a data exchange template has been defined.    
The Import Command displays the Data Import Dialog, which enables you to control the 
import process.

See Also
Data Exchange Template Dialog
Importing Data



Export Command    (Form Menu)
Use the Export Command to export data from a Ad Hoc database to an external file.    Data 
is exported through a form for which a data exchange template has been defined.    The 
Export Command displays the Data Export Dialog, which enables you to control the export 
process.

See Also
Data Exchange Template Dialog
Exporting Data



Design Mode Command    (Form Menu and List Menu)
Use the Design Mode Command to put a form or list in design mode.    This command 
appears on the Form Menu and on the List Menu.
When a form or list is in design mode, you can make changes to its design by using 
commands on the Form Design Menu or List Design Menu, respectively.



Form Attributes Dialog
Use the Form Attributes Dialog to design the basic attributes of a form.    This dialog is 
displayed by selecting the Form Attributes Command from the Form Design Menu when a 
form is in design mode.

Dialog Options

ID
The form ID is the unique identifier of the form when it is stored in the database Forms 
Table.    Enter a name    from 1 to 8 letters (A-Z) or digits (0-9).    The ID must begin with a 
letter.    You must specify a unique identifier for a form before the form can be stored in the 
database.    Pop-up edit forms that are part of a list do not need identifiers, since they are 
saved with the list.

Description
The form Description is a descriptive name for the form that can be up to 32 characters 
long.    The description is the name of the form that the user sees the most, such as in the 
Open dialog, so enter a description that will make it easy for the user to identify the form.

Database Access Permissions

Check this optionTo

Add New Records Allow the user of the form to add new records to the database 
through the form.    If this option is checked, the form must also 
contain all the required fields of the root table of the form view.

Edit Records Allow the user to edit records with the form.
Delete Records Allow the user to delete records with the form.

Search Window
Check this option if you want the form to have a search window.    A search window is a 
pop-up list that enables you to quickly browse through the records in the form view or to 
search for a specific record in the view.    If you add a search window, the search icon on the
form's control pad will appear.    Clicking on this icon when the form is in design mode will 
display the search window so that you can design it.    You design a search window the 
same way you design a standalone list. (See Designing Lists).

Data Exchange Template
Check this option if you want to add a data exchange template to the form.    When this 
option is checked, you can click the DX Template button on this dialog, or select the Data 
Exchange Template Command on the Form Design Menu to design the template.    (See 
Designing Data Exchange Templates).

View Button
Click on this button to display the Edit View Dialog, which enables you to define the data 
view associated with the form.

DX Template Button
Click on this button to display the DX Template Dialog, which enables you to define the 
data exchange template associated with the form.



List Attributes Dialog
Use the List Attributes Dialog to define the attributes of a desktop list object.

Dialog Options

ID
The list ID is the unique identifier of the list when it is stored in the database Forms Table.    
Enter a name    from 1 to 8 letters (A-Z) or digits (0-9).    The ID must begin with a letter.    
You must specify a unique identifier for a list before you can save it in the database.        
Special lists that are part of a form, such as search windows and lists embedded in scroll 
regions, do not need identifiers, since they are saved as part of form.

Description
The list Description is descriptive name for the list that can be up to 32 characters long.    
The description is the name of the list that the user sees the most, such as in the Open 
dialog, so enter a description that will make it easy for the user to identify the list.

Style
You can specify the following style options for a list by checking the appropriate style 
button:

Style Option Description

Column Headings The list will display a non-scrolling column heading line above the 
scrolling area.    You edit the column headings in the Column Heading 
control on this dialog.

Search Control The list will contain a search control, which enables the user to enter 
search keys to find a record in the list.

Sort Control The list will contain a sort control, which enables the user to change the 
sort order of the list.

No Buttons The list will contain no control buttons.
OkCancel The list will contain two control buttons: OK and Cancel.    This style is 

for lists that are search windows of a form.
AddEditDelete The list will contain three control buttons: Add, Edit, and Delete.    This 

style enables the list to be used for adding, editing, and deleting 
records.    It also attaches a pop-up edit form to the list, which you must 
design.

Database Access Permissions
You can set database access permissions to a list that has the AddEditDelete style.    
Records and added and edited through the pop-up edit form attached to the list.

Check this option To

Add New Records Allow the user of the list to add new records to the database 
through the list.    If this option is checked, the pop-up edit form 
must also contain all the required fields of the root table of the form
view.

Edit Records Allow the user to edit records displayed on the list.
Delete Records Allow the user to delete records displayed on the list.



Column Heading
You can add non-scrolling column headings to a list if the Column Heading style option is 
set.    The columns of a list correspond to the database fields that you have selected to be 
displayed in the list.    The default heading for a column is the description of the field stored 
in the data dictionary as part of the field definition.
To edit a column heading, highlight the corresponding field name in the Displayed Fields list
box, then click on the Column Heading edit box (or press Shift-Tab) to move to this box.    
Edit the column heading.    Column heading can be more than one line; to start a new line, 
press the ENTER key and type the new line.

Displayed Fields
Use this section of the List Attributes Dialog to select the database fields that will be 
displayed in the list.    The list displays an entry for each record in the view, and the fields 
are arranged in columns.    The Displayed Fields section contains two list boxes.    The list 
box on the right (the View Fields list) contains    the fields that have been defined in the 
data view for the list.    Not all the fields in the view need to be part of the list display.    
Some of them may only appear on the optional pop-edit form.      The list box on the left    
(the Displayed Fields list) displays the fields that you select to be displayed in the list.    
The displayed fields are listed in the order they will appear on the list, from left to right.    
Use the buttons between the two list boxes to add or remove fields from the display list:

Click or Press To

Add Alt-A Add the field selected in the View Fields list to the end of the 
Displayed Fields list.

Insert Alt-I Insert the field selected in the View Fields list before the field 
selected in the Displayed Fields list.

Delete Alt-D Remove the field selected in the Displayed Fields list from the list.

Shortcut:
You can also double-click on a field in the View Fields List to add it to the end of the 
Displayed Fields list; and double-click on a field in the Displayed Fields list to remove it 
from the list.

View Button
Click on this button to display the Edit View Dialog, with which you can edit the definition of
the data view associated with the list.    Since only fields that are included in the data view 
can be assigned to columns in the list, you must define the fields in the data view before 
you can select the fields that will be displayed on the list.



Edit View Dialog
Use the Edit View dialog to define a data view.    You will use this dialog to define the data 
view associated with a number of objects in Ad Hoc, including forms, lists, and reports.    
The definition of a data view includes the root table of the view, the fields of the view, an 
optional sort specification, and an optional selection filter.

Dialog Options

Root Table
You must specify a root table for a data view.    The Root Table combo box contains a list of 
all the tables defined in the database.    You must select a root table from this list before you
can design the other characteristics of the view.    If you subsequently change the root 
table, the field list, which is based on the root table, must be redefined.

Fields
Use the Fields section of the Edit View Dialog to designate the fields of the view.    This 
section contains two list boxes and a number of buttons.    The list box on the left (the View
Fields list) contains the extended IDs of the fields selected for the view.    This list box on 
the right (the Available Fields list) contains the fields that are available to be included in 
the view.    Available fields include all the fields in the root table, and all the fields in each 
table that is related to the root table by a defined link.    Initially, the Available Fields list 
contains the fields of the root table, and also contains the root table links to other tables.
Fields are displayed in these lists in alphabetical order by extended ID.

Click or Press To

Add Alt-A Add the field selected in the Available Fields list to the View Fields 
list.

Delete Alt-D Remove the field selected in the View Fields list from the list.
All Alt-L Add all the fields in the Available Fields list to the View Fields list.    

If some of these fields are already in the View Fields list, they will 
not be duplicated.

Req Alt-R To add all the required fields in the Available Fields list to the View 
Fields list.    This button is helpful if you are designing a view that 
will be used to add new records to the root table, which requires 
the view to contain all the required fields of the table.

More Alt-M To change the Available Fields list to contain the fields of a table 
that is linked to the currently displayed table.    You can select More
whenever a link ID is highlighted in the Available Fields list.

Back Alt-B To change the Available Fields list back to the previous table 
through a link.    When the Available Fields list displays the fields of
the root table, you cannot use the Back command.

Shortcut:
You can double-click on a field ID in the Available Fields list to add it to the View Fields 
list.    Double-clicking on a link ID in this list is the same as clicking the More button.    You 
can double-click on a field ID in the View Fields list to remove it from the list.

Sort
The Sort section of the Edit View dialog displays the sort specification you have defined for 
the view.    Click the Sort button, or press Alt-S, to display the Sort Specification Dialog, 



which enables you to define the way the view records are sorted.

Filter
The Filter section of the Edit View dialog displays the filter rules (selection criteria) you 
have defined for the view.    Click the Filter button, or press Alt-F, to display the Filter Rules 
Dialog, which enables you to define the filter.
If you do not define a filter for a data view, the records of the view will correspond on a 
one-to-one basis with the records in the root table of the view.



Sort Specification Dialog
Use the Sort Specification Dialog to define the sort order of a data view.    The sort order is 
defined by designating a list of fields in the view whose values will be used to sort the view 
records.    The order of the fields in the sort specification is important.    The first field in the 
list is the primary sort key, the second field is used next, and so on.
The Sort Specification Dialog contains two list boxes and a number of control buttons.    The 
list box on the left (the Sort Field list) displays the fields used for the sort.    The list box 
on the right (the View Fields list) displays the fields that have been defined for the view 
that can be used to sort records.    You can sort using character, numeric, or date fields.

Click or Press To

Add Alt-A Add the field selected in the View Fields list to the end of the 
Sort Fields list.

Insert Alt-I Insert the field selected in the View Fields list before the field 
selected in the Sort Fields list.

+/- Alt-+ Change the sort direction of the field selected in the Sort Fields 
list to either ascending (sorted from low to high values) or 
descending (sorted from high to low values).
A descending sort field will be displayed with a "-" sign after it.

Delete Alt-D Remove the field selected in the Sort Fields list from the list.
Clear Alt-C Remove all the fields from the Sort Fields list.

Shortcut:
You can double-click on a field in the View Fields list to add it to the bottom of the Sort 
Fields list.    You can double-click on a field in the Sort Fields list to remove it from the list.



Filter Rules Dialog
Use the Filter Rules Dialog to define a selection filter for a data view.    The Filter Rules 
dialog contains a list of the rules you have defined.    Below this list are several buttons you 
can use to add or edit the rules in the list.

Click or Press To

Add Alt-A Add a rule.    After an add, the Add button becomes the default 
push-button, so that pressing ENTER causes another rule to be 
added.    Add displays the    Edit Filter Rule Dialog.

Insert Alt-I Insert a new rule before the rule that is highlighted in the list.    
After an insert, the Insert button becomes the default push-button, 
so that pressing ENTER causes another rule to be inserted.    Insert 
displays the Edit Filter Rule Dialog.

Edit Alt-E Change the rule that is highlighted in the list.    After an edit, the 
Edit button becomes the default push-button, so that pressing 
ENTER after highlighting another rule causes that rule to be edited.

Delete Alt-D Remove the highlighted rule from the list.
Clear Alt-C Remove all the rules from the list.

Shortcut:
Double-clicking on a rule in the list will display the Edit Filter Rule Dialog so that you can 
edit the rule.



Edit Filter Rule Dialog
Use the Edit Filter Rule Dialog to edit the definition of a filter rule.

Dialog Options

Database Field
This combo box will contain a list of the fields defined for the view.    Select the field whose 
value will be used for this filter rule.

Comparison
Select the comparison operation to be performed on the value of the field.    The value of 
the field is compared to the value you enter in the Value edit box, or the value of the field 
that you specify in the Value edit box.    The comparisons are:

Code Description The rule is TRUE for a field if

EQ equal to the value of the field is equal to the comparison value
GT greater than the value of the field is greater than the comparison value
LT less than the value of the field is less than the comparison value
NE not equal to the value of the field is not equal to the comparison value
GE greater than or equal to the value of the field is greater than or equal to the 

comparison value
LE less than or equal to the value of the field is less than or equal to the comparison 

value
CO contains the field is of type Character and it contains the character 

string in the comparison value
NN not null the field is not null, it contains a value (which may be zero 

for numerical fields)
NU null the field is null (blank), it contains no value

Value
If the Value option is selected, the field is compared to the value that you enter in the Value
edit box.

Field
If the Field option is selected, the edit box becomes a combo box with a list of possible 
fields that can be used for the comparison value.    The value of the rule field is compared 
to the value of the field you specify in the combo box.    This option will not always be 
available.    You will see it when you define a filter for a report data view.    This allows you to
filter the records for the report by comparing fields in the records with report fields.

Comparison Options

Option Meaning

case sensitive This option is available if the view field for the rule is of type 
Character.    If you select this option, the comparison will take the case
of the letters into account.    If the rule is not selected, the case of the 
letters will be ignored.
For case sensitive comparisons, "The" is not equal to "the".    Upper 



case letters (A-Z) come before lower case letter (a-z) in the sort order. 
Therefore "Zoo" would come before (be less than) "airplane".
For most applications, do not select this option.

month and day only This option is available if the view field for the rule is of type 
Date.    If you select this option, the comparison is made only for the 
month and day part of the date. 

ignore if null This option is available if you are comparing the view field to another 
field.    If this option is set, the rule is ignored (i.e. it is automatically 
TRUE) if the comparison field is null.

Connector to following rule
The option you select here determines how the filter rules are combined to determine 
whether a record passes or fails the filter.    The connections between rules are evaluated 
sequentially.    The combination of the first two rules is evaluated, and the result is 
combined with the next, etc.    If the result of list of rules is TRUE, then the record passes 
the filter.    If it is FALSE, the record does not pass (and is not considered part of the view).
Here is how the evaluation is done for two rules:

If Rule A is and Rule B is Then

TRUE TRUE A and B is TRUE
A or B is TRUE

TRUE FALSE A and B is FALSE
A or B is TRUE

FALSE TRUE A and B is FALSE
A or B is TRUE

FALSE FALSE A and B is FALSE
A or B is FALSE

Some combination examples:
TRUE and TRUE or FALSE is evaluated as TRUE
TRUE and FALSE and FALSE is evaluated as FALSE
TRUE or FALSE and TRUE is evaluated as TRUE
TRUE or FALSE and FALSE is evaluated as FALSE

Displaying Filter Rules
When a filter rule is displayed, for example in the Filter Rules Dialog list on the Edit View 
dialog, it appears as:

FIELDID equals "value" for fields compared with a set value
FIELDID equals FIELDID for fields compared with other fields

If you have set one or more comparison options, they will follow the rule in parentheses:
(m/d) month and day comparison
(cc) case sensitive
(i) ignore if null



Form Links Dialog
Use the Form Links Dialog to define a link between two forms.    When two forms are linked, 
one is the master form and one is the dependent form.    The current record in the master 
form determines the records that are filtered in the view of the dependent form.
This dialog is displayed when a form or list is the active desktop object and you select the 
Form Links command on the File Menu.    The active form or list is the master form, and the 
Form Links dialog will display all the dependent forms that are linked to it, as well as other 
forms on the desktop that you may link to it.    The Form Links dialog enables you to 
redefine existing links, add new linked forms, or delete existing links.

Linked Forms
The Linked Forms list shows the dependent forms and lists that are linked to the master 
form.    If the master form contains an imbedded list (scroll region) that is linked to it, the 
designation "(imbedded)" follows the linked form's name.    You cannot change the link 
definition or remove the link of an imbedded form link, but you can view the definition.

Open Forms
The Open Forms list shows the forms that are open on the desktop and available to be 
linked to the master form.    A form that is already linked as a dependent of another form is 
not available for linking.    A form can be a master to many dependent forms, but can have 
only one master.    You also cannot link a form to another instance of the same form.

To Link a form or list to the active form

1. Select the form or list in the Open Forms list
2. Click on Link, press Alt-L, or double-click the entry in the Open Forms list
3. Describe the link in the Edit Link Dialog
4. The linked form will be added to the Linked Forms list

To Remove a link

1. Highlight the linked form in the Linked Forms list
2. Click on Unlink, press Alt-U, or double-click the entry in the Linked Forms list
3. The form is removed from the Linked Forms list and returned to the Open Forms list

To change the way two forms are linked

1. Highlight the linked form in the Linked Forms list
2. Click on Edit Link, or press Alt-E
3. Edit the link description on the Edit Link Dialog
If the link is to an imbedded form or list, you cannot change the link definition, but you may
view it.



Edit Link Dialog
Use the Edit Link Dialog to define the link between two forms.    You will see this dialog 
when you link two desktop objects with the Form Links command on the File Menu, and also
when you define the link between a form and an embedded list designed on the form.
The Edit Link Dialog contains two lists of fields.

On the left is a list of the fields in the data view of the dependent form to be linked.
On the right is a list of the fields in the data view of the master form.

To define a link, you will select one or more fields in the dependent form view that will be 
filtered by the value of a corresponding field in the master view.    A record in the dependent
view is selected (passes the filter) only if all the fields defined in the link have the same 
value as the fields designated in the master form view.

To define a pair of linked fields

1. Select a field from the dependent form's view in the list on the left
2. If there is one or more equivalent field in the master form's view, these fields will be 

displayed in the list on the right
3. Select the field in the master form's view on the right that the dependent field must 

match
4. The match will be displayed in the box at the bottom of the Edit Link Dialog

To remove a pair of linked fields

1. Select the field from the dependent form view in the list on the left
2. Select "none" in the list on the right

To remove all field matches (clearing the link definition)

1. Click on Clear, or press Alt-C
You can enter as many field matches as you want to define the link between the forms.    As
soon as you accept the definition of the link, by clicking the OK button, or pressing ENTER, 
the dependent form is linked to the master form.
Note: Depending on the number of records in the dependent form and the how heavily the 
link filters the dependent form, you may experience a delay after the link is defined as Ad 
Hoc reads through the dependent view to find records that match the link.    You may also 
experience a delay when you change records in the master form.



Fonts Dialog
Use the Fonts Dialog to define the fonts used for a form or list.    This dialog is displayed by 
the Fonts Command on the Form Design Menu and on the List Design Menu.

Dialog Options

Display Objects
This is a list of the items for which you can designate a font.    Select an item in this list, and
define the characteristics of its font on the right side of the Fonts Dialog.

Type Face
Enter the name of the type face for the font.

Point Size
Enter the size of the font in points (a point, the unit of measure used for the height of the 
font, is 1/72 inch).

Bold
Check this option for a bold font.

Italic
Check this option for an italic font.

Fonts Button
Instead of entering the font characteristics into the above dialog controls, you can click the 
Fonts button to display    a Font selection dialog that is supplied in Windows.    The Windows 
Font selection dialog displays a list of all the fonts installed on your computer.    From this 
dialog you can select a font, a point size, and the other available font styles such as bold 
and italic.
Note: If you are designing a form or list that will be used on another machine or across a 
network, make sure that you select fonts that are available on other machines.



Colors Dialog
Use the Colors Dialog to change the colors of a form or list.    This dialog is displayed by the 
Colors Command on the Form Design Menu and on the List Design Menu.    The dialog 
contains a color combo box for each display object on the form or list for which you can set 
the color. 
The default color of an object is the color that is supplied by Windows based on color 
selections that the user makes with the Windows Control Panel.    To override the default, 
select a specific color.    The default color is displayed in the combo box as it is defined by 
the Control Panel.
Warning:    Make sure you choose different colors for the text and background of an object,
or the text will not appear.    Experiment until you find a pleasing color combination.
Hint:    When you are designing a form, it helps to make the form background color and the
data background color different.    This will help you locate and size controls on the form.    A
control with no border style and with no data displayed will be invisible on the form unless 
it is selected, or unless it is a different color than the form.



Edit Control Attributes Dialog
Use the Edit Control Attributes    Dialog to define the attributes of an edit control on a form.  
This dialog is displayed when a form is in design mode and you:

Select the New Edit Command on the Form Design Menu
Click the right mouse button when the cursor is over an existing edit control on the 

form.
Select the Control Attributes Command from the Form Design Menu when an edit 

control is selected (highlighted).

Dialog Options

Field
The Field combo box contains a list of the fields defined in the data view associated with 
the form.    Select the field that will be displayed (and optionally edited) in the edit control 
you are defining.

Title
Enter the title, if any, to be attached to the edit control.    Ad Hoc will supply the description 
of the field from the data dictionary as a suggested title, but you can change the title if you
wish.

Title Position
Select the position of the title on the form relative to the position of the edit control .

Position Description

None No title will be displayed
Left The title will appear to the left of the edit control
Right The title will appear to the right of the edit control
Above The title will appear above the edit control, aligned with the left edge of the 

control
Below The title will appear below the edit control, aligned with the left edge of the 

control

Style
Select the display style of the edit control:

Style Description

None The edit control will display its contents only.    It will have no border or 
underline.

Underline The edit control will appear with a line under the contents.    This will make it 
appear as an entry on a paper form.

Border the edit control will have a single line border around the data area.
An edit control with no title and no display style (and no displayed contents) will be hard to 
locate on the form when you are laying the form out.    To more easily lay out the form, it is 
suggested that you change the colors so that the form background and data background 
colors are different during the design process.    You can change them back later, if desired.

Display Only
Check the Display Only option if you want the edit control to display the field data, but not 



allow the user to edit the data.    A display-only control cannot be edited, and cannot be 
tabbed to (although when you are setting the tab order of the form, you should include it).   
If you have defined the field displayed in the edit control as a field from a table other than 
the root table of the form view, the Display Only attribute will automatically be set.    You 
can edit only fields from the root table of the view.

Don't validate using table links
Normally, if a field in a form view is part of a link to another table, Ad Hoc will use the link 
to validate the value you enter into the field.    It also uses the link to display a lookup 
window to allow you to select a value from a list.
If you check this option, Ad Hoc will not validate your entries in this control against the 
lookup table, allowing you to enter values that don't appear in the lookup table.    You can 
still use the lookup table to select values, however.



Combo Box Attributes Dialog
Use the Combo Box Attributes Dialog to define the attributes of a combo box control on a 
form.    This dialog is displayed when a form is in design mode and you:

Select the New Combo Box Command on the Form Design Menu.
Click the right mouse button when the cursor is over an existing combo box control 

on the form.
Select the Control Attributes Command from the Form Design Menu when a combo 

box control is selected (highlighted).
A combo box can be used to edit a field that has been assigned the Lookup validation style 
(See Define Field Dialog).    The valid lookup values you define for the field appear in the 
drop down list of the combo box.    A combo box cannot be display only.    If you want to only
display a field on a form, use a display-only edit control.

Dialog Options

Field
The Field combo box contains a list of the fields defined in the data view associated with 
the form that have a Lookup validation type.    Select the field that will be edited in the 
combo box control you are defining.

Title
Enter the title, if any, to be attached to the combo box control.    Ad Hoc will supply the 
description of the field from the data dictionary as a suggested title, but you can change 
the title if you wish.

Title Position
Select the position of the title on the form relative to the position of the combo box control .

Position Description

None No title will be displayed
Left The title will appear to the left of the combo box
Right The title will appear to the right of the combo box
Above The title will appear above the combo box, aligned with the left edge of the 

control
Below The title will appear below the combo box, aligned with the left edge of the 

control

Style
Select the display style of the combo box:

Style Description

Select Description The value must be selected from the drop down list.    The list 
displays the long description associated with the field value 
defined in the data dictionary.

Select Code (Description) The value must be 
selected from the drop down list.    The list displays the field 
value, followed by the long description in parentheses.



Text Box Attributes Dialog
Use the Text Box Attributes Dialog to define the attributes of a text box control on a form.    
This dialog is displayed when a form is in design mode and you:

Select the New Text Box Command on the Form Design Menu.
Click the right mouse button when the cursor is over an existing text box control on 

the form.
Select the Control Attributes Command from the Form Design Menu when a text box 

control is selected (highlighted).
A text box control must be used to edit a field of type Text.    A text box is similar to an edit 
control, except that it can display more than one line of text.    If the contents of the Text 
field are too large to display in the text box, scroll bars allow you to scroll through the text.

Dialog Options

Field
The Field combo box contains a list of the fields of type Text defined in the data view 
associated with the form.    Select the field that will be edited in the text box control you are
defining.

Title
Enter the title, if any, to be attached to the text box control.    Ad Hoc will supply the 
description of the field from the data dictionary as a suggested title, but you can change 
the title if you wish.

Title Position
Select the position of the title on the form relative to the position of the text box control .

Position Description

None No title will be displayed
Left The title will appear to the left of the text box
Right The title will appear to the right of the text box
Above The title will appear above the text box, aligned with the left edge of the 

control
Below The title will appear below the text box, aligned with the left edge of the 

control

Style
Select the desired display style options of the text box:

Style Description

Border Check this option to display a border around the text box.
Vertical Scroll Bar Check this option to include a vertical scroll bar on the right side of 

the text box.    If there is no scroll bar, you can still scroll through the 
contents of the text box with the up and down cursor keys.

Display Only Check this option to make the text box display only.    The user cannot 
edit the contents of a display only text box.



Scroll Region Attributes Dialog
Use the Scroll Region Attributes Dialog to define the attributes of a scroll region control on a
form.    This dialog is displayed when a form is in design mode and you:

Select the New Scroll Region Command on the Form Design Menu.
Select the Control Attributes Command from the Form Design Menu when a scroll 

region control is selected (highlighted).
Select the Control Style Command on the List Design Menu of the list that is 

embedded in the scroll region.
A scroll region is a special type of form control that enables an embedded list to be placed 
on a form.    You design the attributes of the scroll region control with this dialog, and design
the attributes of the list using the List Design Menu that is displayed when you click the 
right mouse button when the mouse cursor is over the list.

Dialog Options

Title
Enter the title, if any, to be attached to the scroll region.    There is no default supplied.    
Enter a title that relates to the contents of the list embedded in the control.

Title Position
Select the position of the title on the form relative to the position of the scroll region .

Position Description

None No title will be displayed
Left The title will appear to the left of the scroll region, aligned with the bottom 

edge
Right The title will appear to the right of the scroll region, aligned with the bottom 

edge
Above The title will appear above the scroll region, aligned with the left edge
Below The title will appear below the scroll region, aligned with the left edge



Quick Form Layout Dialog
Use the Quick Form Layout Dialog to have Ad Hoc automatically place edit controls on a 
new form for fields that you have defined in the data view of the form.    This dialog is 
displayed by selecting the Quick Layout Command on the Form Design Menu.    Quick 
Layout can be done only if the form does not yet contain controls.
Place the fields that you want to create edit controls for in the Displayed Fields list on the 
dialog in the order that you want the controls placed on the form.    If you want to use a 
combo box control for a field, don't include it in the list and add the combo box control 
later.    Or you can include it in the list to make a place for it, then later delete the edit 
control and replace it with a combo box control.

Dialog Options

Displayed Fields
The Displayed Fields List on the left side of the dialog contains the fields for which edit 
controls will be created.    This View Fields list on the right contains all the fields in the data 
view associated with the form that can be assigned to an edit control.    It will not contain 
Text fields, or fields of other types that cannot be edited in an edit control.

Click on or Press To

Add Alt-A Add the field selected in the View Fields list to the end of the 
Displayed Fields list.

Insert Alt-I Insert the field selected in the View Fields list before the field 
selected in the Displayed Fields list.

Delete Alt-D Remove the field selected in the Displayed Fields list from the list.
All Alt-L Add all the fields in the View Fields list to the Displayed Fields list.    

Note that they are added in the order they appear in the View 
Fields list, which may not be the order you want them to appear on 
the form.

Shortcut:
You can double-click on a field in the View Fields list to add it to the Displayed Fields list.   
You can double-click on a field in the Displayed Fields list to remove it from the list.

Vertical Separation
Controls will be placed on the form one below the other.    Vertical separation defines the 
distance between the bottom of one control and the top of the next.    A vertical separation 
of 8 is equivalent to the height of a character in the font you have selected for the data on 
the form.    A vertical separation of 4 is the default.

Left Margin
Enter a number for the distance each control will be placed from the left edge of the form.   
A left margin of 4 is equivalent to the average width of character in the font you have 
selected for the data on the form.    A left margin of 4 is the default.

Title Position
This option cannot be changed at this time.    All controls will be created with a Left style 
title position.

Border Style



Select the border style that all controls will have (See Edit Control Attributes Dialog for a 
description of the border style options).



Data Exchange Template Dialog
Use the Data Exchange Template dialog to define the attributes of a data exchange 
template attached to a form.    This dialog is displayed when you select the Data Exchange 
Template Command on the Form Design Menu.    

Dialog Options

Record Format
Select the format of the file that data will be imported from or exported to.

Format Description

Fixed Field ASCII The file is an ASCII text file.    Records in the file are separated 
by a carriage return-line feed combination.    Within each record
the fields are a fixed length defined in the DX Record Layout 
Dialog.

Delimited ASCII The file is an ASCII text file.    Records in the file are separated 
by a carriage return-line feed combination.    Within each record
the fields are separated by a delimiter character.    In the 
current version, this must be a comma.
If a field contains the delimiter character, the entire field must 
be enclosed in double quote characters ("xxx").    On export, Ad
Hoc    always adds the double quotes.

Comma Separated ValuesThe same as Delimited ASCII above, except that the field 
delimiter is always a comma.

Date Format Option
Select the date format used when exporting Date fields, or expected when importing Date 
fields.    See Date Field for a description of the date format options.    All date formats can be
exported.    Some date formats cannot be imported.    If you select one of these, Ad Hoc will 
warn you that it cannot import the date format you selected.
For fixed-field ASCII records, make sure the length of a date field is large enough to 
accommodate the selected format.

Export Upper Case
Check this option if you want fields in exported records to be in all upper case letters.    This
does not affect records that are imported.    The case of records imported into the database 
is controlled by the case specified in the definition of each field in the data dictionary.

Layout Button
A data exchange template must include a field layout, which designates how the characters
in an ASCII record relate to fields in the database.    Click the Layout button to display the 
DX Record Layout Dialog.    For fixed-field ASCII record types, the position and size of the 
fields in the list is important.    For delimited ASCII or comma separated value record types, 
only the order of the fields is important.    The information in the layout must match exactly 
the actual layout of imported records, or the import operation will generate errors.



DX Record Layout Dialog
Use the DX Record Layout dialog to define the record layout of the ASCII records that will be
imported or exported using a data exchange template.    The dialog contains two list boxes. 
The list box on the left (the Layout list) displays the list of fields defined in the layout.    
The list box on the right (the View Fields list) displays the fields of the data view 
associated with the data exchange template.    (The view for the template is the same as 
the data view associated with the form that the template is being defined for.)

Click on or Press To

Add Alt-A Add the field selected in the View Fields list to the end of the Layout
list

Insert Alt-I Insert the field selected in the View Fields list before the field 
selected in the Layout list

Edit Alt-E Edit the length of the field selected in the Layout list
Delete Alt-D Delete the field selected in the Layout list 

When you add a field to the Layout list, it is added with a length equal to the edit length 
that you specified when you defined the field in the data dictionary.    You can change this 
length by using the Edit button or double-clicking on the field entry in the Layout list.    The 
field length applies only if you are exporting to or imported from a file in a fixed-field 
format.

Warning
If you are exporting data, and the field in the database is longer than the field length 
defined in the record layout, the field contents are truncated.    If the field in the database is
shorter, the field in the export file is padded on the right with blanks.
If you are importing data, and the field in the database is shorter than the field length 
defined in the record layout, the field contents are truncated.

Sample Record
At times, you have an existing file of data that you want to import, but may not be sure of 
the layout of the file.    The Sample Record area of the DX Record Layout Dialog provides 
support to determine if your layout matches the data in a sample record of the file to be 
imported.
Note: Use the Sample Record area of the dialog only for files that have a fixed-field format.
To look at a sample record of a file to be imported, enter the pathname of the file (directory
and file name) in the File Pathname edit box.    Then click the Sample button.
A sample of the first record in the file will appear in the record display area.    When you 
select a field in the Layout list, the corresponding region of the sample record will be 
highlighted.    Check each field to see if your layout makes sense.    The end of the record is 
marked by a vertical line, which should not be highlighted when you select the last record 
in your layout.



Data Import Dialog
Use the Data Import Dialog to start a data import process.    This dialog is displayed when 
you select the Import command on the Form Menu.

Dialog Options

Input File Pathname
Enter the full pathname (directory and file name) of the file that contains data that you 
want to import.

Delete After Reading
Check this option if you want the file deleted after the data is imported.    If you select this 
option, make sure that you have selected a suspense file option, so that records with errors
will be saved to a suspense file so that you can correct them and read them later.

Record Edit Options
The record edit option determines when records read from the input file are displayed on 
the form for you to review and edit before they are imported into the database.

Option selected Action taken

None No records are displayed on the form, the import proceeds 
uninterrupted.    If records contain errors, they are put into a suspense 
file without notifying the user.

Errors Only Records with errors are displayed on the form, and the import waits 
until the user edits the record and either inserts it into the database or
into the suspense file.

All All records are displayed on the form, and the user must approve each
record before it is inserted into the database.

Suspense File
If you want records that contain errors to be stored in a suspense file instead of discarded, 
supply a valid pathname for the suspense file.    You can later edit the records in this file 
and insert them into the database.

Option Description

None Records with errors are not put into a suspense file, they are discarded.
Append Records are appended to the end of the suspense file.
Overwrite If the suspense file that you enter contains information, it is replaced by 

the new records added to the suspense file.



Data Export Dialog
Use the Data Export Dialog to start a data export process.    This dialog is displayed when 
you select the Export command on the Form Menu.

Dialog Options

Output File Pathname
Enter a valid file pathname (directory and file name) for a file that will receive the records 
exported from the database.
If the file you specify exists, one of these options is used:

Export Option Description

Append The exported records are appended to the contents of the file.
Overwrite The contents of the file are replaced by the exported records.

Records are exported using the sort and filter options defined for the data view of the form. 
If no sort specification is supplied in the view definition, records are exported using the 
current index of the view.    The current index is the one specified in the Search Window of 
the form, if one is defined, otherwise it is the primary key order.



Database Table Dialog
Use the Database Table Dialog to define a database table.    The table definition is stored in 
the data dictionary of the database.    This dialog is displayed when you select the New 
Table Command or the Edit Table Definition Command on the Tables Menu.
Using this dialog, you can define a database table, along with its fields, indexes, and links 
to other tables.

Dialog Options

Table ID
Enter a unique identifier for the table in the database.    A Table ID can be a combination of 
1 to 8 letters (A-Z) or digits (0-9) that begins with a letter.    The Table ID should convey 
some meaning to the user of what the table contains, if possible.    For a new table you can 
enter and change the ID.    Once a table definition has been entered into the data 
dictionary, you cannot change the ID.

Description
Enter a long description of the table.    The description can be up to 32 letters or digits.    
Use a description that makes it easy for the user to identify the table.    The description can 
be changed later if necessary.

Type
Select the type of file that will be used to store the table.    The options are:

File Type Description

Btrieve The table is stored as a Btrieve file.

File Name
Enter the file name for the table file.    Ad Hoc will suggest a default file name, comprised of
the Table ID with the extension .DBF.    You can change this default to any valid file name for
a new table.    For an existing table (for which the file has already been created), if you 
change the file name in the table definition, Ad Hoc will not change the actual file name.    
Instead, it will not be able to find a file for the table, unless the new name is the name of an
already existing file.

Path
If you want the table file to be created in the same directory as the data dictionary and 
database system files, leave this entry blank.    If you want the table file to be in another 
directory, or on another disk, enter the pathname (directory and optionally drive) here.

Fields Button
Click the Fields Button to see a list of the fields defined for the table.

Indexes Button
Click the Indexes Button to see a list of the indexes defined for the table.

Links Button
Click the Links Button to see a list of the links to other tables defined for this table.

To work with items in the list

Click on or Press To



Add Alt-A Add an item (field, index, or link) at the end of the list.
Insert Alt-I Insert an item before the item that is selected in the list.
Change Alt-C To change the definition of the selected item in the list.
Delete Alt-D To delete the selected item in the list.

Hint
You can double-click on an item in the list to display the dialog for that item.

See Also
Define Field Dialog
Define Index Dialog
Define Link Dialog



Define Field Dialog
Use the Define Field Dialog to define a field in a database table.

 Dialog Options

ID
Enter a unique identifier for this field.    No two fields in the same table can have the same 
ID.    Fields in different tables can have the same ID, but you should avoid this for sake of 
clarity.    The ID can be any combination of from one to eight letters (A-Z) and digits(0-9), 
but must start with a letter.

Title
Enter a title for the field of from one to 32 letters or digits.    The title is a descriptive phrase
that will be used as a default title for the field on forms and lists.

Required
Check this option if want to require that a field must contain a value (cannot be null, or 
blank).    When the user enters data on a form, Ad Hoc will require that an entry be made 
for the field if the required options is checked.    By definition, the fields that comprise the 
primary key of a table are required fields.

Data Type
Select the data type of the field.

Edit Length
Select the number of characters the user is allowed to enter when entering a value for the 
field.      For Character fields, this is also the size of the field.    For numeric fields it 
determines the number of digits a user can enter, but does not affect the size of the field 
(see Data Types for field sizes).

Decimal Positions
Select the number of decimal positions a Numeric field will have when formatted for output.

Max Size
Enter the maximum size in characters that a Text field can expand to.    If you leave this 
entry zero, the maximum size will be default maximum size defined by the table file type.    
For Btrieve table files, this default size is 55,000 characters in a network environment and 
64,000 characters on a local computer.    If a table contains more than one Text field, the 
total maximum lengths of all Text fields cannot exceed these size limits.

Case Control
Select one of the following options:

Case Option Description

None The user can enter letters in either upper or lower case and digits.
Upper All letters entered by the user are shifted to upper case.
Numeric The user can only enter digits and the following punctuation characters: .

/ + -

Validation Type
Select a optional validation type for the field:



Type Description

None The field is not validated using rules stored in the data dictionary
Range The field must be between a range of values (inclusive) stored in the data 

dictionary
Lookup The field value must equal one of the values stored in a lookup table in the 

data dictionary
Set Each character in the field must belong to a set of characters stored in the 

data dictionary.
In addition to the validation rules defined in the data dictionary, other validations tests are 
performed by Ad Hoc when the user enters a value for a field:

If the field is required, the user must enter a value for the field
If the field is part of a foreign key described by a link defined for the table, the value 

a user enters in the field must equal the primary key value of a record in the linked table.    
This is, the linked table defined in the link definition becomes a lookup table for the field 
value.

Edit Button
If a validation type is defined, you can click the Edit button to edit the validation rules.

For Validation Type the Edit Button will display

Range Validation Range Dialog)
Lookup Validation Codes Dialog
Set Validation Set Dialog



Data Types
A database field can be one of the following types

Type Description Size

Character A string of letters or digits that is a 
pre-defined fixed length.

length 
defined by 
user

Short 
Integer

A whole number between -32,767 and
32,767.

2 bytes

Long 
Integer

A whole number between -
2,147,483,647 and 2,147,483,647.

4 bytes

Numeric A floating point number (whole or 
fractional) between 1.7 x 10E-308 
and 1.7 x 10E308, with 15-digit 
precision

8 bytes

Date A date between Jan 1, 0 AD and Dec 
31, 9999 AD

8 bytes

Text Text data (characters or integers) variable

Date Field

Entering dates into edit controls
The following formats are recognized as valid date formats 

mm/dd/yy You must use the "/" separator
The following values may be entered in a date field, and are converted to the appropriate 
date.    Only the first three letters need be entered, the others are ignored

Entry Converted to

today current system date
yesterday day before current system date
tomorrow day after current system date
monday date of the next Monday after current system date
tuesday date of the next Tuesday
wednesday date of the next Wednesday
thursday date of the next Thursday
friday date of the next Friday
saturday date of the next Saturday
sunday date of the next Sunday

Date output formats
Date output formats that can be specified for data exchange output and reports are shown 
below for the date April 16, 1993.    In the current version, the only date format in a report is
the default format.



Format code Date displayed as
Default The default format set for Ad Hoc (4/16/93 in current version)
yymmdd 930416
yyyymmdd 19930416
mmddyy 041693
mmddyyyy 04161993
ddmmyy 160493
ddmmyyyy 16041993
mmm dd, yyyy Apr 16, 1993
mmmm dd, yyyy April 16, 1993
w, mmm dd, yyyyFriday, Apr 16, 1993
dd mmm yyyy 16 Apr 1993



Validation Range Dialog
Use the Validation Range Dialog to define the value range that will be used to validate the 
data entered into a field.
You can use Range validation for Character, Numeric (including integer), and Date data 
types.    You can enter a low value, high value, or both.    If you omit the high range value, 
the field value can be equal to or greater than the low value, and vice versa.



Validation Set Dialog
Use the Validation Set Dialog to define the set of valid characters that are allowed in a field 
of type Character.    The values you enter can be either upper or lower case letters, digits, 
or punctuation.
Set validation if useful if a field is to contain a set of codes, such as days of the week.    In 
this case, the valid set might be MTWRFSU, each letter corresponding to a day of the week. 
A valid field entry would be MWF.    MWA would be invalid.    Ad Hoc does not currently check
for duplicates in the field, so MMWF would also be acceptable.

Case Sensitive
Check the Case Sensitive option if you want upper and lower case letters to be treated as 
separate characters.    If case sensitive is checked and the valid set is MTWRF, then MtWRF 
would not be valid.



Validation Codes Dialog
Use the Validation Codes Dialog for fields with the Lookup validation type.    This dialog 
defines the valid values that can be entered into a field, along with an optional descriptive 
phrase that can be associated with the value.
The Validation Codes Dialog contains a list of valid codes, or values, the field can have, 
followed by an optional description, a longer phrase that describes the code.    For 
example, a field in an employee record called SEX could have the following codes and 
descriptions:

Code Description

F female
M male

The Code is the data in the field, the Description is supplied so that a user can understand 
the codes when entering data into the field.    The Description is optional for validation 
purposes.
To work with the validation codes dialog:

Click on or Press To

Add Alt-A Add a code to the list
Change Alt-C To change the description of a code in the list
Delete Alt-D To delete a code from the list

Shortcut:
Double-click on an entry in the code list to edit it

When you Add or Change a code, Ad Hoc displays the Validation Code Dialog, enabling you 
to enter a code and description.

Code
A code can be any combination of letters (upper case) or digits, from one to sixteen 
characters.      You cannot define duplicate codes for a field.

Description
The code description is optional, and there is no practical limit to its length.



Edit Validation Code Dialog
Use this dialog to define a validation code value and an optional description of the code.

Code
A code can be any combination of letters (upper case) or digits, from one to sixteen 
characters.      You cannot define duplicate codes for a field.

Description
The code description is optional, and there is no practical limit to its length.



Define Index Dialog
Use the Define Index Dialog to define an index for a table.    As indexes are added to the 
table definition, they are assigned a number, starting with 0, in the order you place them in
the index list on the Database Table Dialog.    Index 0 must be the primary key of the table.

Dialog Options

Index Description
Enter a phrase that describe how the index sorts the table.    The description is displayed in 
cases where the user is selecting a sort order for the table.    Use a phrase like "by 
Employee ID" or "Alphabetically".

Index Options

Option Description

Modifiable Fields that make up the segments of the index can be changed by 
the use after a record has been added to the table.    Example: if you 
index the employee table on last name, this allows you to change an 
employee's last name.

Duplicates Allowed Records can have duplicate values for the fields that make up the 
index.    Example: if you index the employee table on last name, this 
allows two or more employees to have the same last name.

Nulls Allowed Blanks (null values) are allowed for the fields that make up this index.
If the fields that make up an index are all blank, the record will not 
appear in the index (it will appear in other indexes).

Note: 
The primary key index cannot have any of these options checked.
If a field belongs to an index that is not modifiable, it cannot be changed after the 

record is added to the table.
If a field belongs to an index that does not allow duplicates, no two records in the 

table can have the same value for this field.

Segments
The Segments list contains the fields that make up the index.    The Fields list to the right of 
the segments list shows the fields defined for the table.    Add segments to the index 
definition from this list:

Click on or Press To

Add Alt-A Add the field highlighted in the Field list to the end of the 
Segments list.

Insert Alt-I Insert the field highlighted in the Field list before the field 
highlighted in the Segments list.

Delete Alt-D Delete the field highlighted in the Segments list.

Shortcut:
You can double-click on a field in the Field list to add it to the Segments list.    You can 
double-click on a field in the Segments list to remove it from the list.

Segment Attributes



When a field is highlighted in the Segments list, you can select attributes for this index 
segment in the Segment Attributes box:

Attribute Description

Ascending The index segment is sorted in ascending order.
Descending The index segment is sorted in descending order.
Case Sensitive The sort order of the segment is case sensitive.    This means that lower

case letters are arranged differently in the sort order than upper case 
letters.    The range (a-z) follows (A-Z), so that Zoo would come before 
albatross.    If the sort order is not case sensitive, upper and lower case 
letters are treated as identical (A and a sort the same).
In most cases, leave this option set off.



Define Link Dialog
Use the Define Link Dialog to define the links a table has to other tables in the database.    
In order to define a link to another table, one or more fields in the table must comprise a 
foreign key to another table.    That means this field (or fields) must be equivalent to the 
field (or fields) that make up the primary key of the other table.    Equivalency means the 
same data type and size.
You should define a link for each foreign key in a table, as links allow you to develop multi-
table forms and reports, and also allow for automatic validation of field values, using the 
linked table as a lookup reference.

Dialog Options

Link ID
Enter a character string identifier of from 1 to 8 characters for the link ID.    No two links in 
the same table definition can have the same ID.    Use an ID that is descriptive of the link, 
as the link ID is used as part of the extended field ID of a field in a data view.

Description
Enter a longer descriptive phrase that describes the link, such as "Link to Department 
Table".

Associated Table
Select the database table that this link is linking to.

Segments in Foreign Key
Add the fields (segments) that make up the foreign key of the associated table.    To the 
right of the Foreign Key Segments list is the Fields list, showing the fields that have been 
defined for the table for which the link is being defined. 

Click on or Press To

Add Alt-A Add the highlighted field in the Field list to the end of the Segments 
list.

Insert Alt-I Insert the highlighted field in the Field list before the highlighted 
field in the Segments list.

Delete Alt-D Delete the highlighted field from the Segments list.

Shortcut:
You can double-click a field in the Field list to add it to the Segments list.    You can 
double-click a field in the Segments list to remove it from the list.

The fields you select for the Foreign Key Segments list must match the fields in the primary
key of the associated table exactly in data type and size.



Edit Database Information Dialog
Use the Edit Database Information Dialog to define the characteristics of the database.

Description
Enter a long description of the database 1 to 32 letters or digits.    This helps identify the 
database in certain situations.    It can be changed if necessary.



New Database Dialog
The New Database Dialog is displayed when you select the Create New Database 
Command.    It enables you to define the ID and directory of a new database.

Dialog Options

Database ID
Enter an identifier for the database.    The Database ID is a combination of one to seven 
letters (A-Z) and digits, that must begin with a letter.    The ID is used to identify the data 
dictionary file of the database, the system files, and the reports, lists, and forms defined for
the database.

Description
Enter a descriptive phrase up to 32 characters that describes the database.    You can 
change this description later with the Edit Database Information Command.

Directory
Enter a directory into which the database system files will be placed.      Enter the full 
pathname of the directory, such as: C:\APP\DATA for a directory called DATA that will 
contain the database system files, which is a subdirectory of a directory called APP located 
on the C drive.

If the directory you specify does not exist, Ad Hoc will ask you if you want to create it.
Only one set of database system files can reside in a directory.

When you accept the entries in the New Database Dialog, Ad Hoc will create a new set of 
system files and place them in the specified directory.



Report Elements Dialog
Use the Report Elements Dialog to work with the elements in a report.

Click on or Press To

Add Alt-A Add a new element to the end of the elements list.
Insert Alt-I Insert a new element before the highlighted element in the list.
Edit Alt-E Change the description of the highlighted element in the list.
Delete Alt-D Remove the highlighted element from the list.
Cancel ESC Close Report Elements Dialog

Shortcut
Double-click on an element in the list to edit its description.



Edit Element Dialog
Use the Edit Element Dialog to change the definition of a report element.

Dialog Options

Description
Enter a description of the element, from one to 32 characters.

Trigger
Select the event during the printing of the report that will cause the element to be 
rendered.

Region
Select the report region in which the element will be rendered.

Page Break Options
When an element is rendered, it can cause a new page to be started (a page break).    
Elements assigned to the Page Header or Page Footer regions cannot cause page breaks.

Option Description

None The element will not cause a page break.
Before A page break will happen before the element is rendered.
After A page break will happen after the element is rendered.
Set Page to 1 When a page break caused by this element occurs, the page 

numbering will restart at 1.
Render on break Selecting this option will cause an element to be rendered at each 

page break , in addition to its assigned event.    
Use this option, for example, if you want to repeat a break header 
element on every new page.

Fixed Size
Select this option if you want to specify an exact size of an element.    An example of an 
element that should have a fixed size is the image of a label on a report that prints mailing 
labels.    If you select this option you must specify:

Measurement Description

Width The width of the element, in increments of .001 inch.
Height The height of the element, in increments of .001 inch.
Left Margin The left margin within the element, in increments of .001 inch.    The 

distance between the left side of the element area and the start of text 
in the element.

Top Margin The top margin of the element, in increments of .001 inch.    The distance
between the top of the element area and the start of text in the element.

If you don't check the Fixed Size option, the width of the element will default to the 
distance between the left and right report margins.    The height of the element will be 
determined by the font height and the number of lines of text in the element, plus the top 
and bottom margin of the element.



Margins
The margins of an element are space between the borders of the element and text that 
appears in the element.    The margins are determined slightly differently, depending on 
whether you have selected the fixed size option or not.    All margins are specified in 
increments of .001 inch.    

For fixed size elements, the overall border of the element is fixed, and the margins 
determine the area available for text or other contents.

For non-fixed size elements, the left and right margins determine indents from the 
left and right report margins, and the top and bottom margins add extra space before or 
after an element:

Margin Fixed Size Element Non-fixed size
Left The space between the left edge 

of the element and the text or 
other contents

Provides an indent from the left 
report margin

Right The space between the element 
contents and its right edge

Provides an indent from the right 
report margin

Top The space between the element 
contents and its right edge

Adds space before (above) the 
element

Bottom The space between the element 
contents and its bottom edge

Adds extra space below (after) 
the element

Line Spacing
Select the spacing between lines of text in the element.

If you select Then

Automatic Lines will be spaced automatically by the size of the font of text in the line.
Set to... You must specify a spacing between lines in points.    Specify the distance 

between the top of a line and the top of the next line.

Font Button
Click on the Font Button to display the Font Selection Dialog, which enables you to select a 
font for the element.    

Use Default Report Font
Select this option to assign the font defined on the Report Layout Dialog instead of a locally
defined font for the element.    If this option is selected, changing the report font will change
the element font.

Use Common Report Tabs
Select this option to attach the common tabs defined for the report to this element.    All 
elements with this option selected will share the same report tabs.    When you change a 
tab setting for one of these elements, you will change it for all of them.

Word Wrap
Normally, when an element is rendered, it is truncated at the right margin of an element, 
and at the bottom margin if the element is fixed size.
If you check this option, lines within the element will be word wrapped, or broken at the last
word boundary before the margin and the rest of the line printed on the next line of the 
report.    This is particularly useful in paragraph style reports, and when you have included 



Text fields, which can contain paragraphs of text, on a report.    Any remaining tabs in a line 
that is word-wrapped are applied against the next tab stop after the new line is started.    
This may result in unwanted spacing if you are designing a columnar report.    For this 
reason, it is best not to place other fields after a Text field on a line, place Text fields on a 
separate line, or create a separate element for each text field.
If there are tabs in a Text field, they will be spaced according to the tab stops set for the 
element.
Note: There is an implicit option in Ad Hoc that could be called "Keep Together".    If word 
wrapping is not turned on, an element will be rendered entirely on the same page.    If there
is not enough room for a multi-line element at the bottom of a page, the entire element will
appear at the top of the next page.    With the word-wrap option turned on for an element, 
the element is handled a line at a time, and the implicit "Keep Together" option is turned 
off.    Therefore, a page break could occur in the middle of an element.

Don't Print Blank Lines
Select this option to suppress the rendering of blank lines in the element.    This is useful for
printing address labels, for example, when you have several address lines.    Blank address 
lines will not show up on the label.



Report Regions Dialog
Use the Report Regions Dialog to work with the regions in a report.

Click on or Press To

Add Alt-A Add a new region to the end of the elements list.
Insert Alt-I Insert a new region before the highlighted region in the list.
Edit Alt-E Change the description of the highlighted region in the list.
Delete Alt-D Remove the highlighted region from the list.
Cancel ESC Close Report Regions Dialog

Shortcut
Double-click on a region in the list to edit its description.



Edit Report Region Dialog
Use the Edit Report Region Dialog to change the definition of a report region.

Dialog Options

Description
Enter a one to 32 character description of the region.

Width
Specify the width of the region.    The width options are:

Option Description

Report margins The region will extend from the left margin of the report to the
right margin.

Fixed width The region will be the width you specify in increments of .001 
inch.

Width of fixed size elements The region will be as
wide as the sum of the widths of the elements assigned to the
region that have been indicated as having a fixed size.

Height
Specify the height of the region.    The height options are:

Option Description

Report margins The region will extend from the top margin of the 
report to the bottom margin.

Fixed Height The region will be the height you specify in 
increments of .001 inch.

Height of fixed size elements The region will be as high as the sum of the heights
of the elements assigned to the region that have a 
fixed size.

Float between regions above and below The region will 
extend from the bottom of the region that precedes
it in the regions list to the top of the region that 
follows it.

Note:    Some of the height and width options are mutually exclusive and some depend on 
the options of other report regions.    See Designing Report Regions for examples of how to 
set region size options.

Horizontal Position
For some Region Width options, you must designate horizontal positioning of the region on 
the report layout.    When you select these Width options

Specify Width
Size Width to Contents

You must specify a distance (offset) of the region from the left or right report margin in 
inches.    A positive offset measures distance to the right of the left margin or to the left of 
the right margin.



Vertical Position
For some Region Height options, you must designate vertical positioning of the region on 
the report layout.    When you select these Height options

Specify Height
Size Height to Contents

You must specify a distance (offset) of the region from the top or bottom report margin in 
inches.    A positive offset measures distance below the top margin or above the bottom 
margin.

Repeat Direction
The elements assigned to a region are repeatedly rendered in the region until it is filled.    
For example, each time a record is read, an element assigned to the next record event is 
rendered in its region.    Elements are repeated in a region according to the repeat direction 
option.

If you select Then

One column Elements are rendered from top to bottom in the region, in only one 
column, regardless of the widths of the region and element.

By rows Elements are repeated in rows and columns in the region, from right to 
left for each row, filling a row before going to the next. 

By columns Elements are repeated in rows and columns in the region, from top to 
bottom in a column, filling a column before going to the next.

The number of elements that fit across or down a region is determined by the size of the 
region and the size of the elements.    If there is not enough room either horizontally or 
vertically to render an element in a region, a page break occurs, which "empties" the report
regions so they can be filled with new elements.

Border
If you want a border rendered around a region

Select To print

Left a line on the left side of the region
Right a line on the right side of the region
Top a line along the top of the region
Bottom a line along the bottom of the region
All a border around the region

Border Style
Select the style of the borders that you want for the region.



Report Layout Dialog
Use the Report Layout Dialog to define the general characteristics of a report.

Dialog Options

Report ID
Enter a unique ID for the report, from one to eight letters or digits, starting with a letter.    
The report ID is used to store reports in the database Reports Table.    Two reports cannot 
have the same ID.

Description
Enter a descriptive phrase for the report, from one to 32 characters.    This will be used to 
display reports in selection lists.

Startup Dialog
Select this option if the report will have a startup dialog.    A start-up dialog is displayed 
before a report is printed to allow the user to enter information used to print the report.

Page Size
Enter the width and height of a page the report will be printed on.    This is the physical size 
of the page in inches.    If the report will be printed on 8 1/2 x 11 paper, for example, enter 
8.500 for the width and 11.000 for the height.

Printer Orientation
Select a printer orientation that will be used to print the report.

Orientation Description

Default The report will be printed with the orientation that the printer is already 
configured for.

Portrait
Landscape

Margins
Enter the Left, Right, Top, and Bottom page margins for the report, in inches.

Font
Enter the type face of the font that will be the default for the report.    An element can be 
assigned this common report font, or can have its own font assigned.

Size
Enter the size of the report font, in points.

Font Button
Instead of entering a type face and size for the font, click the Font Button to display the 
Font Selection Dialog, which enables you to select a font from the fonts installed on your 
computer.



Label Report Layout Dialog
Use the Label Report Layout Dialog to design the layout of a labels style report (mailing 
labels, etc.).    When you begin a new report with the New Command on the File Menu, and 
select the label style report, this dialog is displayed in place of the normal Report Layout 
Dialog.

Dialog Options

Report ID
Enter a unique ID for the report, from one to eight letters or digits, starting with a letter.    
The report ID is used to store reports in the database Reports Table.    Two reports cannot 
have the same ID.

Description
Enter a descriptive phrase for the report, from one to 32 characters.    This will be used to 
display reports in selection lists.

Style
The Style combo box contains a list of pre-defined label styles, plus a selection called 
"Custom".    To define your own label page layout, select custom.    When you select one of 
the other styles in this list, most of the label layout parameters are filled in with the 
specifications for the selected label style.

Startup Dialog
Select this option if the report will have a startup dialog.    A start-up dialog is displayed 
before a report is printed to allow the user to enter information used to print the report.

Page Layout Orientation
Select a printer orientation that will be used when the report is printed.

Orientation Description

Default The report will be printed with the orientation that the printer is already 
configured for.

Portrait
Landscape

Page Layout Width and Height
Enter the width and height of a page the report will be printed on.    This is the physical size 
of the page in inches.    If the report will be printed on 8 1/2 x 11 paper, for example, enter 
8.500 for the width and 11.000 for the height.

Page Layout Left and Top Margins
Enter the Left and Top, margins for the report, in inches.    The bottom and right margins will
be computed based on the number of labels and the spacing between labels.

Labels Across and Down
Enter the number of labels across the page and down the page.

Horizontal Spacing 
Enter the distance, in inches, between the left edge of one label and the left edge of the 



next label.

Vertical Spacing
Enter the distance, in inches, between the top edge of one label and the top edge of the 
label below it.

Label Width and Height
Enter the width and height of a label in inches.    If the labels touch each other on the page, 
the width and height will be the same as the horizontal and vertical spacing.

Label Margins
Enter the left and right margins within each label, in inches.    The label margins determine 
the distance of the text on the label from the left and top edges.    You cannot set a right or 
bottom margin.    If the text is larger than the label, it will extend beyond the edges of the 
label.

Font Button
Click the Font Button to display the Font Selection Dialog, which enables you to select a 
font for the labels from the fonts installed on your computer.



Quick Report Setup Dialog
The Quick Report Setup Dialog helps you quickly set up the basic design of a standard 
report.    This dialog is displayed only once when you start a new report by selecting 
"Report(Quick Setup)" from the New Command on the File Menu.    Once the report is setup 
up, use the commands on the Report Menu to make changes or further additions to the 
design of the report.
The Quick Report Setup Dialog creates a standard style of report with:

A page header with a centered title and an area (report element) for column 
headings

An area (element) for the detail line description
An optional area (element) for a page footer with either the report date, page 

number, or both
Common tabs for the column heading element and detail line element
Border lines under the page header and above the page footer

On the dialog, you enter the report title, define the fonts for each of the report elements, 
and select the date and page number options.    After Ad Hoc sets up the basic report, you 
must    enter the fields and text for the column header line and detail line.    They are 
initially established to share a common set of tabs, but you must set the tabs.

Dialog Options

Title to Appear on Report
Enter the title to appear on the title line of the report.    This will appear centered at the top 
of each page of the report.

Fonts
Select the fonts for the Report Title, the Column Headings, the Detail Line and the Page 
Footer of the report.    These fonts are initially set to the font you defined in the Report 
Layout Dialog.

Date Option
If you select (check) this option, the report will have a page footer element.    The print date
of the report will be on the left of the footer line (bottom left corner of each page).

Page Number option
If you select this option, the report will have a page footer element.    The page number will 
appear on the right side of the footer (lower right corner of each page).



Report Breaks Dialog
Use the Report Breaks Dialog to designate break levels for the report.    This dialog is 
displayed when you select the Report Breaks Command from the Reports Menu.
The Dialog lists the fields defined in the sort specification of the report view.    Click on a 
field to highlight it or to remove the highlighted.    Report breaks will correspond the 
highlighted fields.



Total Fields Dialog
Use the Total Fields Dialog to work with the total fields of a report.

Click on or Press To

Add Alt-A Add a total field definition to the report.
Edit Alt-E To change the definition of the selected total field.
Delete Alt-D To delete the selected total field.
Cancel ESC To close the Total Fields Dialog

Shortcut:
You can double-click on an entry in the Total Fields list to edit its definition.



Edit Total Field Dialog
Use the Edit Total Field Dialog to define a total field for a report.

Dialog Options

ID
Enter a descriptive ID for the total field, of from 1 to 32 characters.

Field
Select the designated "target" field in the report data view that the total field will be 
attached to.    This field should a numeric data type if the total field will be used for Sum, 
Average, Maximum, or Minimum.

Counter Type
The Counter Type option determines how the value of a total field is changed each time a 
record is read from the report view while the report is being printed:

Counter Type Action

Sum The target field value is added to the value in the counter field.
Count The value of the counter field is incremented by one.    If the Include Nulls

option is not selected, target fields with null values are not counted.
Average The value of the counter field is the average of the values of the target 

field in all the records read so far.    If the Include Nulls option is set, 
target field null values are counted as zero, otherwise they are not 
included in the average.

Maximum The value in the counter field is the largest value of the target field in 
records read so far.

Minimum The value in the counter field is the lowest value of the target field in 
records read so far.

Include Nulls
Select this option if you want the total field results to include records for which the 
designated target field is null.    If this option is not set, null fields will not affect the results 
in a total field.    If it is set, the field will be counted, but its value will be considered zero.    It
will therefore affect Count and Average type total fields.

Clear on Event
Select the report event that will cause the counter to be cleared, or reset to zero.    For a 
total field that is to include all the records in a report, select the Report Header event to 
clear the total field when the report starts.



Computed Fields Dialog
Use the Computed Fields Dialog to work with the computed fields of a report.

Click on or Press To

Add Alt-A Add a computed field definition to the report.
Edit Alt-E To change the definition of the selected computed field.
Delete Alt-D To delete the selected computed field.
Cancel ESC To close the Computed Fields Dialog

Shortcut
You can double-click on an entry in the Computed Fields list to edit its definition.



Edit Computed Field Dialog
Use the Edit Computed Field Dialog to define a computed field in a report.

Dialog Options

Identifier
Enter a descriptive string of from one to 32 characters that identifies the field.

Equivalent Field
The Equivalent Field combo box contains a list of the database fields defined for the report. 
Selecting one of these fields is a quick way of setting the field characteristics (Data Type, 
Edit Length, Decimal Places, and Case Control) of the computed field you are defining.    

Select "-none-" if you want to define the characteristics of the computed field 
yourself.

Select a field ID from the list if you want to set the computed field characteristics 
equal to the selected field's characteristics.

Data Type
Select the data type of the field.

Edit Length
Select the number of characters the user is allowed to enter when entering a value for the 
field.      For Character fields, this is also the size of the field.    For numeric fields it 
determines the number of digits a user can enter.    The edit length is used if you place this 
field on a report startup dialog.

Decimal Places
Select the number of decimal positions a Numeric field will have when formatted for output.

Case Control
Select one of the following options:

Case Option Description

None The user can enter letters in either upper or lower case and digits.
Upper All letters entered by the user are shifted to upper case.
Numeric The user can only enter digits and the following punctuation 

characters: . / + -

Expression
Enter the expression that is used to compute the field value.    See Field Expressions.

Compute on Event
Select the event that will cause the field value to be computed according the field 
expression.    In the current version of Ad Hoc, field values are computed only when the 
report starts (Report Header Event), before the startup dialog is displayed.    Therefore, the 
field expression can contain a suggested default value, and the user can override it when 
the report is started.



Field Expressions
In the current version of Ad Hoc, field expressions can only be constants.    A constant field 
expression is the same as the value you would enter for a field on a form.



Report Field Types
The types of report fields that can be defined for a report are:

Field Type Description

Standard Fields Built-in report fields that include Page, Date, and Time.
Database Fields Database fields are fields defined in the report view (See Data View 

Command).    The report field name is an "@" sign followed by the 
short field ID of the field.    (If the field is from a linked table, the link 
prefix is not used).    If two fields in the view have the same field ID, a 
"1" is appended to the name of the second field.

Total Fields Total fields are defined with the Total Fields Command.    
Computed Fields Computed fields are defined with the Computed Fields Command. 



Report Fields Dialog
Use the Report Fields Dialog to select a field to be inserted on a report layout at the 
position of the blinking edit cursor.    This dialog is displayed when you select the Insert 
Field Command.
The Report Fields Dialog contains a list of all the fields defined for the report.    Below the 
list is displayed a description of the field selected in the list.    This description includes:

Field Type Description includes

Standard Fields Description of the field
Database Fields The extended field ID from the report view

The field description from the data dictionary
Total Fields The computation type of the field

The database field whose value is being computed
Computed Fields The characteristics of the field

The expression



Report Display Window Options Dialog
Use the Report Display Window Options dialog to change the viewing and other options for 
report display windows.    You can display this dialog by selecting the Options command on 
the Report Display Window Menu.
Note: when you change these options, they are stored in the Ad Hoc initialization file, and 
will apply to every report display window that you open after you change the options.

Dialog Options

Report Page Height
There are two options for report page height:
Select To

As Designed Generate the report with a page height equal to that specified when the 
report was designed.

Fit Window Change the height of the report page to equal the height of the display 
area of the report display window.    The height of the window when the 
report generation starts is used.    If you subsequently change the 
window size, the page size of an already generated report is not 
changed.    If you change this option after the report is generated, you 
have to use the Restart command to regenerate the report with a new 
page size.

Magnification
The magnification options set the scaling of the report in the display window.    Using a 
smaller magnification zooms out so that more of the report is visible in the same area.    
Using a larger magnification zooms in so that the output of the report looks larger, but you 
see less of it.
Select To

Fit Window Set the magnification so that an entire page of the report can fit within 
the report display window.    This option is not available if you have set the
"Fit Window" Page Height option.

Custom Specify the magnification amount, from 10 percent to 200 percent.

Store Pages on Disk
As a report is generated, the image of each page is stored in memory.    Each page image 
could require 5,000 to 6,000 bytes for moderately complex pages of text, and possibly 
more for very complex output.    If you have a large report to view, and limited RAM in your 
computer, you can select the Store Pages on Disk option to store the page images in 
temporary files on disk rather than in memory.    Each page is stored in a temporary file with
a name like: ~MFxxxx.TMP.    These files are stored      If you have a TEMP environment 
variable specified, these files will be placed in the directory specified in that environment 
variable, otherwise they will be placed in your Windows directory.    When the report display 
window is closed, or a new report is generated, these temporary files are removed.    Don't 
select this option for the fastest report generation and display speed.



Tables Window
The Tables Window displays a list of the tables defined for the current database.    The 
tables are displayed alphabetically by Table ID.    This list also displays the description of the
table, its file status, and the number of records in the table.    When the Tables Window is 
displayed, you can use the commands on the Tables Menu to change table definitions and 
maintain table files.
The file status of a table displayed in the Tables Window is one of the following:

Status Meaning

OK The file exists and its status is normal.
No File The file could not be found.    Ad Hoc looks for a file with the name 

specified in the table definition.    If there is no pathname specified in the 
table definition, Ad Hoc assumes the file is in the directory assigned to 
the database when it was created.    This is the current working directory 
when the database is opened.

Error in File An error was encountered in opening the file.    The file must either be 
rebuilt, or if that is not possible, restored from a backup.    If all files 
contain this error code, there is a system problem.    In this case, before 
rebuilding, first close all your applications, reboot your system, and open 
Ad Hoc again.

The tables containing    data in the database are shown in black.    System files are shown in
blue.    If the table file could not be found, the table is displayed in red.
The system tables are:

Table ID Description

_DDDATA Contains data dictionary information, including validation rules for 
database fields.

_FORMS Contains the definitions of the data entry forms.
_REPORTS Contains the definitions of the reports in Client Connection.



Forms
Using Forms
Displaying Forms
Parts of a Form
Entering Data on a Form
Using a Form Scroll Region
Using a Form Search Window
Designing Forms



Using Forms
A form is a desktop object that displays records from the database, and optionally enables 
you to edit the contents of a record.    In many ways, a form is similar to a standard 
Windows dialog box.    A form contains objects called controls that display the contents of 
data fields and allow you to change the field contents.    The three main types of controls on
a form are:
Control Type Description
Edit Control Similar to a Windows dialog edit box.
Text Box Similar to a Windows dialog edit box.    A text box can contain more 

than one line of text, and is used to display and edit fields of type Text.
Combo Box Similar to a Windows dialog combo box.

Each form control corresponds to a field in the data view associated with the form, and 
when you change the information in the box and then accept the change, you have 
changed the field in the database.    If you discard the changes you make on a form, the 
changes are not made in the database.
See For help on
Parts of a Form Understanding the layout of a form and its various parts
Displaying Forms Displaying and putting away forms
Entering data on a form Making changes to the data displayed on a form
Using a Form Scroll Region Working with forms that contain scroll regions
Using a Form Search Window Selecting a record from the data view to display on a 

form



Displaying Forms

To open a form and display it on the desktop:

1. Select the Open Command on the File Menu to display the Open Dialog.
2. Highlight the name of the form you want to open, by clicking it or using the up or down 

arrow to highlight it.
3. Click the OK button, or press ENTER.
You can also just double-click on the name of the form to open it.

To put away a form
Make sure the form is the active form.    Then do one of the following:

Select the Close Command on the File Menu.
Double-click the System Menu icon in the top left corner of the form.
Click the System Menu icon to display the menu, the select the Close Command.

To close all the open forms on the desktop, select the Close All Command on the Window 
Menu.



Parts of a Form

Click on an object in the above graphic to see a short description.

Control Pad
The form control pad is displayed at the top of the form.    The control pad contains icons 
representing control functions for the form.    The icons displayed on the control pad will 
change depending on the status of the form.

Click To
Display the first record from the form data view.
Display the previous record from the form data view.
Display the next record from the form data view.
Display the last record from the form data view.
Display the form's search window.    This icon is displayed only if the form has a 

search window.
Prepare for entering a new record in the database.    This icon is displayed only if you 

are allowed to add new records using the form.    
Delete the current record.    This icon is displayed if you are allowed to delete records  

using the form.
Accept the changes you have entered on the form.    
Discard the changes you have entered on the form.
Display the lookup window for the field with the focus.



First Record
Click this icon on a form control pad to display the first record from the form's data view.    
The first record is determined by the current index selected in the search window, or the 
current sort order.    You can also

type Ctrl-F
select the First command from the Form Menu



Previous Record
Click this icon on a form control pad to display the previous record from the form's data 
view.    The record order is determined by the current index selected in the search window, 
or the current sort order.    If you hold the left mouse button down on this icon, the Previous 
command will start repeating until you release the mouse button.    You can also

type Ctrl-P
select the Previous command from the Form Menu



Next Record
Click this icon on a form control pad to display the next record from the form's data view.    
The record order is determined by the current index selected in the search window, or the 
current sort order.    If you hold the left mouse button down on this icon, the Next command 
will start repeating until you release the mouse button.    You can also

type Ctrl-N
select the Next command from the Form Menu



Last Record
Click this icon on a form control pad to display the last record from the form's data view.    
The last record is determined by the current index    selected in the search window, or the 
current sort order.    You can also

type Ctrl-L
select the Last command from the Form Menu



Search for a Record
Click this icon on a form control pad to display the search window.    If no search window has
been defined for the form, this icon will not appear on the control pad.    You can also

type Ctrl-S
select the Search command from the Form Menu



New Record
Click this icon on a form control pad to prepare the form for entering a new record in the 
database.    If the form does not allow the entry of new records, this icon will not appear.    It 
also does not appear when the form is in design mode.    You can also

press the INS key
select the New command from the Form Menu



Delete Record
Click this icon on a form control pad to delete the current record.    Ad Hoc will ask you to 
confirm the deletion.    If the form does not allow deletion of records, this icon will not 
appear.    It also does not appear when the form is in design mode.    You can also

type Ctrl-D
select the Delete command from the Form Menu



Update Record Changes
Click this icon on a form control pad to accept the changes you have made on the form.    
This icon appears if a change has been made on the form.    You can also

press the ENTER key
select the Update command from the Form Menu



Cancel Record Changes
Click this icon on a form control pad to discard the changes you have made on the form.    
The record will not be updated and the form will be restored to its values before you began 
the changes.    You can also

press the ESC key
select the Cancel command from the Form Menu
Lookup Field Value

This icon appears when the form control (field) with the current focus has a value that can 
be looked up in another table or has a validation rule defined in the data dictionary.    Click 
this icon to open the lookup window and select a value for the field.    You can also:

hold down the Ctrl key and press the up-arrow key
click the right mouse button in the data area of the control.



These are examples of edit controls.



The form title bar displays the name of the form.    You can click and drag the title bar to 
move the form on the desktop.    You can double-click the title bar to maximize the form.



Entering Data on a Form

To edit (make changes to) a record in the database
To edit a record in the database, make sure the correct record is displayed on the form:

Use the search window to find the record, or use the Next Record or Previous Record 
commands to locate the record.
 Move to the control that contains the data you want to change.    You can do this by:

Pressing the Tab key to move from one control to the next
Pressing Shift-Tab to move backwards from one control to the next
Click the left mouse button on the control

Edit controls and text boxes
To make a change to an edit control or a text box, position the cursor in the control at the 
point in the text where you want to make the change, then type in your change.    

Press the backspace key to delete the character to the left of the cursor
Press the Del key to delete the character to the right of the cursor
Hold down the left mouse button and drag the mouse across a selection of the text 

you want to highlight.    When a selection is highlighted, the next character you type will 
replace the highlight (the backspace and Del keys will delete a selection).
When you enter a change on a form, the update and cancel icons will appear on the control
pad.    Change as many data items as you want, then press the Enter key or click on the 
update icon to accept your changes and update the information in the database.    To 
discard your changes, press the Esc key, or click on the cancel icon.    

Combo boxes
Instead of typing data into a combo box, you select a value from a list of values in the 
combo box.    A combo box normally displays the selected value of the field.    To see the list 
of values and select a new value, you display the drop down list of the combo box.
To select a value from the combo box list,

Click the arrow icon on the combo box to display the list, then click on the desired 
entry.

Type the first letter of a value in the list to select it.    The list does not have to be 
displayed.    If several entries have the same first letter, successively typing the letter will 
select the items in order.
For fields that are required (not allowed to be blank) the combo box contains only the list of
valid values.    For fields that can be blank (have null values), there is an extra entry in the 
list designated as "n/a".    This corresponds to a null value, and selecting this entry in a 
combo box is the same as leaving an Edit control blank.

Accepting the changes
When you try to leave a form control, either by tabbing, clicking on another control, or 
accepting the changes to the form, Ad Hoc will validate the contents of the control.    If the 
information you entered into the box is invalid, Ad Hoc will not let you leave the control.    
Instead it will beep and display a message in the status bar.    If this happens, simply retype
your entry with a valid value for the field.

To add a new record on a form

1. Use the New Record command to blank the form.
2. Enter the field values for the new record
3. Accept the new record with the Update Record Changes command



To discard the new record without adding it to the database, use the Cancel Record 
Changes command.

You can add a new record on a form only if the Add permission was specified in the form 
design and all the required fields in the root table of the form's data view are on the form.    
For new record to be accepted, the field or fields that make up the primary key of the root 
table must not duplicate the key of a record already in the table.

To delete a record
Make sure the form is displaying the correct record, then use the Delete Record command 
to delete the record.    Ad Hoc will ask you to confirm the deletion.    You can delete records 
on a form only if the Delete permission was specified in the form design.



Using a Form Scroll Region
A scroll region is an area on a form that contains an imbedded list.    This list operates like a 
standard list object (See Using Lists), except that its data view is usually linked to the 
parent form so that the records displayed in the list have some relationship to the records 
on the parent form.

When a form with one or more scroll regions is first displayed, the form is active, which 
means that pressing the Tab key will move you from control to control on the form.

To activate the scroll region
Press the F6 key to activate a scroll region, or click on the scroll region with the mouse.    
When a scroll region is active, pressing the Tab key will move the input focus among the 
controls of the scroll region.    
Successively pressing F6 will move the active focus between the scroll regions and the 
form.    You can also reactive the form by clicking on any control on the form (except scroll 
regions and display-only controls).

Editing records displayed in the scroll region
If the scroll region has a pop-up edit form (see Using Lists), you can use the following 
commands when the scroll region is active:
To Do this
Add a new record Press Alt-A, or

Click the left mouse button on the Add button
Edit a record Highlight the record in the list by clicking on it or using the arrow keys, then

Press Alt-E, or



Click the left mouse button on the Edit button, or

Double-click on the record in the list
Delete a record Highlight the record in the list, then

Press Alt-D, or

Click the left mouse button on the Delete button
Ad Hoc will ask you to confirm the deletion



Using a Form Search Window
The search window of a form is a list attached to the form that pops up to display the 
records from the form's data view in a list (row and column) format.    You can use the 
search window to browse through the records and select a record to load into the form for 
editing.
If the form has a search window, you can use the search icon on the control pad to display 
the search window.    

Click on an area of the above graphic to see a short definition.

Selecting a Record from a Search Window
To select a record from the search window, click on the entry in the search list, or use the 
arrow keys to highlight the entry.    Then click the OK button or press the ENTER key.    You 
can also just double-click on the entry to select a record.    The search window will close and
the selected record will be displayed on the form.
If you want to close the search window without selecting a record, click the Cancel button, 
or press the ESC key.

Changing the order of records in the search window
Use the sort control at the top of the search window is a combo box that enables you to 
select the sort order of records in the list.    To display the drop-down list of the combo box, 
click on the combo box.    Select the sort order displayed.    The entries in the sort list will 
include:

All the indexes defined for the root table of the data view.    Each of these entries will 
include the index number and description.

The sort defined for the data view, if one was defined.    This entry will include the IDs
of the fields in the sort specification, if one was defined for the form's data view.
When you select a sort, the names of the fields that define the sort will be displayed after 
the search control (see below).

Searching for a Record
You can use the search control on the search window to search for a particular record in the
list.    See List Search Control for help.    When you have found (and highlighted) the record 
you want to edit,    press ENTER or click the OK button to hide the search window.    The 
record will be displayed in the form.    If you do not want to select a record from the search 
window, click the Cancel button or press the Esc key.



Click the OK button (or press the ENTER key) to select the record highlighted in the list and 
display it in the form for editing.



Click the Cancel button (or press the ESC key) to close the search window without selecting 
record.



Using Lookup Windows
A lookup window is a window that is available for certain controls on a form to enable you 
to scroll through a list of valid values for the control, and select one from the list.    If a field 
on a form is part of a link between the form's root table and another table, the link can be 
used to look up valid values for that field, and Ad Hoc will automatically validate any value 
you enter for the field.    The link is also used to fill out a lookup window that you can pop-
up to see a list of all possible values for the field.        An example in the sample database is 
the Department field on the Employee form.    When you move the cursor to this field,    you 
will see the lookup icon appear on the control pad, indicating that a lookup window is 
available for the Department field.

Lookup icon
Whenever the input focus is on a field that can be validated using a relationship between 
tables, a lookup icon appears on the form's control pad.    You can click on this icon to show 
the lookup window.    You can also click the right mouse button on the field or hold the Ctrl 
key down and press the up arrow key to display the window.
A lookup window acts just like other lists, such as the form's search window.    You can 
change the sort order of the records displayed to any of the indexes defined for the lookup 
table.      When you select an entry from the lookup list, the fields in the table's primary key 
are pasted into the corresponding fields (foreign key fields) on the form.    In our sample 
database, the Department ID from the Department table is entered into the Department 
field on the employee record.    
To select an entry on the lookup table, highlight it and click the OK button, or just double-
click it.
If you don't want to select an entry, click the Cancel button.
When you use a lookup window for the first time after opening a form, it will have 
approximately the same size as the form.    This may not be large enough to see all the 
columns or many of the rows in the lookup list.    To re-size the lookup window, drag its 
border with the mouse.    It will always open in the top left corner of the form, but it will stay
the size you make it until the form is closed.      Lookup window settings are not saved when 
a form is saved or from one use of the form to the next.    Similarly, the sort order of the 
lookup window will always initially be index 0 of the lookup table, but you can change this 
order like any other list.
See Designing Lookup Windows for information about specifying the fields that appear in a 
lookup window.

Other Types of Lookup Windows
The lookup icon is also displayed for fields that have validation rules in their definitions in 
the data dictionary (entered when you designed the table from the Tables Window).    For 
fields that have a Lookup validation type, a lookup dialog is displayed listing the valid 
values and their descriptions.    You can select a value in the same way as described earlier. 
Of course you can also use a combo box control for these types of fields.    The lookup 
window is displayed only if you use an edit control instead.    For fields that have range or 
set validation rules, a dialog pops up displaying the rules; you have to enter a value 
yourself.



Designing Forms
See Also

Steps in designing a form

1. Determine what information you want to appear on the form and how the form will be 
used.    Determine the data view for the form.

2. Decide on a preliminary layout of the controls on the form.
3. Select the New Command on the File Menu, then select Form from the list of objects.    

This will display a new, empty form on the desktop in design mode.
The following steps are performed by selecting commands from the Form Design Menu, 
which you display by clicking the right mouse button when the mouse cursor is over the 
form, or by pressing Alt-M.
1. Define the basic attributes of the form by selecting the Form Attributes Command on 

the Design Menu to display the Form Attributes Dialog.
2. Define the data view for the form by selecting the Data View Command on the Design 

Menu to display the Edit View Dialog.    (See Defining Data Views.)
3. Place a control for each field in the data view that you want to appear on the form.    

You can use the Quick Layout Command (see Quick Form Layout Dialog) to quickly 
create a standard layout of selected controls, or you can create each control 
individually with the New Edit, New Combo Box, and New Text Box commands.

4. Set the tab order of the controls.
5. Select the colors for the form with the Colors Command (see Colors Dialog).
6. Select the fonts for the form with the Fonts Command (see Fonts Dialog).
7. If the form has a search window, design the search window (see Designing a Form 

Search Window).
8. If the form has an attached data exchange template, design the template (see 

Designing Data Exchange Templates).
9. Set the size of the form by dragging its borders with the left mouse button.    The size of

the form is saved with the design.    The size of a form can be changed only when the 
form is in design mode.

10. Move the form to the position on the desktop where you want it to appear when it is 
first opened.    Move the form by dragging its title bar with the left mouse button.

11. Leave design mode by selecting the Leave Design Mode Command on the Form Design 
Menu.

12. Select the Run Diagnostics Command, either on the Form Run Menu or the Form Design
Menu, to check the design of the form.    (See Diagnostics);

13. Save the form design by selecting the Save Command on the File Menu.
Once a form design has been saved, you can display it on the desktop by selecting the 
Open Command on the File Menu.

To make modifications to a form design

1. Display the form on the desktop
2. Select the Design Mode Command from the Form Menu
3. Make the desired changes
4. Leave design mode by selecting the Leave Design Mode Command on the Form Design 

Menu



5. Save the form design with the Save Command on the File Menu

To delete a form design from the database
Select the Delete Command on the File Menu
Select the form design you want to delete from the list of forms and other desktop objects
Click OK or press ENTER.    Ad Hoc will ask you to confirm the deletion.

Design Considerations
To use the form for Make sure that

Editing records The Edit Records option is checked on the Form Attributes 
Dialog.

Adding new records The Add New Records option is checked on the Form Attributes 
Dialog, and that the form contains a control for each required 
field in the root table.

Deleting Records The Delete Records option is checked on the Form Attributes 
Dialog.

Importing/Exporting Data You have designed a data exchange template appropriate for 
the import and/or export operation.



Defining Data Views
Designing Form Controls
Arranging Controls on a Form
Aligning Controls on a Form
Designing a Scroll Region on a Form
Designing A Form Search Window
Designing Lookup Windows



Defining Data Views
Data Views are associated with forms, lists, and reports, and define the data from the 
database that will appear on the form, list, or report.    A data view is a collection of fields 
from one or more tables of the database.    In this respect, a view is like a table, except that 
its records are not stored physically in a file that corresponds to the view.    Instead, the 
records in a view are built    dynamically, as they are read from the view, from data fields 
stored in the database tables.    Using views, a form or report can work with data that is 
gathered from several different tables in the database.
In addition to the fields, a view definition consists of a sort specification, which defines the 
sort order of the records in the view, and a filter definition, which determines which records
from other tables are selected to provide data for the view.
See Edit View Dialog for specifics of using this dialog to enter a view definition.

Root Table
The primary table supporting the view is called the root table.

Only fields from the root table can be changed on forms, fields in the view supplied 
by other tables can only be displayed.

The pre-defined indexes of the view are the indexes of the root table.
Fields from tables other than the root table must be from tables that are related to 

the root table through one or more links. defined in the root table, or in tables linked to the 
root table.
The use of the form or report using the data view will usually make the choice of the root 
table obvious.    If you are designing a form to enter employee data into the database, for 
example, the Employee Table will be the root table.    In general, if you are defining a view 
based on two tables that are related by a link defined in one table, the table with the link 
definition should be the root table.

Fields
The fields of a view can be any field from the root table, or from any table that can be 
reached from the root table by a link.    You can select fields from tables that are not linked 
directly to the root table, but are linked to a table that itself is linked to the root table.    
Fields to include depend on the object the view is attached to:
Object Fields to Include
Form All the fields that you want to display in controls on the form.    If the form is to

be used to add new records, you must include all required fields of the root 
table.    If additional fields will be used to define the sort specification or filter, 
these must also be included in the view definition.

List All the fields that will be displayed in the list columns, and (if the list has been 
designed with a pop-up edit form) all the fields that will appear on the edit 
form.    If additional fields will be used to define the sort specification or filter, 
these must also be included in the view definition.

Report All the fields that will appear in the report layout, fields that will be used in the
definitions of computed report fields, and fields that will be used in the 
definitions of the view sort specification and filter.

Sort Specification
The sort specification consists of a list of fields that define the sort order of records.    
Records are sorted by the values of the fields in the sort order.    Each field can be sorted in 
either ascending or descending order.    Any field in the view can be used in the sort 
specification.



The sort specification is defined on the Sort Specification Dialog, which is displayed from 
the Edit View Dialog.

Filter
The filter of the data view determines how records are selected from other tables to make 
up the records of the view.    A filter selects records based on whether or not the values of 
specified fields in a record pass the comparison rules defined in the filter.    In the current 
version of Ad Hoc, only fields from the root table can be used to define a filter.    If no filter is
defined for the view, each record in the root table will generate a record in the view.
See Filter Rules Dialog and Edit Filter Rule Dialog for details on entering a filter definition.



Designing Form Controls
The process of laying out a form consists of placing a form control on the form for each field
in the data view that you want to display and optionally edit on the form.    To define or 
modify controls on a form, the form must be in design mode.

Control Type Can be used with fields of type
Edit Control Character, Integer, Numeric, Date
Combo Box Character, Integer, Numeric, Date which have a validation type of 

Lookup
Text Box Text

Topics
Quick Form Layout
Placing a Control on a Form
Changing the Tab Order of Controls
Changing the Definition of a Control
Arranging (Moving and Sizing) Controls
Aligning Controls

Quick Form Layout
To Quickly lay out a number of edit controls on a new form, use the Quick Layout Command
on the Form Design Menu.    (See Quick Form Layout Dialog).

Placing a Control on a Form
Select one of these commands from the Form Design Menu:

Selecting Will display
New Edit Edit Control Attributes Dialog
New Combo Box Combo Box Attributes Dialog
New Text Box Text Box Attributes Dialog

1. Use the dialog to define the field attached to the control, and other attributes of the 
control, the click the OK button, or press the ENTER key.

2. The dialog is closed and the shape of the cursor is changed to a cross
3. Move the cursor to the position on the form where the upper left corner of the control 

(not including its title) is to be placed
4. Click the left mouse button to place the control

Once a control is placed on a form, you can use the layout icons on the control pad to move
them to the correct position and size them.    See Arranging Controls on a Form and Aligning
Controls on a Form.

Changing the Tab Order of Controls
The tab order is the order that you move from control to control when you press the Tab 
key.    (Pressing Shift-Tab moves you in reverse tab order).    The tab order should be the 
order you want to fill out the controls when you enter data on a form.
1. Make sure no controls are selected by clicking on a blank area of the form.
2. Select the Tab Order Command on the Form Design Menu.    The cursor will change shape

to indicate you are in Tab Order mode.



3. Click the left mouse button on each control, in the order you want to establish as the tab 
order.    As each control is clicked, it is displayed with the selection border.

4. Click on all controls, even if they will be display-only.    When all controls have been 
selected, Tab Order mode will be turned off.    To leave Tab Order mode before selecting 
all the controls, use the Tab Order Command.

5. Press the Tab key to tab through the controls to check the order.    When the form is in run
mode, you cannot tab to controls that are display-only controls.

Changing the Definition of a Control
To change the display attributes, title, and attached data field for a form control, either:

Click the right mouse button on the control.
Select the control, or a group of controls, then select the Edit Control Command on 

the form design menu.
Either action will display the appropriate control edit dialog,    If more than one control is 
selected, a dialog will appear for each control in turn.



Arranging Controls on a Form
To design a form, you must arrange and size the data entry controls and scroll regions.    You
do this by selecting one or more controls and then using a layout tool to move or size the 
selected controls.

Selecting Controls
Select a control by clicking the left mouse button when the cursor is on the control.    When 
a control is selected, a selection border is displayed that encloses the data area of the 
control, its border (or underline) and its title.    This is referred to as the selection area of 
the control.    Clicking anywhere within this area will select the control.
To select more than one control to work with either:

Hold down the Shift key and click the left mouse button on each control to be 
selected.    With the shift key down, clicking on a control that is already selected will un-
select it.

Move the mouse cursor to a blank area of the form that is not in a control's selection 
area.    Hold down the left mouse button and drag the mouse cursor over the form.    A 
selection rectangle will be drawn on the screen as you drag the mouse.    When you release 
the left mouse button, any control whose selection area falls within the selection rectangle 
will be selected.

To select a second group of controls, follow the above procedure, but hold the Shift 
key down before you click the left button, and while you drag the mouse cursor.

When a group of controls is selected, clicking on a selected control will not change 
the selection, but clicking on an un-selected control (when the Shift key is not down) will 
remove the selection from the group and select the new control.

To un-select all controls, click on a blank area of the form that is not in a control's 
selection area.

Moving Controls
To move a control, first select it.    Move the mouse cursor to fall within the control's 
selection area, click and hold the left mouse button, then drag the control by moving the 
mouse.    When the control is in the desired position, release the left mouse button.
To move a group of selected controls, click and hold the left mouse button on any of the 
controls, then drag them to the desired new position.    The controls will move as a group, 
retaining their relative positions.
You can also move controls with the arrow keys on the keyboard.    With one or more 
controls selected, press the arrow key for the desired direction.    Hold the key down for 
continuous movement.    Each keystroke moves the controls one screen unit (pixel).    For 
faster movement, hold the Ctrl key down.    while pressing the arrow keys.    This causes the 
controls to move 5 pixels for each keystroke.    When the controls are in the desired 
position:

Accept the new position by pressing the Enter key, or clicking the left mouse button 
anywhere on the form.

Cancel the move by pressing the Esc key.

Sizing Controls
A new control is placed on the form with a default size, that is determined by the maximum
length of data in the field attached to the control.    Once a control placed on the form, you 
can change its size by dragging the appropriate border of the control's selection area.

Select the control
Move the mouse cursor to the border you want to drag.    For example, if you want to 

make the control wider, either drag the left border to the left, or the right border to the right.
Move to a corner of the border to change width and height at the same time.



When the cursor changes to an arrow shape, click the left mouse button and hold it 
while dragging the border to the desired size, then release the button.

If several controls are selected, only the control you drag will be re-sized.
Restrictions on sizing:

You can change only the width of edit controls, the height of an edit control is 
adjusted automatically to the font you select for controls.

When you change the size of a combo box control, you are changing the size of the 
drop down list for the control.    The area in which this list will be displayed is outlined in 
design mode so you can see where it will be.    The drop down list area is included in the 
control's selection area.



Aligning Controls on a Form
Aligning controls on a form consists of arranging or sizing a group of controls relative to 
each other.    In design mode, a set of alignment icons are displayed on the form's control 
pad.    Clicking these icons carry out alignment and sizing operations on the selected 
controls.    There are corresponding commands on the Alignment Menu.    the Alignment 
Menu is a second level menu displayed when you select the Alignment Command on the 
Form Design Menu.
Icon Menu Command Action

Align Left Aligns the selected controls in the horizontal direction so that the left 
edges of their data entry areas are lined up vertically.    Titles are ignored for the alignment.

Align Right Aligns the selected controls in the horizontal direction so that the right
edges of their data entry areas are lined up vertically.

Align Top Aligns the selected controls in the vertical direction so that the top 
edges of their data entry areas are lined up horizontally.

Align Bottom Aligns the selected controls in the vertical direction so that the bottom
edges of their data entry areas are lined up horizontally.

Space Equally Vertically Moves the controls vertically so that they have equal 
spacing between them in the vertical direction.    The top and bottom controls in the 
selection are not moved.

Space Equally Horizontally Moves the controls horizontally so that    they have equal
spacing in the horizontal direction.    The leftmost and rightmost controls in the selection are 
not moved.

Grow to Largest Width Re-sizes the selected controls to the width of the widest 
control in the selection.

Shrink to Smallest Width Re-sizes the selected controls to the width of the control 
with the smallest width in the selection.



Designing a Scroll Region on a Form
A scroll region is a form control that contains an embedded list.    The list can be used to 
display records from another view that is related in some way to the view attached to the 
main form.    For example, a department form could contain a scroll region with a list of 
employees in the department.
Designing a scroll region is similar to designing a list (see Designing Lists).    Since the list is
embedded in a form, there are some additional considerations:

The scroll region has form control attributes, including a title and the position of the 
title.    These are defined on the Scroll Region Attributes Dialog.

The List Design Menu of a scroll region is displayed by clicking the right mouse key 
on the scroll region. It has two commands not on the standard List Design Menu:

The Control Style Command displays the Scroll Region Attributes Dialog
The Link to Parent Command displays the Edit Link Dialog, which enables you to 

describe how the scroll region view is linked to the parent form view.    The list within the 
scroll region is usually linked to the parent form.

To place a scroll region on a form

1. Select the New Scroll Region Command from the Form Design Menu.    The cursor will be 
displayed as a cross.

2. Move the mouse cursor to the spot you want the upper left corner of the scroll region to 
appear, then click the left mouse button.

3. Fill out the scroll region attributes on the Scroll Region Attributes Dialog and click the OK 
button or press ENTER.    The scroll region will be displayed.

4. Click and drag the border of the scroll region with the left mouse button to size the 
region.

Moving a scroll region
Scroll Regions are sized and moved like other form controls.    (See Arranging Controls on a 
Form and Aligning Controls on a Form.    

Note:    The tab bar area of list in the scroll region cannot be used to select or drag the 
scroll region.    Mouse actions in this area are for moving and defining the column tabs of 
the list.

To design the scroll region
Size and position the scroll region as described above.    Clicking the right mouse button on 
the scroll region displays the Scroll Region Design Menu.
1. Define the scroll region data view with the    Data View Command on the Design Menu.
2. Define the scroll region list attributes with the List Attributes Command.
3. Define the scroll region colors and fonts with the Colors and Fonts Commands
4. Define the form control attributes of the scroll region with the Control Style Command
5. Define the way the data view of the scroll region is related to the data view of the parent 

form with the Link to Parent Command.
Note:    The link between the list in the scroll region and the parent form is not active while 
the form is in design mode.
See Designing Lists for more details.



Designing a Form Search Window
To include a search window on a form, check the Search Window option on the Form 
Attributes Dialog.    When the form is in design mode, use the Search command to display 
the search window in design mode.
Follow the same steps in designing a search window that you would to    design a list (see 
Designing Lists), with the following restrictions:

You do not need to specify an ID or description for a search window since it is part of 
the parent form.

The data view of the search window must have the same root table as the data view 
of the parent form.

The button style of a search window must be OkCancel.
A search window cannot be used to add or edit records, only to find records for the 

parent form.
After you have specified the search window layout and control options:
1. Select the sort option that you want to be the default option the first time the search 

window is displayed.
2. Size and position the list where you want it to appear in relation to its parent form.    

When you save a form design, the current size and position of the search window with 
respect to the parent form are saved with the design.

Size the search window by dragging its borders with the left mouse button down.
Position the search window by dragging its title bar with the left mouse button down.

To hide the search window during the design process, click the OK or Cancel button, or 
press the Esc key.



Designing Lookup Windows

You can determine the fields that appear in the columns of a lookup window by including 
them in the data view of the main form.    There will be a column in the lookup window list 
for each field in the view that is from the linked lookup table.    The lookup window will 
always contain the primary key fields of the linked table, even if you don't specify them.    
That way, the entries in the lookup list will always show the values that are being pasted 
back into the field being looked up.
For example, suppose an Employee form has the following view fields specified:
EMPID, LNAME, FNAME, HOMEDEPT (employee id, last name, first name, home department)
In the definition of the Employee table, there is a link defined that links HOMEDEPT in the 
Employee table to DEPTID in the Department table.    This link is called DEPTLNK in the 
Employee table.    Therefore the HOMEDEPT field on the form can be validated against the 
Department table.    If you included no fields from the Department table in the view for the 
Employee form, the lookup window would contain a column for one field: DEPTID.
If you wanted to also see the department name in the lookup list, you would specify it in 
the view of the Employee form through the link.    The ID of this field in the Department 
table is NAME.    It would be prefixed by the link ID in the employee form view, so the 
employee form view would become:
EMPID, LNAME, FNAME, HOMEDEPT, DEPTLNK.NAME

By including the field DEPTLNK.NAME in the view of the employee form, you cause the
Department table field NAME to appear as a column in the lookup window for HOMEDEPT.



Lists
Using Lists
Displaying Lists
Entering Data with a List
Parts of a List
List Sort Control
List Search Control
Designing Lists



Using Lists
A list is a desktop object that displays records from the database in a row and column 
format.    A row in the list corresponds to a database record.    The columns in the list 
correspond to fields in the record.    When you design a list, you define its data view, which 
determines which fields from the database are displayed in the list.    Special uses of lists 
include form search windows and form scroll regions.
The design of a list can include a pop-up edit form, which enables you to edit or delete a 
record displayed in a list, as well as add new records.
A list can also have index and search controls that enable you to change the ordering of 
records in a list and easily find a particular record.

Keystroke Navigation
To move to a selected entry in a list, you can use the arrow keys or the list scroll bar.    Lists 
also offer keystroke navigation, which refers to typing letter keys to move to a selected 
entry in the list.    See Desktop Configuration Dialog for a discussion of keystroke navigation
options for lists.

See For help on
Parts of a List Understanding the design of a form and its various parts
Displaying Lists Displaying and putting away lists
List Sort Control Selecting the sort order of records in a list
List Search Control Searching for a record in a list
Entering Data with a List Changing database records in the list



Displaying Lists

To open a list and display it on the desktop:

1. Select the Open Command on the File Menu to display the Open Dialog.
2. Highlight the name of the list you want to open, by clicking it or using the up or down 

arrow to highlight it.
3. Click the OK button, or press ENTER.
You can also just double-click on the name of the list to open it.

To put away a list
Make sure the list is the active desktop object.    Then do one of the following:

Select the Close Command on the File Menu.
Double-click the System Menu icon in the top left corner of the list.
Click the System Menu icon to display the menu, then select the Close Command.

To close all the open lists and forms on the desktop, select the Close All Command on the 
Window Menu.



Parts of a List

Click on an object in the above graphic to see a short description.



The list title bar displays the name of the list.    You can click and drag the title bar to move
the list on the desktop.    You can double-click the title bar to maximize the list.



The sort control of a list is a combo box that enables you to select the order that records 
will be displayed in the list.



The search control of a list is an edit control that enables you to search for a particular 
record in the list.



The search fields area on a list shows the fields that define the sort order of the records.    
These fields are used to search for a record when you enter a value into the search edit 
control.



The column heading area of a list displays the titles of the fields displayed in the list.



The main area of a list displays the list entries.    Each list entry corresponds to a record 
from the data view of the list.



List Command Buttons
A list can contain command buttons at the bottom of the list.    When you click on these 
buttons, commands are sent to the list.      There are two styles:
Button Style Description
OK / Cancel Selects an entry in the list, hides a pop-up list (such as a form search 

window).
Add / Edit / Delete Indicates the list has an associated pop-up edit form that can be used 

to add, edit, or delete records in the list. 



List Sort Control
The sort control on a list is a combo box that displays the sort options of records in the 
list.    Click on the sort control    to display the drop-down list of the combo box, then click on
an entry to select it.    The entries in the sort order list will include:

All the indexes defined for the root table of the data view.    Each of these entries will 
include the index number and description.

The sort defined for the list data view, if one was defined.    This entry will show the 
fields in the sort specification of    the list's data view.
When you select a sort, the names of the fields that define the sort will be displayed to the 
right of    the search control.
If the list is a search window of a form, selecting an index as the sort order will also set the 
order of records in the parent form to the same index.



List Search Control
The search control on a list is an edit control that enables you enter a search value to find
a particular record in the list.    When you select a sort order for the list, the fields that 
define the sort order are displayed to the right of the search control.    The value you enter 
in the search control is used to find a record with the closest match in these fields.

To find a record

1. Determine which sort order you want to use to locate the record and select it with the 
sort control. 

2. Move to the search control by clicking on it, pressing Alt-S, or tabbing to it.
3. Enter a search value that will be used to find the closest matching record.    The value 

you enter will be compared with value in the first sort field.    
4. Press the ENTER key (or click the OK button if the list has one).
5. The first record from the data view that most closely matches your entry will be 

highlighted in the list.

How records are matched
If there is only one field that defines the sort order of a list, the search value you enter is 
compared with the contents of that field in each record.    The selected record is the first 
one in the data view whose field value is equal to or greater than the search value.    If the 
sort order is defined by more than one field, the first field is used.
You can enter a search value for more than one field in the sort order by separating the 
values with a comma.    The first value you enter is compared with the first field, the second
with the second, etc.    The record selected will be the first record in the data view whose 
field values, taken together, are equal to or greater than the search values.

Example
A list of employee records, the sort order is Last Name, First Name.    In the employee table 
are the following employees:

Roberts, Peter
Smiley, Beth
Smith,    Michael
Smith,    Theresa
Sommers, John

Entering Search Value Will find the record for
S Beth Smiley
Smith Michael Smith
Smith,T Theresa Smith
Smi,Theresa Beth Smiley (because Smiley is the first record greater than or 

equal to Smi)



Entering Data with a List
A list can be used to enter and edit records in the database if it has been designed with a 
pop-up edit form.    A list with an edit form has Add, Edit, and Delete command buttons 
displayed at the bottom of the list.    The list edit form is displayed if you click the Add or 
Edit buttons.
Entering data on a pop-up edit form is similar to using a standard form for entering data 
(see Entering Data on a Form).    The differences are:

The pop-up edit form of a list can display only the record that is highlighted in the list 
(or a new record that will be inserted in the list).

The pop-up form's control pad contains only the update and cancel icons.

To edit (make changes to) a record

1. Highlight the record in the list.
2. Click the Edit button, or press Alt-E.
3. Make the changes on the pop-up edit form, then select the Update Record command.
To cancel the edit, use the Cancel Record Changes command.

To add a new record

1. Click the Add button, or press Alt-A.
2. Fill out the pop-up edit form, then select the Update Record command.
To cancel the add, use the Cancel Record Changes command.
When you add a new record, the list is re displayed so that the new record is displayed and 
highlighted in the list.
Note:    You can add new records on a list only if the Add permission was specified in the list
design and the edit form contains all the required fields in the root table of the list's data 
view.

To delete a record

1. Make sure the correct record is highlighted in the list.    
2. Click the Delete button, or press Alt-D.
3. Ad Hoc will ask you to confirm the deletion.
You can delete records in a list only if the Delete permission was specified in the list design.



Designing Lists
Lists have a number of uses in Ad Hoc.    The basic steps in designing a list are the same for
all uses, but there are some differences.    This help topic describes the design process for a
standalone list, see the topics noted below for specifics on the other uses of a list.

Use Design Process
Standalone desktop object Use the New Command on the File Menu to open a new 

list and the Save Command to save it in the Forms table.
Search window of a form Designed as part of the form.    See Designing a Form 

Search Window.
Embedded in a Scroll Region Designed as part of the form.    See Designing a Scroll 

Region on a Form.

Steps in designing a list
Use the File New Command on the File Menu to open a new list on the desktop, or use the 
File Open Command to open an existing list.    A new list is opened in design mode.    To put 
an existing list in design mode, select the Design Mode Command on the List Menu.    
Display the List Menu by clicking the right mouse button on the list, or by pressing Alt-M.    
To design a new list:
1. Decide how you want to use the list, and what data will appear on it.
2. Define the data view attached to the list by selecting the Data View Command on the List

Design Menu to display the Edit View Dialog.    See Defining Data Views.
3. Define the fields to appear on the list, the column titles, list controls, and database 

permissions by selecting the List Attributes Command to display the List Attributes 
Dialog.    See Designing a List Layout.

4. Position the columns of the list (See Setting List Columns).
5. Select the list colors by using the Colors Command to display the Colors Dialog and the 

list fonts by using the Fonts Command to display the Fonts Dialog.
6. If you have specified the AddEditDelete button style on the List Attributes Dialog, the list 

will have a pop-up edit form.    Design the Edit Form (see Designing a List Edit Form).
7. Size the list by dragging its borders with the left mouse button.    The size of the list when

it is saved will be its initial size when it is opened on the desktop.
8. Move the list to the position where you want it to appear on the desktop when it is first 

opened.    Move the list by dragging its title bar with the left mouse button.
9. Leave design mode by selecting the Leave Design Mode Command on the List Design 

Menu.
10. Select the Run Diagnostics Command on either the List Run Menu or the List Design 

Menu, to check the design of the list.    (See Diagnostics).
11. Save the list design with the Save Command on the File Menu.

To make modifications to a list design

1. Display the list on the desktop
2. Select the Design Mode Command from the List Menu
3. Make the desired changes
4. Leave design mode by selecting the Leave Design Mode Command on the List Design 

Menu
5. Save the list design with the Save Command on the File Menu



To delete a list design from the database
Select the Delete Command on the File Menu
Select the list design you want to delete from the list of forms and other desktop objects
Click OK or press ENTER.    Ad Hoc will ask you to confirm the deletion.



Designing a List Layout
The elements of a list layout include

The controls that appear on the list
The fields that are displayed in the columns of the list
The spacing and alignment of the columns
The fonts and colors of the list

List Controls
The controls that appear on a list are defined on the List Attributes Dialog.    

Check the  Search Control option if you want to be able to find records in the list by 
typing in a search value.

Check the Sort Control option if you want to be able to change the record sort order 
while using a list.
Select one of the following button styles

Button Style Description
None The list will have no command buttons.
OKCancel Used for search windows.    The list will have two buttons:

OK hides the list and sends a selection notification to its parent form

Cancel hides the list.
AddEditDeleteIndicates the list has an associated pop-up edit form that can be used to add, 
edit, or delete records in the list.    The list will have three buttons:

Add displays the edit form for adding a new record

Edit displays the edit form for editing the current selection in the list

Delete deletes the current selection in the list

List Fields
Select the fields to display in the columns of the list from the fields defined in the data 
view.    Fields to be displayed are selected on the List Attributes Dialog.
Each displayed field defines a column in the list display.    If you have selected the Column 
Headings option on the List Attributes Dialog, you can designate a title for each column.    
The fields you display will depend upon your application, but you should include fields that 
will help the user identify the records in the list.    (For example, for a list of employees, you 
should include the employee ID and name).    Include fields that help the user identify the 
sort order for each sort option available in the list.    (For example, if you can order the 
employee records by employee ID, the ID field should be included as a column in the list.)

Spacing and Alignment of List Columns
Once you have designated the fields that will be displayed on the list, you can size the 
columns using the tab bar displayed at the top of the list in design mode (see Setting List 
Columns).

Fonts and Colors
Use the Font Command on the List Design Menu to designate the fonts in the list.
Use the Colors Command on the List Design Menu to designate the list colors.



Setting List Columns
A list displays records in a row and column format.    Each row is a record, and each column 
corresponds to a field in the record.    When a form is in design mode, a tab bar is displayed 
above the column heading area of the list.    The tab bar contains a tab for each column in 
the list.
Tabs can only be moved right or left;    they cannot be deleted.

To move a column

1. Click and hold the left mouse button when the cursor is over the tab for the column.
2. Drag the tab to the left or right, release the mouse button at the desired location.

To move a column and all columns to the right
Depress and hold the Shift key, then click and drag the tab to the desired position.    

All tabs to the right of the dragged tab will maintain their relative positions to this tab.

To change the width of a column
Move the tabs located to the right of the column.

To add a column
Insert a new field in the Displayed Fields list on the List Attributes Dialog.    Insert the 

field in the correct position in the Displayed Fields list.    The list determines the order of the 
columns from left to right.

To remove a column
Delete the corresponding field from the Displayed Fields list on the List Attributes 

Dialog.

To change the alignment of a column
Click the right mouse button on the tab for the column to display the column alignment 
menu.    Select the desired menu option.
Alignment Type Description
Left The column is left aligned at the tab position
Right The column is right aligned at the tab position
Centered The column is centered around the tab position
Decimal The contents of the column are positioned so that the first decimal point 

(period) is aligned with the tab position.    If there is no decimal point, this
option acts like right alignment.    Use this alignment only for numeric 
fields that contain a decimal point.



Designing a List Edit Form
If you want to edit database records displayed in a list, you must include a pop-up edit form
in the design.    With the form in design mode:
1. Select the AddEditDelete button style on the List Attributes Dialog.
2. Set the database access permissions allowed for the list (see List Attributes Dialog).
3. Click on the Add or Edit list command button (or press Alt-A or Alt-E) to display the edit 

form.
4. Size the edit form by dragging its borders with the left mouse button
5. Position the edit form by dragging its title bar with the left mouse button.    Position the 

form where you want it to pop-up relative to its parent.
6. Design the layout of the form just as you would design a standard desktop form (see 

Designing Forms).    Clicking the right mouse button on the list edit form displays the 
Form Design Menu.

7. Make sure the form is the correct size and positioned correctly relative to the parent list.
8. Hide the pop-up edit form with the Cancel command.
There are some restrictions when designing list edit forms:

The edit form uses the data view of the parent list, so all fields that will appear on the
edit form must be defined in the list data view.

Database add, edit, and delete permissions for the list apply to the edit form.    They 
are defined on the List Attributes Dialog.

A list edit form cannot have a data exchange template.
You cannot leave design mode from the edit form.    You must hide it and use the 

Leave Design Mode command on the List Design Menu.



Keyboard Reference

Global Keys for Ad Hoc
F1 Display context sensitive Help
Shift+F1 Display help system table of contents
Ctrl+F1 Search for help on a topic

F2 Open a desktop object
Shift+F2 Open a new desktop object to design

F3 Close the active desktop object
F4 Save the design of the active desktop object
F9 Print a report
Shift+F9 Open a report design window
Ctrl+F9 Display a report on the screen

F10 Display/Hide Tables Window

Forms
Ctrl+D Delete the current record
Ctrl+F Display the first record in the data view
Ctrl+L Display the last record in the data view
Alt+M Display the Form Menu (or the Form Design Menu if in design mode)
Ctrl+N Display the next record
Ctrl+P Display the previous record
Ctrl+S Display the search window to find a record
Enter Accept changes on the form, update the database
Esc Discard changes on the form, restore the original contents
Ins Start editing a new record
Tab Move from one control to another on the form
Shift+Tab Move backwards from one control to another
F6 Cycle between the form and its scroll regions (if any)

Lists
Alt+A Display the edit form to add a new record
Alt+D Delete the selected record in the list
Alt+E Display the edit form to edit the selected record in the list
Alt+M Display the List Menu (or the List Design Menu if in design mode)
Alt+O Move to the sort order selection control
Alt+S Move to the search control
Enter Accept the selected record and close (for search windows)

Accept the search value and find a record (for search windows when the 
search control has the focus)

Esc Close with no selection (for search windows)

Report Design Windows
Ins Insert a field at the cursor position
Shift+Ins Insert a new element below (after) the current element
Alt+M Display the Report Design Window pop-up menu



Report Display Windows
Ctrl+F Display the first page
Ctrl+G Go to Page...
Ctrl+L Display the last page
Ctrl+N Display the next page
Ctrl+P Display the previous page



Reports
Printing Reports
Displaying Reports on the Screen
Printer Setup
Designing Reports



Printing Reports
Report designs are stored in the Reports table of the database.    To print a report:
1. Make sure your printer is connected, turned on, and on-line.
2. If the report requires a special printer configuration, such as page orientation or paper 

source, use the Printer Setup Command on the File Menu to select and configure a 
printer.

3. Select the Print Report Command on the File Menu to display the Print Report Dialog.
4. The Print Report Dialog contains a list of all reports stored in the database, sorted 

alphabetically by description.
5. Highlight the report you want to print, then click the OK button or press the Enter key.
6. Shortcut: Select a report and print it by double-clicking on the entry in the list.
7. If the report has a startup dialog, enter the information requested on the dialog, then 

press Enter or click the OK button.
8. If the report has to sort records in its data view, it will display a sorting progress box 

showing the number of records read and the total number to sort.
9. While the report is printing, the Print Report Dialog is displayed.    This dialog shows the 

report being printed, the printer being used, and the page of the report that is currently
printing.

10. To cancel the report before it completes printing, click the Cancel button on the Print 
Report Dialog.



Printer Setup
Use the Printer Setup Command on the File Menu to select a printer attached to your 
computer, and set the configuration of the printer.    When you select a printer and 
configure it using the Printer Setup Command, the settings are used only by Ad Hoc; the 
printer configuration you designate within Ad Hoc is not seen by other programs.
The configuration settings that are most commonly changed are:

Page Orientation
A report can be printed in landscape orientation or portrait orientation.    A report design 
can designate the orientation to be used for the report, or can specify that the current 
printer setting be used.    In the latter case, you can set the orientation of a report with the 
Printer Setup Command. 

Paper Source
Most printers offer at least two paper sources: automatic feed and manual feed.    Some 
offer more than one paper bin, or have an envelope feeder.    The report design in Ad Hoc 
does not contain a designation of paper source,    so you must set the paper source using 
the Printer Setup Command before you print a report that requires a special setting.



Displaying Reports on the Screen
To display a report on the screen, select the Display Report command on the File Menu, or 
select the Display command on the Report Menu when a Report Design Window is active.    
See Report Display Window for details.
Reports are displayed with the same layout, fonts, tabs, etc. as when they are printed.    
The report display window is useful to preview a report as you are designing it.



Designing Reports

The steps in designing a report

1. Open a new report design window by selecting the New Command on the File Menu, 
then selecting one of the Report options.    Fill out the initial design dialogs that are 
automatically displayed for a new report.
To work with the design of an existing report, already saved in the database, use the 
Design Report Command.

2. When a report design window is active, the Report Menu appears on the Ad Hoc menu 
bar.    This menu contains the report edit commands.

3. Define the report layout and attributes with the Layout Command, which displays the 
Report Layout Dialog (or the Label Report Layout Dialog if the report is a label-style 
report).

4. Define any computed fields you want for the report with the Computed Fields 
Command.    Computed fields are defined on the Edit Computed Field Dialog.

5. Define the report data view with the Data View Command, which displays the Edit View
Dialog.

6. Define the report break levels, if any, with the Report Breaks Command, which displays
the Report Breaks Dialog.

7. Define any total fields you want for the report with the Total Fields Command.    Total 
fields are defined on the Edit Total Field Dialog.

8. Define the regions the report will have, using the Regions Command.    Regions are 
defined on the Edit Report Region Dialog.    See Designing Report Regions for details.

9. Define the elements of the report, using the Elements Command.    Elements are 
defined on the Edit Element Dialog.    See    Designing Report Elements for details.

10. Set the tabs for each report element.
11. Type in the contents of each report element.
12. Design the report startup dialog, if the report has one.    See Designing a Report Startup

Dialog.
13. Select the Run Diagnostics Command on the Report Menu to check your design.    (See 

Diagnostics.
14. Select the Display Command to test the report design by displaying the report on the 

screen.    (See Report Display Window)
15. Use the Save Command on the File Menu to save the report design in the database. 

Quick Report Setup
When you start a new report, Ad Hoc can help you set up a report if you select Quick Report
Setup.    Ad Hoc will first display the Report Layout Dialog and the Edit View Dialog for you 
to establish the basics of the report.    It will then display the Quick Report Setup Dialog 
which enables you to enter the report title, fonts for the main parts of the report, and other 
design options.    Ad Hoc will then set up the basic design for a standard report with a title, 
column headings, a detail line, and a page footer with optional date and page number.    You
must enter the fields and text in the column heading and detail line.



Report Design Windows
A report design window is a desktop object that enables you to design a report.

Click on areas of the above graphic to see a short description.

Ruler
The ruler displays the tab settings for the active element (the element that contains the 
edit cursor) and is used to change tab settings.    See Setting Report Tabs.

Element Edit Box
A report design window contains an element edit box for each element of the report.    The 
elements are displayed in the order that they are defined on the Report Elements Dialog.    
When you move the edit cursor into an element edit box, the tab settings for the element 
are displayed on the ruler, and the description of the element and its region are displayed 
on the Ad Hoc status bar.    The size of the edit box is determined by the size you specify for
the element on the Edit Element Dialog.



The title bar of a report window displays the long description of the report being designed. 
If a description has not been entered, it displays "untitled".



Element Edit Boxes display the design of each element in the report.    Fields inserted in 
the text of an element are displayed in the element edit box as the field ID enclosed in 
braces { }.



Understanding Reports
Ad Hoc uses a unique model for a report that gives you a great deal of flexibility in 
designing complex reports.

Report Identifiers
When you design a report, you must specify a report ID, which is unique to that report, and 
a longer report description.    The ID is the primary key of the report in the Reports table, 
the description is displayed in report selection lists.

Report Data View
You specify the information from the database that appears on the report by defining a data
view for the report.    As with any data view, you can specify the sort specification and filter. 
The fields from the view can be inserted anywhere in the report design.    When Ad Hoc 
prints a report, it opens the report view and reads records from the view.    As each record is
read, it triggers an event. Events result in an action such as the printing of a line of the 
report, or a computation of a report field value.    See Report Events for a list of the events.

Report Layout
A report design specifies how information is presented on a printed page.    The Report 
Layout Dialog enables you to specify the physical dimensions of the page, and the page 
margins.    You can also specify whether the report is printed in landscape or portrait 
orientation.    The page size, orientation, and margins determine the area in which the 
report can be printed.
You must define one or more regions within the report area.    A region specifies an area 
within which specified information is printed.    A simple report layout may have two 
regions: a page header region within which the title and column headings are printed, and 
a detail region, within which the detail lines of the report are printed.
A report element defines the information that is printed in a report.    An element can 
contain text, database fields, and report fields.    When you design a report, you specify the 
contents of each element, its tab settings, and its font.    An element is printed in response 
to an event and is printed in a specified region.    In the simple report mentioned above, 
there would be two elements, one for the title and column headings, and one for the report 
detail line (one detail line is printed for each record read from the view).    When a page 
header event occurs, the title/column heading element is printed in the page header 
region.    When a detail line event occurs, a detail line is printed in the detail region.    As 
each record is read, a detail line is printed until the detail region is full.    This triggers a 
page header event, and a new page is started.
Regions can be sized by the size of their contents, so that only one instance of each 
element in the region can fit.    A page header region would fall into this category.    Regions 
can also be larger than the elements assigned to the region, in which case the elements 
are repeated in the region until it is full.

Fonts and Tab Settings
You can specify a font for each report element.    You can specify a default font for the 
report, and indicate that an element is to use the report font.    If several elements are using
the report font, you can change their fonts by making only the one change to the report 
font.
Similarly, each element has its own tab settings.    You can specify several elements use a 
common set of tabs, so that changing the tabs for any of these elements changes them for 
all elements using the common tabs.



If you need to use different fonts or tab settings within a section of the report, you must 
break that section up into different elements for each font or tab setting.

Computed Fields
In addition to the database fields defined in the view, you can define additional fields for 
the report.    The definition of these fields includes an expression that is used to compute 
the field value, and an event that triggers the computation of the value.    Computed fields 
can be placed on the startup dialog, so that the user can enter a value before the report 
prints.    Computed fields can be included in a report layout, or can be used in the filter of 
the data view, allowing the user to specify record selection criteria for the report.    See Field
Expressions for more information on expressions.

Total Fields
Total fields are a special kind of computed field that are computed from the values of 
database fields as records are read.    They can hold a count of records, a running total of a 
specified numeric field in the data view, a running average of a specified field, and other 
types of computations.    See Edit Total Field Dialog for a detailed description.



Report Events
Event When it happens
Report Header At the beginning of the report, after the computed fields are computed 

and the startup dialog is displayed.
Page Header Each time a new page is started, including the first page.
Detail Line Each time a record is read from the view.
Page Footer The last event for a page, just before a new page is started.
Report Footer At the end of the report, before the last page is completed (before the 

page footer of the last page)
Break Header After a record is read, but before the detail line event, if the record 

causes a report break.    A break header event is generated for each 
break level that has occurred.

Break Footer After a record is read, and after the detail line event, if the next record 
to be read will cause a report break.    A break footer event is generated
for each break level that will occur.

Break header and footer events are issued in the order of the break levels. Higher level 
break headers are issued before lower levels, and lower level break footers are issued 
before higher levels.    When a break event is issued, all lower level break events are 
automatically issued.

Example
Assume an employee report sorted by department and group within department.    The 
report includes a heading for department that is printed each time the department 
changes, and a total line showing the number of employees in the department.    There is a 
similar header line and total line for group.    You would define break levels for department 
and group.
As the report is printed, if the next record to be read is an employee from a different 
department than the current record, the break events will occur in the following sequence 
(includes the detail line event of the current record):
Event Triggers this element
detail line report detail line for current record
group break footer total line for group
dept break footer total line for department
dept break header heading for the next department
group break header heading for the next group
detail line report detail line for next record



Designing Report Regions
Use the Regions Command on the Report Menu to add, change, or delete the regions of the
report.    This command displays the Report Regions Dialog, which contains a list of the 
regions defined for the report.      See Edit Report Region Dialog for details on the design 
options for a region.

When you need to specify a region
A report must have at least one region in which information will be printed.
If the report contains a page footer, it must have a separate region for the footer to 
reserve space at the bottom of the page.
Whenever you want an area of the report to have a border style (such as an line under 
the page header) define a region for that area.

Order of regions in the Report Regions Dialog
The order that you add regions in the Report Regions dialog is important in only one case:    
If the height of the region is specified as "size between neighbors", the region must be 
defined in the list between the regions that it "floats" between.



Designing Report Elements
Use the Elements Command on the Report Menu to add, change, and delete elements from
the report design.    This command displays the Report Elements Dialog, which contains a 
list of the regions defined for the report.
See Edit Element Dialog for help on the detailed design options for elements.    Use this 
dialog to define

The element description
The region the element will be printed in
The event that will cause the element to be printed
The size and margins of the element
The font and line spacing
If a page break occurs before or after the element is printed
If blank lines in the element are printed or skipped

Define a report element for each piece of information (text and fields) that:
Is printed in a different region of the report
Is printed in response to a different event
Requires its own font or tab settings

Order of elements in the Report Elements Dialog
Elements are displayed on the report design window in the order they are defined on the 
Report Elements Dialog.    The order they appear in the list is also the order that elements 
assigned to the same region and triggered by the same event will be printed.    For 
example, if you have defined an element for the report title and an element for the column 
headings, they both will appear in the page header region and be triggered by the page 
header event, so make sure the report title element comes before the column heading 
element in the elements list.

Editing the contents of an element
To edit the contents of an element, click on the element edit box in the report window, or 
use the cursor keys to move the edit cursor into the element edit box.

Type in text that will appear in the element.
To insert a field value in the text, position the edit cursor at the insertion point and 

press the Ins key.    The Report Fields Dialog will be displayed, enabling you to select a field 
to be inserted.

Press the backspace key to delete text fields to the left of the edit cursor.
Press the Del key to delete text and fields to the right of the edit cursor.
To select a section of text, click and hold the left mouse button and drag it though the

text to highlight a selection.    When a selection is highlighted, it is deleted by press 
backspace or Del.

Placing text and fields horizontally
Use tabs to locate text and fields horizontally within an element.    This is necessary in the 
case of a report with columns of information.    Do not use spaces to position text in a 
element, particularly if you are using a variable pitch font where each character is a 
different width.

See Setting Report Tabs for help on defining the tab settings for an element
To insert a tab in the text of an element, press the Tab key

If you have defined a fixed size for the element on the Edit Element Dialog, then you can 
also specify a left margin for the element.

Placing text and fields vertically
You can control the vertical placement of text and fields to an extent by specifying the line 



spacing of the element on the Edit Element Dialog.    If you select the automatic option, the 
line spacing will be determined by the size of the font, otherwise you can specify the line 
spacing in points.
If you have defined a fixed size for the element, then you can also specify a top margin for 
the element.



Setting Report Tabs
Use the ruler displayed at the top of the report design window to set tab stops for an 
element.    Each element has its own tab settings, and when you move the edit cursor into 
an element's edit box, the element's tabs settings are displayed on the ruler.

To add a tab stop
Click the left mouse button at the spot in the ruler tab area where you want to place the 
tab

To move a tab stop
Position the mouse cursor over the tab icon, and use the left mouse button to drag the tab 
to the right or left, then release the mouse button.

To remove a tab stop
Position the mouse cursor over the tab icon, click and hold the left mouse button while 
moving the mouse cursor out of the ruler tab area, then release the mouse button.

To change the alignment of a tab
Click the right mouse button on the tab icon to display the Tab Style Menu, select one of 
the following tab styles:
Alignment Tab Description
Left Tab Text typed after the tab will be positioned at the tab position (left 

aligned on the tab)
Right Tab Text typed after the tab will be positioned before the tab (right aligned 
on the tab)
Centered Tab Text typed after the tab will be centered around the tab
Decimal Tab Text typed after the tab will be right aligned until a decimal point 
(period) is typed,    the decimal point will be aligned with the tab position.    Use decimal tabs 
only for positioning numerical data that contains decimal points



Designing a Report Startup Dialog
To include a startup dialog with the report design, check the Startup Dialog option on the 
Report Layout Dialog.    When this option is checked,    you can select the Edit Startup Dialog
Command on the Report Menu to display the report dialog.
You design a report dialog the same way you design a form.    See Designing Forms for 
detailed help.    Click the right mouse button when the mouse cursor is over the report 
startup dialog to display the Report Dialog Design Menu.    The commands on this menu 
function identically to the commands on the Form Design Menu.
After you lay out the desired controls on the dialog, size the dialog by dragging its borders 
with the left mouse button to the size you want it to appear when the report is printed.    
When the report prints, the dialog will be expanded in height to accommodate an OK and 
Cancel button at the bottom of the dialog.    Don't allow room for the buttons when you 
design the dialog.

Placing controls on the startup dialog
Controls are placed on a report dialog just as they are on a form.    The difference is that the
fields you assign to the controls are report fields that you want the user to set a value for 
before the report prints.    If the user must enter a value, check the Required option when 
you define the report field (see Edit Computed Field Dialog).    If a value is optional, don't 
check the Required option.



Report Display Window
You use a report display window to view a report on the screen instead of printing it.    To 
open a report display window, select the Display Report command on the File Menu.    If you
are designing a report in a Report Design Window, you can display the output of the report 
in a report display window by selecting the Display command on the Report Menu.    You 
may have any number of report display windows open at the same time, using the File 
Menu Display Report command.    From a report design window you can open only one 
associated report display window.
A report display window will display a report exactly as it would be printed.    You can, 
however, change the scaling (magnification) of the report to see more of it in the window.    
You can also set an option to change the page height in the report layout to equal the 
height of the report display window, so that you can see an entire page of the report 
(shorter than it would be on paper), at whatever magnification you select.
When you select a report to be displayed, the report display window will load the report 
from the database, and begin generating the report output.    As each page is generated, it 
is stored in memory.    You can select an option to store the pages temporarily on disk if the 
memory in your computer is limited.    As soon as the first page is completed, it is displayed
in the window.    You may move to any page that has been generated while the report is 
being processed.    After the report processing is complete, you can view any page of the 
report until you start another report or until you close the report display window.
You can change the scaling (magnification) of the report to from 10 percent to 200 percent 
of actual size (as it would appear on the printed page).    Since "actual size" on a display 
screen appears somewhat larger than printer output (depending on your display resolution 
and monitor size) you may find that a scaling of around 75 to 80 percent is most readable.
Since a report for an 8 1/2 x 11 inch sheet of paper, for example, will not fit entirely within 
a window, and scaling it to fit would probably result in a font size that is too small to read, 
you have an additional option of shortening the page height in the report design to match 
the height of the report display window.    When you change this option, you must restart 
the report.    Page heights are fixed after a report is generated, although you can change 
the magnification at any time.

Report Display Window Menu
The report display window menu is a pop-up menu that you can activate by clicking the 
right mouse button whenever the cursor is over the display area of the window.    This menu
contains commands that allow you to select reports, restart the current report, select pages
for display, and set the view options for the window.    See Report Display Window Menu.

Display Options
Display options can be set using the Options command on the Report Display Window 
menu.    This command displays the Report Window Options dialog.

Title Bar
The title bar of the report display window contains the long description of the report that 
you entered when you designed the report.    It also contains the page number of the page 
currently being displayed, as well as the total pages of the report.    As a report is being 
generated, you will see the pages total increase.    The designation "processing" will also be
in the title bar while the report is being generated.

Control Pad
The report display window contains a control pad that enables you to select pages to 
display, or stop the report while it is being generated.    The controls on this control pad are:



First Page
Click this icon to display the first page of the report.

Previous Page
Click this icon to display the previous page.

Next Page
Click this icon to display the next page.

Last Page
Click this icon to display the last page of the report.    If the report is still being generated,
the last generated page will be displayed.

Stop Report
This icon is displayed while the report is being generated, and is grayed out when the 
report generation is complete.    Click this icon to stop the generation of the report.    You 
can still view the pages that were already generated.
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What is a Database?
A database is a collection of related data that is organized so that the data can be easily 
retrieved in a desired format.    A database can be as simple as an address list, or as 
complex as all the data needed to run a company.    The data in relational database is 
divided into components called tables.    A table is a structure that holds data related to an 
object in the real world.    For example, in a company, the information on an employees 
would be stored in a table.    Information on purchase orders would be stored in a different 
table.    You can think of a table graphically as composed of rows and columns of 
information.    Each row in a table corresponds to a particular object, such as an individual 
employee.    In Ad Hoc, a row is called a record.    In the employee table, there is a record for
each employee.    
All the records in a table contain the same data.    A record can contain one or more items 
of data, called fields.    Each field is a piece of data of a particular type, such as text, 
numbers, dates, etc.    The fields correspond to the rows of the table.
Data in a relational database is stored in a very ordered fashion, to enable the program to 
retrieve it efficiently.    You will probably want to assemble the data into information that has
a different format from the way it is stored.    For example, you may want to display or print 
a report that contains selected fields from several tables, sorted and filtered in a way that 
meets your requirements for a particular application.    Ad Hoc provides the tools for you to 
extract the data in ways that are useful to you.
The definitions of the tables in a database and the fields that they contain, how the records 
in a table are indexed, validation rules for fields, and other information needed for the 
operation of Ad Hoc are stored in the data dictionary.    Each database contains a data 
dictionary that defines its contents.    Ad Hoc lets you edit a data dictionary at any time to 
change the way the data in the database is organized.



Primary Keys and Indexes
In Ad Hoc, at least one field in the table must be designated as the primary key.    The 
primary key of a table provides a unique identifier for each record in the table.    No two 
records can have the same value in the primary key field(s).    Usually, the primary key is a 
single field, but can be defined as several fields.    As an example, an employee record 
would contain the employee ID.    Since each employee must have a unique ID, the 
employee ID is a good choice for the primary key of the employee table.    The records in 
the table can be retrieved in order, sorted by the primary key.
A sort order that is built into the definition of a table is called an index.    The first (and 
required) index in a table is the primary key.    You can define additional indexes for a table 
so that you can retrieve records in other sort orders more suited for a particular application.
For example, you may want to define an index for the employee table that consists of the 
employee's last name and first name, so that you can retrieve records alphabetically.
You can define any sort order for a form or a report, independent of the indexes of the 
tables that are related to the report.    The difference between a form or report sort and an 
index is that an index is maintained by Ad Hoc as you add and delete records from a table. 
As a result, an index is always instantly available to order records in a table.    If you define 
a sort for a report that is not an index, the records used for the report have to be sorted 
each time you print the report.



Table Links
Ad Hoc is different from many relational database managers in that it stores the ways the 
various tables in the database can be related to each other.    In Ad Hoc, the relation of one 
table to another is called a link.    Links between tables always involve the primary key of 
one table, and an equivalent field (or set of fields in the other table).    The field (or fields) in
the second table must match the primary key of the first table, and is called a foreign key.   
This relationship between two tables can be stored in the data dictionary of the database 
and used to help you assemble fields from various related tables that you need for a form 
or report.    As an example, suppose your company database, in addition to the employee 
table, had a department table, that stored information on the departments in the company. 
You want to design a report containing employee information and some information about 
the department that each employee works in, sorted by employee.    Instead of keeping all 
the department information duplicated in each employee record, which would waste space 
and make it very difficult to keep the department information updated, you keep the 
department information in the department table, one record per department.    The primary 
key of the department table is the department number, which is different for each record in
the table.
One field in the employee record is the department number of the department the 
employee works in.    This field in the employee record is a foreign key for the department, 
and can be used to link a particular employee record to the department record that has the
same value in its primary key.    You would define this link for the employee table, and when
selecting employee fields for a report, you can use this link to also select fields from the 
department record for the report.    For each employee record printed in the report, Ad Hoc 
automatically retrieves the appropriate department record.
A database table can have any number of foreign keys to other tables, and therefore any 
number of links to other tables.    These links define the relations between tables that give a
relational database its name.



Types of Data
With Ad Hoc, you can define several types of fields in a table: character (alphanumeric) 
fields, integer (whole number) fields, numeric fields, date fields, and text (or memo fields).   
In addition, Ad Hoc is designed to accommodate other types of data fields, such as pictures
and other objects.



Data Views
A very important concept in Ad Hoc is that of the data view.    A view is similar to a table, in 
that it has records made up of fields.    However a view is not physically stored anywhere, 
as all of its records are assembled from one or more tables in the database.    A view is a 
virtual table.    A view is based on a table, called the root table.    The indexes of the view 
are the indexes of the root table, and the fields of the view can be all or just a subset of the
fields of the root table.    In addition to the root table fields, however, the view can also 
contain fields from any or all tables linked to the root table through a foreign key.    The 
records of a view can be sorted for a form or report using any field in the view.    You can 
also define a filter for a view, which uses criteria you define to select specific records that 
belong to the view.    (For example, only employees in the accounting department).
A view is similar to a table in all respects but one.    Only the fields from the root table can 
be updated when you enter or edit records through a view.



Forms
Once you have defined the structure of your database, you need a mechanism for entering 
data, and viewing it on the screen.    The object that you use for these purposes is the form. 
A form appears as a window within the Ad Hoc main program window.    Ad Hoc allows you 
to design and store any number of forms in the database.
There are two types of forms.    Data entry forms, or (referred to as just "forms" in Ad 
Hoc), display the fields values from one record at a time and allow you to edit the content 
of the fields.    A form is similar in layout to a paper form that has blanks to fill in.    List 
forms display the data in a row and column format, allowing you to see many records at a 
time and easily browse through a table.    These two types of forms can be combined in 
several ways to give you powerful data entry and display tools.
When you design a form, you design a view associated with the form.    You can place the 
fields of the view on the form, define form colors and fonts, define the sort order of view 
records, define the filter that will select records that will be displayed, and designate other 
characteristics that tailor the form for a particular purpose.

See Also
Using Forms
Using Lists
Designing Forms
Designing Lists



Reports
Ad Hoc has a very flexible report designer that allows you to design and store many types 
of report formats, including "row and column" reports, form letters, envelopes, and mailing 
labels.    Reports, like forms, are associated with a database view that can contain fields 
from one or more tables in the database.    You can designate a sort order and selection 
filter for the report and design the layout of information on the report, including margins, 
tabs, placement of data and text, repeating regions, fonts, line spacing, report breaks, and 
other layout characteristics.

See Also
Printing Reports
Designing Reports



Creating a Database
Creation of a new database includes

Creating the database
Defining the tables of the database
Designing forms and lists to display and enter data
Designing reports

Before you start, decide how you want to organize your data into tables, and how the 
tables of your database are related to each other.
The steps to creating a database are:
1. Select the Create New Database Command on the Tables Menu if a database is currently 

open.    If no database is currently open, this command is on the File Menu.
2. If a database is currently open, Ad Hoc will ask if you want to close it.    Respond Yes.
3. Describe the new database on the New Database Dialog.    The new database will be 

opened with the Tables Window displayed.
4. Define the tables of the database using the New Table Command on the Tables Menu to 

display the Database Table Dialog.
5. Design data entry forms and lists and save them in the Forms table.    See Designing 

Forms and Designing Lists.
6. Design reports and save them in the Reports table.    See Designing Reports.

System Files
A database must have a seven character ID that can be letters or digits, but must start with
a letter.    This ID is used to name the system files of the database.    Each database that you
create must have its own directory for the system files.    Files for other tables you define 
can be an any directory, and two databases can even share a database table.    When you 
create a database, the system files that are placed in the directory are    (assume SAMPLE is
the ID you gave the database):

File Name Purpose

SAMPLE.DDF the data dictionary file, which contains the table definitions, including 
field, index, and link definitions

SAMPLED.DD the _DDDATA table file (data dictionary additional data), which contains
validation rules for fields and other field and table definition data

SAMPLEF.DD the _FORMS table file, which contains the form and list designs that 
you create

SAMPLER.DD the _REPORTS table file, which contains the report designs that you 
create

These files together define the database and must always exist in the same directory.



Changing a Database
You cannot change the ID of an existing database.    You can however, change the directory 
name the database is located in, or move the database to another directory, with the 
following restrictions:

Only one database (set of database system files) can exist in a directory.
All the system files of a database must be in the same directory (See Creating a 

Database).
You can change global information describing the database (such as its descriptive name) 
by selecting the Edit Database Information Command on the Tables Menu to display the 
Edit Database Information Dialog.
To change other design aspects of the database:

See For Help on changing
Edit Table Definition Command the definition of a table, including adding, changing, or 

removing fields, indexes and links
Designing Forms the design of a form
Designing Lists the design of a list
Designing Reports the design of a report

Note:    You cannot edit a table definition or rebuild a table file from the Tables Window if 
there are other desktop objects (forms, lists, report design windows) open on the desktop.   
This is to guard against possible data integrity errors if you change the structure of a 
database table that a desktop object is designed around.



Database Maintenance
Ad Hoc system files database files actually require no maintenance unless they become 
damaged by a power failure, a disk failure, or some other system disaster.

Back up Your Files
This should be stressed throughout the help system.    If your database files are deleted or 
irreparably damaged, the only way to recover your data is to regularly make a backup of 
your hard disk.    Ad Hoc does not provide a backup command, so you must use a 
commercial backup program or the DOS backup program.    If you have a large disk filled 
with data, we highly recommend a tape backup system.    The safest backup policy is to 
back up files that change regularly every day, and rotate several sets of backup disks or 
tapes.

Missing Database Table Files
If the Tables Window indicates that a database table file cannot be found:
1. Check the file name and path name specified for the table on the Database Table Dialog 

(next two steps).
2. Highlight the table in the Tables Window list
3. Select the Edit Table Definition Command on the Tables Menu
4. Use the Window File Manager to check that the file specified is in the database directory 

or, if a different path is specified on the Table Definition Dialog, in the directory specified 
by the path

5. If the file is not on your disk, restore it from a backup.
6. If restoring from a backup fails, your only recourse is to make sure the table with the 

missing file is highlighted, then select the Empty Table Command on the Tables Menu to 
create a new, empty file for the table.

Damaged Database Table File
If the Tables Window indicates that there is an error in a table file, follow these steps.
1. Save any changes you have made to form or report designs, and exit Ad Hoc.
2. Start Ad Hoc again, and display the Tables Window with the Show Tables Window 

Command on the Tables Menu.
3. If the table file is still shown as having an error, attempt to rebuild the file.    Highlight the

damaged table in the Tables Window list.
4. Select the Rebuild Table File Command on the Tables Menu, and tell Ad Hoc Yes, you want

to rebuild the table file.
5. After the rebuild process is completed, click the OK button on the progress display 

window.
6. If the table is still indicated as damaged, you will have to restore it from your latest 

backup.
Note:    If a number of tables (or all of them) in the Tables Window list are shown with file 
errors, there may be a system error in your hardware, DOS, windows, or the Ad Hoc record 
manager.    In this case, before rebuilding or restoring from a backup, close all your 
applications, quit Windows, reboot your system, and then reopen Ad Hoc.

Using the Rebuild command to shrink a database file
As records are added to a Ad Hoc table, the size of the table file expands.    As records are 
deleted, the file size remains the same, but the space for the deleted records is kept track 



of.    As new records are again added, the space of the old deleted records is used first 
before expanding the file.
If you have a database file with a lot of addition and deletion activity, and a large number 
of records have just been deleted, you can shrink the size of the file if you want (its not 
necessary unless you need the disk space), by rebuilding the table file with the Rebuild 
Table File Command on the Tables Menu.
Note:    You cannot edit a table definition or rebuild a table file from the Tables Window if 
there are other desktop objects (forms, lists, report design windows) open on the desktop.   
This is to guard against possible data integrity errors if you change the structure of a 
database table that a desktop object is designed around.



Diagnostics
Ad Hoc contains several diagnostics routines that you can run to check 

the design of a form or list
the design of a report
the database table definitions stored in the data dictionary

The diagnostics checks are automatically run every time you open a form, list, or report 
window on the desktop, or print a report.    The database diagnostics are run every time you
start Ad Hoc or open a new database.    When these automatic checks are run, Ad Hoc will 
display the results only if the severity of any errors encountered exceeds a threshold set on
the Diagnostics Options Dialog.
If fatal errors are encountered for a report, you can't print the report until the errors are 
corrected (See Designing Reports).    If lower level errors are found, you have the option of 
continuing or canceling the report.
You can run the diagnostics routines at any other time by selecting the Run Diagnostics 
Command on the appropriate menu

To Check Use
A Form Run Diagnostics Command on the Form Run Menu or the Form Design 

Menu
A List Run Diagnostics Command on the List Run Menu or the List Design 

Menu
A Report Run Diagnostics Command on the Report Menu when a Report Design 

Window is active, or the pop-up menu of a Report Display Window
A Table Definition Run Table Diagnostics Command on the Tables Menu when the Tables 

Window is active
All Tables Run Database Diagnostics Command on the Tables Menu

Diagnostics Display Window
The results of diagnostics tests are displayed in a pop-up window that contains a 
description of what was tested, and a scrolling window showing messages for each warning
or error found.    At the end of the report is a summary of the number of errors found.    Click
the OK button to close this window.
When errors are found before printing a report, the diagnostics window contains an OK and 
Cancel button.    Click OK to continue the report, or Cancel to cancel it.

Error Levels
There are four levels of errors reported.
Level Description
Comment An unusual design that is probably OK, but might be the cause of a 

minor problem in a form or report
Warning A situation that will cause unexpected results.    Nothing major, but 

should be corrected
Error A problem that will cause unexpected results in a form or report 

output.    A problem in a table definition that will cause problems 
elsewhere and should definitely be corrected

Fatal A serious problem in the design of a form or report (or a table 
definition) that keep the form or report from working

Diagnostic Checks



The current version of Ad Hoc checks only for major design oversights, or incompatibility 
between the database and a form or report design.    There are problems that could exist 
that aren't caught by the diagnostics routines.    These will usually be apparent when you 
display a form or print a report.

Form Diagnostics
List Diagnostics
Report Diagnostics
Database Diagnostics



Form Diagnostics
The following form design errors are checked:

Invalid root table ID in the view definition
Invalid field IDs in the view definition
No fields defined
Invalid field IDs in the sort specification
Invalid field IDs in the filter definition
No input controls on the form
Controls assigned to invalid fields
Controls assigned to fields of the wrong data type
Controls with an invalid size or position on the form
Search window has a different sort specified than the main form
An imbedded list not linked to the main form (comment only)



List Diagnostics
The following list design errors are checked:

Invalid root table ID in the view definition
Invalid field IDs in the view definition
No fields defined
Invalid field IDs in the sort specification
Invalid field IDs in the filter definition
Invalid fields assigned to display columns



Report Diagnostics
The following report design errors are checked:

Invalid root table ID in the view definition
Invalid field IDs in the view definition
No fields defined
Invalid field IDs in the sort specification
Invalid field IDs in the filter definition
Invalid fields defined for report breaks
Invalid fields inserted into the report layout
Invalid target field for a total field
Invalid clear event for a total field
Element assigned to an invalid event
No regions defined
No report elements defined
Region contains no elements
Region is designated as "size to elements", but contains no elements of fixed size
Two floating regions together, or between non-fixed regions
Element assigned to an invalid region



Database Diagnostics
Diagnostics checks are performed on the table definitions in the data dictionary.    The 
following errors are checked:

No file name specified for the table
The specified file could not be found
Invalid pathname specified for the table file
Specified file was found, but could not be opened.
No fields defined for a table
No indexes defined for a table
Primary key index (0) defines a modifiable, duplicates allowed, or nulls allowed
Primary key index field not defined as required (no nulls allowed)
Invalid field defined for an index
Field of wrong data type defined for an index
Invalid table ID in a link definition
Invalid fields in a link definition
Fields specified in a link don't match primary key of associated table



Data Exchange
Data exchange includes importing data into a Ad Hoc database from an external file or 
application, and exporting data from a Ad Hoc database to an external file or application.    
Currently, Ad Hoc supports data exchange to and from 

Text files in the comma separated values (CSV) format
Text files in the fixed field format

To move data from another application, you must export it from that application in one of 
the above formats, then import it into Ad Hoc.    To move data from Ad Hoc to another 
application, you must export if from Ad Hoc in one of the above formats, then import it into 
the other application.    Most applications support importing and exporting with the CSV 
format.
To import or export data in Ad Hoc, you must design a form with a data exchange template. 
(See Designing Forms.)
For help on importing data, see Importing Data.
For help on exporting data, see Exporting Data.



Comma Separated Values (CSV) Format
Data can exported to or imported from an external DOS text file in comma separated 
values (CSV) format.    The data is structured in records, just like a database table.    Each 
record is divided into fields.    The fields are stored in the same order within each record, 
and the records are stored sequentially in the file.

Records are separated by two characters, a carriage return (ASCII code 13), and a 
line feed (ASCII 10).

The file is (optionally) terminated with an end-of-file character (ASCII code 26).
The fields have the same order within each record, and    are separated by commas.
Fields can vary in length.
If the field value contains a comma, the entire field is enclosed in double quotes 

("..,..").
The order of the fields within a record is defined by the data exchange template.

When Ad Hoc exports data in CSV format, it encloses all fields with double quotes (whether 
required or not) and separates them with commas.    It also writes the end-of-file character 
at the end of the file.



Fixed-Field Format
Data can be exported to or imported from an external DOS text file in fixed-field format.    
The data is structured in records, just like a database table.    Each record is divided into 
fields.    The fields are stored in the same order within each record, and the records are 
stored sequentially in the file.

Records are separated by two characters, a carriage return (ASCII code 13), and a 
line feed (ASCII 10).

The file is (optionally) terminated with an end-of-file character (ASCII code 26).
Each record is the same length (number of characters).
The fields are identical in length and position within each record

The order and size of the fields within each record is defined by the data exchange template.



Importing Data
To import data from an external file into a Ad Hoc database, you must design a form with an
attached data exchange template.    The data view of the form must contain the same fields
that are in the external file.    The same data exchange template can be used for both 
importing and exporting, however only the fields that belong to the root table of the data 
view can be imported.    Other fields in the import record are ignored.
To design a data exchange template, see:

Designing Data Exchange Templates
Designing Forms

The data view of the form defines which fields from the database can be updated when an 
import record is read.    The data exchange template defines how data in the import record 
matches the fields in the data view.

Restrictions on importing data
You can change data in existing records in the root table of the data view associated 

with the form and data exchange template, if the imported records contain the fields in the 
root table's primary key.

You can add new records to the root table of the data view if the imported records 
contain the fields in the table's primary key and all of the table's required fields are 
contained in the imported records.

To import data from a file

1. Display the form that contains the data exchange template designed for the record 
format of the external file.

2. Select the Import Command on the Form Menu to display the Data Import Dialog.
3. Enter the name of the external file that you are importing, along with the other options 

on the dialog, then press Enter or click the OK button.
4. Ad Hoc will display the progress of the import process in a window.
5. If an error is encountered in an input record, the record will be displayed on the form for 

you to edit.    You can either correct the error and use the update command to import the 
record, or use the cancel command to discard the record.    If you have specified a 
suspense file, the discarded record will be added to the suspense file for later editing and
import.

6. When the import process is completed, click the OK button in the process window to 
close it and terminate the import process.



Exporting Data
To export data from a Ad Hoc database to an external file, you must design a form with an 
attached data exchange template.    The data view of the form must contain the fields that 
you want in the exported records in the external file.    The same data exchange template 
can be used for both importing and exporting, however all fields in the view will be 
exported, including fields from linked tables.
To design a data exchange template, see:

Designing a Data Exchange Template
Designing Forms

The data view of the form defines which fields will be read from the database.    The data 
exchange template defines how the data in those fields will be placed in the export record.

To export data to a file

1. Display the form that contains the data exchange template designed for the record 
format of the external file.

2. Select the Export Command on the Form Menu to display the Data Export Dialog.
3. Enter the name of the external file that you are exporting to, along with the other options

on the dialog, then press Enter or click the OK button.
4. Ad Hoc will display the progress of the export process in a window.
6. When the export process is completed, click the OK button in the process window to 

close it and terminate the export process.



Designing Data Exchange Templates
Data exchange in Ad Hoc is implemented by importing and exporting records through a 
form.    A form contains the means of reading and writing records to the database.    By 
attaching a data exchange template to the form design, you can use the form to import 
(read) records into the database from an external file, or export (write) records from the 
database to an external file.    When you import records, you can use the form to display 
and edit them before they are stored in the database.
A data exchange template describes how the fields in the data view of the form are 
"mapped" to the data in the records of the external file.    Not all of the fields in the data 
view need to be defined in the data exchange template - only the ones you want to import 
or export.
There are some restrictions to importing data that you must be aware of when designing a 
template that will be used for import:

Only fields from the root table of the data view can be updated in the database, so 
only these fields will be imported.

An import record must contain the fields of the primary key of the root table.
If import records are to be used only to update information in existing database 

records, they need only contains the primary key field(s) and the fields to be updated.
If import records are to be used to add new records to the database, they must 

contain, as a minimum, the primary key field(s) and all required fields of the root table.
Only certain date formats available to data exchange templates can be used for 

importing.    See Data Exchange Template Dialog.

To design a data exchange template

1. Use an existing form, or design a new form for the data exchange process.    See 
Designing Forms.

2. Put the form in design mode with the Design Mode Command on the Form Menu.
3. Design the data view.    The data view of the form must contain all the fields to be 

imported or exported.
4. If the form will be used for importing, there should be a control on the form for each 

field in the root table that will be imported.    This will allow editing of errors in the 
import record.

5. Check the Data Exchange Template option on the Form Attributes Dialog.
6. Select the Data Exchange Template Command on the Form Design Menu (or click the 

DX Template button on the Form Attributes Dialog) to display the Data Exchange 
Template Dialog.

7. Select the record format of the external file, and the other options on the Data 
Exchange Template Dialog.

8. Click the Layout button to display the DX Record Layout Dialog.      Use this dialog to 
define the mapping of data in the records of the external file to the fields in the form's 
data view.    See DX Record Layout Dialog for details.

9. If you are designing a template to import from an existing external data file, you can 
use the Sample Record facility on the DX Record Layout Dialog to display a sample 
from the file to help design the layout.

10. If you are designing the template to export data, you can define the sort specification 
and filter of the data view to determine the order and selection criteria of exported 
records.    See Defining Data Views.

11. When you have designed the template, take the form out of design mode with the 
Leave Design Mode Command on the Form Design Menu.



12. Save the form design with the Save Command on the File Menu.
13. Test the design by exporting to a sample output file.    If the template is to be used for 

importing, verify that the output sample records match records that will be imported.



Registration and License Information
You are authorized to use this evaluation version of Ad Hoc for a period of 21 days.    If you 
use the program after the 21-day evaluation period, you are required by law to register 
your copy and pay the registration fee for a license to use the software.    Your use of the 
product, even during the evaluation period, means that you agree to the terms of the 
software license agreement.

Benefits to Registering
How to Register Ad Hoc and Order Copies
Software License Agreement
Limited Warranty



Software License Agreement
By installing and using this software, you agree to the following license agreement between
yourself and Exlogica.    You should carefully read the following terms and conditions, and if 
you do not agree with them, do not use the software.

Shareware version of Ad Hoc
You are hereby authorized to:

Use the shareware version of the software for a 21-day evaluation period.
Make as many copies of the shareware version of this software and documentation as

you wish, as long as the copies include all of the files distributed in the shareware package
Give exact copies of the original shareware version to anyone for their evaluation, 

and distribute the shareware version of the software and its documentation in its unmodified
form via electronic media.
You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other 
products or services (commercial or otherwise) without prior written permission.
You may not use Ad Hoc after the 21-day evaluation period without first registering your 
copy and paying the license fee.    Unregistered use of Ad Hoc after the evaluation 
period, by any person, business, corporation, government agency, or any other 
entity, is strictly prohibited and is in violation of federal copyright laws.

Use of software
Each registered copy may be used by only one person on one or more computers or 
workstations, or may be installed on a single computer for use by several people.    You may
install and use Ad Hoc on a network, provided that you have purchased individual licenses 
for the software covering all workstations that will access the software through the 
network.
You may not modify or patch the Ad Hoc executable files in any way.    You may not de-
compile, disassemble, or otherwise reverse engineer the software in this product.
You may not sell or otherwise distribute Ad Hoc, enhancements to Ad Hoc, or Ad Hoc data 
dictionary or database files, or designs for such files, to anyone without written permission 
from Exlogica.

Shareware Vendors
No fee, charge, or other compensation may be requested for distributing copies of Ad Hoc, 
except:

Operators of electronic bulletin board systems may make Ad Hoc available for 
downloading only if the above conditions on distributing copies are met, and no fees are 
charged specifically for downloading Ad Hoc.    The only permissible charges are the time-
dependent charges for use of the bulletin board.

Vendors of user-supported or shareware software may distribute Ad Hoc only with 
written permission from Exlogica.    Vendors may charge a disk duplication and handling fee, 
which, when pro-rated to the Ad Hoc product, may not exceed eight dollars.

Non-profit user groups may distribute copies of Ad Hoc to their members, without 
specific permission,    subject to the above conditions stated under "Shareware version of Ad 
Hoc".    Non-profit groups may collect a disk duplication fee not to exceed five dollars.

U.S. Government Restricted Rights
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 
252.227-7013 (DFARS 52.227-7013).    Contractor/manufacturer is Exlogica, 59 Golden 



Eagle Lane, Littleton, CO 80127.

Evaluation and Registration
Ad Hoc is not free software.    This license allows you to use the software for evaluation 
purposes without charge for a period of 21 days.    If you use this software after the 21 day 
evaluation period, you must register it and pay the license fee.    

This license agreement is governed by the laws of the State of Colorado.

See Also
Limited Warranty



Limited Warranty
This software and accompanying files and documentation are licensed "as is" and without 
any warranty as to performance or fitness for any particular use, or any other warranties 
expressed or implied.    The user must assume the entire risk of using this program. 
If you have paid the registration fee for a license to use the software, and have received a 
registered version of the software from Exlogica, Exlogica warrants that the disks provided 
are free from defects in material and workmanship, assuming normal use, for a period of 90
days from the date of registration.    If a defect in the disk occurs during this warranty 
period, you may return the disk(s) for a replacement.      
EXLOGICA DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, WITH RESPECT TO THE PRODUCT.    SHOULD THE PROGRAM PROVE DEFECTIVE, 
THE PURCHASER ASSUMES THE RISK OF PAYING THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR, OR CORRECTION AND ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES.
IN NO EVENT WILL EXLOGICA    BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING 
WITHOUT LIMITATION DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF DATA, OR THE LIKE) ARISING OUT OF THE USE OR THE INABILITY 
TO USE THIS PRODUCT    EVEN IF EXLOGICA HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.
In no event shall the liability of Exlogica for any damages to you or any other person 
exceed the lesser of the suggested list price or the actual price paid for the license to use 
the software, regardless of any form of the claim.
Your use of this product for any period of time constitutes your acceptance of this 
agreement and subjects you to its contents.



Benefits to Registering
We hope you like Ad Hoc and will continue to use it after the 21-day evaluation period.    If 
you continue to use Ad Hoc after the evaluation period, you must register your copy and 
pay the registration fee to avoid being in violation of Federal copyright laws.    
The additional benefits to registering your copy are:

You will receive a registered copy of the product (without the "Unregistered Copy" 
notice) and a printed copy of the User's Manual, when it is available.

You will be eligible for telephone (or fax) technical support.    
You will receive the next update version of the software for free, and will be notified 

of the availability of future updates.    The next version of the software will contain 
enhancements not in the evaluation version.

You will be able to contribute to the design of the next release.    We thrive on the 
suggestions and requests of our users.



How to Register Ad Hoc and Order Copies
You can order registered copies of Ad Hoc by mail. Send a check, along with the order form,
to:

Exlogica
59 Golden Eagle Lane
Littleton, CO 80127-5750

Payment must be in US Dollars, drawn on a US bank.
For information on ordering, site licenses, or obtaining upgrades to the product, write the 
above address, or contact Exlogica at:

Voice / Fax (303) 933-8553
Compuserve 75136,1033



Ad Hoc Order Form
Send this completed form, along with your payment in US Dollars drawn on a US bank, 
to

Exlogica
59 Golden Eagle Lane
Littleton, CO 80127-5750
USA

Specify diskette size: ___ 3.5" (1.44MB) ___ 5.25" (1.2MB)

_____ copies of Ad Hoc      @ $49.95 each $ ___________
US shipping and handling @ $5.00 each ___________
Canada/Mexico shipping and handling @ $8.00 each ___________
International shipping and handling @ $12.00 each ___________
Colorado residents add 3% sales tax ___________
Total Payment $ ___________

Name Date

Company

Address

City, State, Zip (Postal Code)

Country

Telephone (in case of problems with your order) Fax

Compuserve ID (or other Electronic Mail Address)

How did you hear about Ad Hoc?
Comments:



About This Beta Version
This is the second beta (pre-release) version of Ad Hoc.    It has been tested extensively in-
house and in a few customer locations, but we feel that it is not ready to be called a final 
release version until it has had wider exposure in a number of applications on a number of 
different machines.    Therefore, we are releasing it as a shareware product with "beta" 
status.    All of the conditions of the software license, however, apply to this version.    If you 
use this version for more than the 21-day evaluation period, you must still register it and 
pay the license fee.    All registered users will receive a copy of the final release version.
As of the release date of this version, there are no known major bugs in the product.    All of 
the bugs reported from users of the previous version have been identified and fixed (to the 
extent that users have notified us of them.)    We request any users of the product to 
contact us on Compuserve (user ID 75136,1033) if problems or bugs are found.
Exlogica is working on additional features for the final version that are not currently in this 
version.    This version contains additional features that were not in the previous release 
(See What's New in Ad Hoc beta version 1.00.27).

Beta testers
There is no formal beta testing program for Ad Hoc.    We will appreciate any bug reports 
from users of the product.    If you are using Ad Hoc, and there are changes in the product 
or new features that would make it more useful for you, or easier to use, please contact us 
on Compuserve and give us your suggestions.    
If you want to register as an active beta tester, contact us on Compuserve.    Active beta 
testers will receive updates to the program throughout the beta period and will receive a 
free registered copy of the final version, as well as a complimentary copy of the next major 
update.

Beta Period
It is anticipated that the beta period for this product will last through September 1993, at 
which time a final version will be made available.    This schedule depends on the response 
to this current version.



Technical Support and Questions
Technical support is available from Exlogica at no charge through the following means:

Electronic mail on Compuserve (user ID 75136,1033)
US Mail.    Send questions to:
Exlogica
59 Golden Eagle Lane
Littleton, CO 80127-5750
Fax at (303) 933-8553

Support to registered users will receive priority.    Due to the low price of Ad Hoc, we regret 
that we cannot offer telephone (voice) support generally.    Limited telephone support will 
be offered to registered users in exceptional cases.
If you have a question about a feature or a procedure in Ad Hoc, please try to find the 
answer in the on-line help system first.    If you still have a problem, please include the 
following information in your query:

The type of computer you are using, and the amount of memory.    Are you on a 
network?

The version of DOS/Windows
What you were doing in Ad Hoc when the problem occurred.
The messages or warnings you received.
How we can get back to you by Compuserve Email, fax, or mailing address.



What's New in Ad Hoc beta version 1.00.27
Many new features have been added to the latest version of Ad Hoc.      A number of these 
features were requested by users, so keep those suggestions coming in!
Several bugs have been fixed, including a fatal one that caused a General Protection Fault 
sometimes when a form was closed or you exited Ad Hoc.    In general the operation of 
forms and lists have been improved.
If you experience any problems with this version of Ad Hoc, please report them to ExLogica 
on Compuserve.    Our ID is 75136, 1033.
The new features are in the following areas.    

Lookup Windows
Diagnostics
FastMenu
Report Display Window
Changes to the Options Menu
Keystroke Navigation in Lists
Enhanced Form Design Tools
Combo Box Control Changes
Other Form Changes
Changes in Report Design



New Features:
 Lookup Windows for Form Controls
Lookup windows are automatic windows that you can pop up when you are entering a value
into certain fields on a form.    These windows contain a list of valid entries for these fields, 
along with additional data that you can specify to help you select an entry.    Selecting an 
entry in a lookup window pastes the value into the data entry field.    See Lookup Windows.



New Features:
Diagnostics

Ad Hoc now has a built-in diagnostics function that checks the validity of form, list, and 
report designs, and checks the integrity of the table definitions in the data dictionary.    You 
can run these procedures at any time, or set an option to have Ad Hoc run them 
automatically and report errors above a certain level.    See Diagnostics for details.



New Features:
FastMenu

You can now use a FastMenu to open form windows or start reports.    This menu pops up 
when you click the right mouse button on the (uncovered) Ad Hoc Desktop area.    You can 
select what commands appear on this menu.    See Fast Menu Options Dialog for details.



New Features:
Report Display Window

You can now view reports on the screen instead of printing them, by opening a Report 
Display Window.    This window lets you view a report as it would appear on paper, or 
change the report "page size" to fit the window.    See Report Display Window for details.



New Features:
Changes to the Options Menu

The Options Menu has been expanded to include five groups of options you can set for Ad 
Hoc operation.    The Preferences Dialog on the File Menu has been removed and the 
options on it have been regrouped into the options on the Options menu.    The five 
commands on the Options menu are:

Desktop Configuration
Database Options
Confirmation Options
FastMenu Options
Diagnostics Options

The Automatic Record Update option of previous versions has been removed, and is now a 
part of the Confirmation options.    The "AUTO" designation is no longer displayed on the 
status bar.



New Features:
Keystroke Navigation in Lists

Keystroke navigation has been added to make it easier to find an entry on a list.    Keystroke
navigation refers to typing letter or digit keys to move the highlight in a list.    Ad Hoc now 
offers two kinds of key navigation for Ad Hoc lists: progressive and single-key (the latter is 
used in Windows standard list boxes.).    See the Keystroke Navigation options on the 
Desktop Configuration dialog.



New Features
Enhanced Form Design Tools

The designing of forms has been made easier by new form design tools on the control pad 
when the form is in design mode.
See 

Designing Form Controls
Arranging Controls on a Form
Aligning Controls on a Form



New Features:
Combo Box Control Changes

The "Edit Code" style of combo box has been removed from the style options on the Combo
Box Attributes Dialog.      If you have designed forms with combo boxes of this style, the 
combo boxes will automatically change to the "Select Description" style.    The only reason 
for the editable style was to allow you to enter a blank field for fields that were not 
designated as required fields.    This option is now offered with the other styles:

If a field is marked Required in the data dictionary (blank values not allowed), the 
combo box list will contain only the valid values of the field as found the data dictionary.

If a field is not required, and can be blank, an additional entry will be found in the 
combo box: "n/a".    When you select this entry, the field will be blanked (set to a null value) 
in the record.



New Features:
Other Form Changes

Various other changes have been made to forms:
The Search Window is now filtered according to the same filter rules that apply to the

main form.    This includes any filter rules you included in the view design and filtering that is
done when the form is linked to another form.    Only records allowed to be displayed on the 
form will appear in the Search Window.

When a form is linked to another form (See the Form Links command), the 
designation "linked to ..." will appear in its window title after its name.

On the Form Links dialog (which was called "Link Forms" in previous versions), an 
imbedded lists will now also appear in the linked forms list of its parent form, if it has been 
defined with a link to the parent.    You can look at the definition of an imbedded list link, but 
you cannot change it unless you go into design mode and select the Link to Parent command
on the imbedded list's Design Menu.



New Features:
Changes in Report Designs

A few changes have been made in the design of reports.
The major one is that word wrapping is now supported, allowing a report to meaningfully 
include Text fields that may be paragraphs long.    A new Word Wrap option appears on the 
Edit Element Dialog.    When you select word wrapping for an element, any line that would 
extend past the right margin of the element is broken at the nearest word boundary, and a 
new line is started.    If this option is turned off, the line is truncated at the right margin.
If a Text field is included in a word-wrapped element, it will be printed in its entirety before 
any following fields on the line are printed.    For this reason, it is best not to include other 
fields on the same line after a Text field.    It is best to put Text fields on their own line, or 
better yet in their own element.
Right and bottom margin settings have been added to the element definition.    You should 
check the design of all your reports, as a bug in the previous version of Ad Hoc may have 
caused garbage to be put into the right and bottom margins.    This will result in reports that
don't print correctly.    You can fix this by redefining the bottom and right margins on all the 
elements of the report.
When a report is printed, and when the design is displayed on the screen, the contents of 
the element are clipped at (not displayed outside of) the margins.    An element that is not 
designated to have a fixed size is as wide as the report margins and as high as necessary 
to print all the contents.    The element left and right margins are inside the report margins 
and the top and bottom margins add space before and after the element.    For fixed size 
elements, all the margins are within the designated size.
If a tab is placed outside of the margins of a report, it is ignored.




